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Chapter 1 — Introduction

Welcome

Welcome to CST MICROWAVE STUDIO®, the powerful and easy-to-use
electromagnetic field simulation software. This program combines a user-friendly
interface with unsurpassed simulation performance.

CST MICROWAVE STUDIO® is embedded into the CST DESIGN ENVIRONMENT ™.
Please refer to the CST DESIGN ENVIRONMENT™ First Steps manual first. The
following explanations assume that you already installed the software and familiarized
yourself with the basic concepts of the user interface.

How to Get Started Quickly

We recommend that you proceed as follows:

1. Readthe CST DESIGN ENVIRONMENT™ First Steps manual.

2. Work through this document carefully. It provides all the basic information
necessary to understand the advanced documentation.

3. Work through the tutorials by choosing the example which best suits your
needs.

4. Look at the examples folder in the installation directory. The different
application types will give you a good impression of what has already been
done with the software. Please note that these examples are designed to give
you a basic insight into a particular application domain. Real-world applications
are typically much more complex and harder to understand if you are not
familiar with the device.

5. Start with your own first example. Choose a reasonably simple example, which
will allow you to become familiar with the software quickly.

6. After you have worked through your first example, contact technical support for
hints on possible improvements to achieve even more efficient usage of CST
MICROWAVE STUDIO®.

What is CST MICROWAVE STUDIO®?

CST MICROWAVE STUDIO® is a fully featured software package for electromagnetic
analysis and design in the high frequency range. It simplifies the process of inputting the
structure by providing a powerful solid modeling front end which is based on the ACIS
modeling kernel. Strong graphic feedback simplifies the definition of your device even
further. After the component has been modeled, a fully automatic meshing procedure is
applied before a simulation engine is started.

A key feature of CST MICROWAVE STUDIO® is the Method on Demand™ approach
which allows using the simulator or mesh type that is best suited to a particular problem.
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All simulators support hexahedral grids in combination with the Perfect Boundary
Approximation (PBA® method). Some solvers also feature the Thin Sheet Technique
(TST™) extension. Applying these highly advanced techniques normally increases the
accuracy of the simulation substantially in comparison to conventional simulators. Since
no method works equally well in all application domains, the software contains three
different simulation techniques (transient solver, frequency domain solver, eigenmode
solver) to best fit their particular applications. The frequency domain solver also contains
specialized methods for analyzing highly resonant structures such as filters.
Furthermore, the frequency domain solver supports both hexahedral and tetrahedral
types of mesh.

The most flexible tool is the transient solver, which can obtain the entire broadband
frequency behavior of the simulated device from only one calculation run (in contrast to
the frequency step approach of many other simulators). This solver is remarkably
efficient for most kinds of high frequency applications such as connectors, transmission
lines, filters, antennae and more.

The transient solver is less efficient for electrically small structures that are much smaller
than the shortest wavelength. In these cases it is advantageous to solve the problem by
using the frequency domain solver. The frequency domain solver may also be the
method of choice for narrow band problems such as filters or when the usage of
tetrahedral grids is advantageous. Besides the general purpose solver (supporting
hexahedral and tetrahedral grids), the frequency domain solver also contains fast
alternatives for the calculation of S-parameters for strongly resonating structures. Please
note that the latter solvers are currently available for hexahedral grids only.

However, efficient filter design often requires the direct calculation of the operating
modes in the filter rather than an S-parameter simulation. For these applications, CST
MICROWAVE STUDIO® also features an eigenmode solver which efficiently calculates
a finite number of modes in closed electromagnetic devices.

If you are unsure which solver best suits your needs, contact your local sales office for
further assistance.

Each solver's simulation results can be visualized with a variety of different options.
Again, a strongly interactive interface will help you quickly achieve the desired insight
into your device.

The last — but not least — outstanding feature is the full parameterization of the structure
modeler, which enables the use of variables in the definition of your component. In
comblnatlon with the built-in optimizer and parameter sweep tools, CST MICROWAVE
STUDIO® is capable of both the analysis and design of electromagnetic devices.
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Who Uses CST MICROWAVE STUDIO®?

Anyone who has to deal with electromagnetlc problems in the high frequency range
should use CST MICROWAVE STUDIO®. The program is especially suited to the fast,
efficient analysis and design of components like antennae (including arrays), filters,
transmission lines, couplers, connectors (single and multiple pin), printed circuit boards,
resonators and many more Since the underlying method is a general 3D approach, CST
MICROWAVE STUDIO® can solve virtually any high frequency field problem.

The software is based on a method that requires the discretization of the entire
calculation volume; the applications are therefore limited by the electrical size of the
structures. An important feature of the transient solver is the excellent linear scaling of
the computational resources with structure size. Currently, modern personal computers
allow the simulation of structures with a size of up to roughly 100 wavelengths. For large
antenna arrays, the frequency domain solver offers a very powerful Unit Cell feature
where the periodicity of the structure is taken into account.

CST MICROWAVE STUDIO® Key Features

The following list gives you an overview of CST MICROWAVE STUDIO®s main
features. Note that not all of these features may be available to you because of license
restrictions. Contact a sales office for more information.

General
O Native graphical user interface based on Windows 2000 and Windows XP
O Fast and memory efficient FIl-method
O Extremely good performance due to Perfect Boundary Approximation (PBA®) for

solvers using hexahedral grids. The transient and eigenmode solvers also support
the Thin Sheet Technique (TST™). Hexahedral grids are supported by all solvers.

O The structure can be viewed either as a 3D model or as a schematic. The latter
allows for easy coupling of EM simulation with circuit simulation.

Structure Modeling

Advanced ACIS -based, parametric solid modeling front end with excellent
structure visualization

Feature-based hybrid modeler allows quick structural changes

Import of 3D CAD data by SAT (e.g. AutoCAD ), Autodesk Inventor® IGES, VDA-
FS, STEP, ProE®, CATIA 4%, CATIA 5%, CoventorWare®, Mecadtron® or STL files
Import of 2D CAD data by DXF GDsSlI and Gerber R8274X RS274D files

Import of Agilent ADS layouts

Import of Sonnet em® models (8.5x)

Import of a visible human model dataset or other voxel datasets

Export of CAD data by SAT, IGES, STEP, STL, DXF, DRC or POV files
Parameterization for imported CAD files

Material database

Structure templates for simplified problem description

Ooooooooo oo O

! Portions of this software are owned by Spatial Corp. © 1986 — 2005. All Rights Reserved.
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Transient Simulator

0 000 00000 O0000 OoO0ooOoo oo o oo

O

OO0 OOoO0OO0ooOoOo oOooo

Efficient calculation for loss-free and lossy structures

Broadband calculation of S-parameters from one single calculation run by applying
DFTs to time signals

Calculation of field distributions as a function of time or at multiple selected
frequencies from one simulation run

Adaptive mesh refinement in 3D

Parallelization of the transient solver using up to 32 processors on a PC

Isotropic and anisotropic material properties
Frequency dependent material properties
Gyrotropic materials (magnetized ferrites)
Surface impedance model for good conductors

Port mode calculation by a 2D eigenmode solver in the frequency domain
Multipin ports for TEM mode ports with multiple conductors

Multiport and multimode excitation (subsequently or simultaneously)
Plane wave excitation (linear, circular or elliptical polarization)

Excitation by a current distribution imported from SimLab®

S-parameter symmetry option to decrease solve time for many structures
Auto-regressive filtering for efficient treatment of strongly resonating structures
Re-normalization of S-parameters for specified port impedances

Phase de-embedding of S-parameters

Full de-embedding feature for highly accurate S-parameter results

High performance radiating/absorbing boundary conditions
Conducting wall boundary conditions
Periodic boundary conditions without phase shift

Calculation of various electromagnetic quantities such as electric fields, magnetic
fields, surface currents, power flows, current densities, power loss densities,
electric energy densities, magnetic energy densities, voltages in time and
frequency domain

Antenna farfield calculation (including gain, beam direction, side lobe suppression,
etc.) with and without farfield approximation. Farfield probes to determine broad
band farfield data at certain angles.

Antenna array farfield calculation

RCS calculation

Calculation of SAR distributions

Discrete elements (lumped resistors) as ports

Ideal voltage and current sources for EMC problems

Lumped R, L, C, (nonlinear) Diode elements at any location in the structure
Rectangular shaped excitation function for TDR analysis

User defined excitation signals and signal database

Simultaneous port excitation with different excitation signals for each port

Automatic parameter studies using built-in parameter sweep tool

Automatic structure optimization for arbitrary goals using built-in optimizer
Network distributed computing for optimizations, parameter sweeps and multiple
port/mode excitations
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Frequency Domain Simulator

O O 000 000 OoOooOooooo 0O

O OO0 OO ooo d

Efficient calculation for loss-free and lossy structures including lossy wave guide
ports

General purpose solver supports both hexahedral and tetrahedral meshes
Isotropic and anisotropic material properties

Arbitrary frequency dependent material properties

Automatic fast broadband adaptive frequency sweep

User defined frequency sweeps

Adaptive mesh refinement in 3D

Direct and iterative matrix solvers with convergence acceleration techniques

Port mode calculation by a 2D eigenmode solver in the frequency domain
Re-normalization of S-parameters for specified port impedances
Phase de-embedding of S-parameters

High performance radiating/absorbing boundary conditions

Periodic boundary conditions including phase shift or scan angle

Unit cell feature simplifies the simulation of periodic antenna arrays (tetrahedral
mesh only)

Floquet mode ports (periodic wave guide ports)

Calculation of various electromagnetic quantities such as electric fields, magnetic
fields, surface currents, power flows, current densities, power loss densities,
electric energy densities, magnetic energy densities

Antenna farfield calculation (including gain, beam direction, side lobe suppression,
etc.) with and without farfield approximation

Antenna array farfield calculation

RCS calculation

Calculation of SAR distributions

Discrete elements (lumped resistors) as ports
Lumped R, L, C elements at any location in the structure

Automatic parameter studies using built-in parameter sweep tool
Automatic structure optimization for arbitrary goals using built-in optimizer
Network distributed computing for optimizations and parameter sweeps

Besides the general purpose solver, the frequency domain solver also contains
two solvers specialized on strongly resonant structures (hexahedral meshes only).
The first of these solvers calculates S-parameters only whereas the second also
calculates fields with some additional calculation time, of course.
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Eigenmode Simulator

OO0 oOoOooo

ooao

Calculation of modal field distributions in closed loss free or lossy structures
Isotropic and anisotropic materials

Parallelization using up to two processors on a PC

Adaptive mesh refinement in 3D

Periodic boundary conditions including phase shift
Calculation of losses and internal / external Q-factors for each mode (directly or
using perturbation method)

Automatic parameter studies using built-in parameter sweep tool
Automatic structure optimization for arbitrary goals using built-in optimizer
Network distributed computing for optimizations and parameter sweeps

Schematic View

O

O

Allows for the connection of arbitrary networks to EM ports. These networks can
contain any combination of R/L/C circuit elements, ideal phase shifters, perfect
absorbers, variable reflections, directional couplers, 3dB splitters, CST
MICROWAVE STUDIO® netlist files and ports.

All circuit simulation capabilities licensed for CST DESIGN STUDIO™ can also be
used within this schematic view.

The schematic view and the 3D view are synchronized automatically.

Visualization and Secondary Result Calculation

OO0 OO0 OoOooood

oo

Displays S-parameters in xy-plots (linear or logarithmic scale)
Displays S-parameters in smith charts and polar charts
Online visualization of intermediate results during simulation
Import and visualization of external xy-data

Copy / paste of xy-datasets

Fast access to parametric data via interactive tuning sliders

Displays port modes (with propagation constant, impedance, etc.)

Various field visualization options in 2D and 3D for electric fields, magnetic fields,
power flows, surface currents, etc.

Animation of field distributions

Display of farfields (fields, gain, directivity, RCS) in xy-plots, polar plots, scattering
maps and radiation plots (3D)

Display and integration of 2D and 3D fields along arbitrary curves
Integration of 3D fields across arbitrary faces

Automatic extraction of SPICE network models for arbitrary topologies ensuring
the passivity of the extracted circuits

Combination of results from different port excitations
Hierarchical result templates for automated extraction and visualization of arbitrary

results from various simulation runs. These data can also be used for the definition
of optimization goals.
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Result Export

O Export of S-parameter data as TOUCHSTONE files
O Export of result data such as fields, curves, etc. as ASCII files
O Export screen shots of result field plots

Automation

O Powerful VBA (Visual Basic for Applications) compatible macro language including
editor and macro debugger

O OLE automation for seamless integration into the Windows environment (
Microsoft Office®, MATLAB®, AutoCAD®, MathCAD®, Windows Scripting Host,
etc.)

About This Manual

This manual is primarily designed to enable a quick start of CST MICROWAVE
STUDIO®. It is not intended to be a complete reference guide to all the available
features but will give you an overview of key concepts. Understanding these concepts
will allow you to learn how to use the software efficiently with the help of the online
documentation.

The main part of the manual is the Quick Tour (Chapter 2) which will guide you through
the most important features of CST MICROWAVE STUDIO®. We strongly encourage
you to study this chapter carefully.

Document Conventions

O Commands accessed through the main window menu are printed as follows: menu
bar item=menu item. This means that you first should click the “menu bar item”
(e.g. “File”) and then select the corresponding “menu item” from the opening menu
(e.g. “Open”).

O Buttons which should be clicked within dialog boxes are always written in italics,
e.g. OK.

O Key combinations are always joined with a plus (+) sign. Ctr/+S means that you
should hold down the “Ctrl” key while pressing the “S” key.

Your Feedback

We are constantly striving to improve the quality of our software documentation. If you
have any comments on the documentation, please send them to your local support
center. If you don’'t know how to contact the support center near you, send an email to
info@cst.com.
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Chapter 2 — Quick Tour

CST MICROWAVE STUDIO® is designed for ease of use. However, to get started
quickly, you need to know a couple of things. The main purpose of this chapter is to
provide an overview of the software’s capabilities. Read this chapter carefully, as this
may be the fastest way to learn how to use the software efficiently.

This chapter covers the following sections:

Oo0o0oOoooooood

Start the software

Overview of the user interface structure

Create and view some simple structures

The first real world application example

Which solver to use

General purpose and resonant frequency domain computations
Eigenmode (resonator) computations

Choose the right port

Antenna computations and digital calculations

Add circuit elements to external ports

SPICE network model extraction

Cadence® Allegro / APD plug in and Agilent ADS® co-simulation

Start the Software

After starting CST DESIGN ENVIRONMENT™ you will be prompted to open an existing
file or create a new project:

Welcome to CST DESIGH EMVIROMMENT

Pleaze select one of the following options:

@ Create a new project
E 9 = @

CST CSTEMSTUDIO  CST PARTICLE CST DESIGH
MICROWAYE STUDID STUDIO
STUDIO
é? Open an existing project
“AMore Files...

[ &dways start with the selected module
[ ] 0pen the Quick Start Guide
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In this dialog box, select a CST MICROWAVE STUDIO® project and click the OK button.
You can make this selection the default whenever the CST DESIGN ENVIRONMENT™
is started by checking the Always start with the selected module option. Once CST

MICROWAVE STUDIO® is initialized, you will see the following window:

Select a Template

Select a template for the current project

<Monex

Antenna [in Free Space. planar]
Antenna [in Free Space, waveguide]
Antenna [on Planar Substrate]
Antenna [with Ground Plane]
Antenna Array Unit Cell [FD
Connector [Coaxial]

Dezcription

“r'ou may zelect one of the
ternplates fram the ligt in arder to
cuztornize the default zettings for
particular types of applications.

If you chooze <Mones, the default
zettingz will be left unchanged.

Connector [Mulbping
EMC-EMI Problem
FS5 - Unit Cell [FD)
|C Package

LTCC

raFlA Project
Planar Coupler [Microstrip, Coplanar)
Planar Filker

RCS

Fiesonator

RFID

W aveguide Coupler
waveguide Filter

I Ok, l [ Cancel

Shaow thiz dialog box when a new project iz created

This dialog box will always appear when a new project is created.

Here you can select one of the predefined templates to automatically set proper default
values for the particular type of device you want to analyze. Although all of these
settings can be changed manually at any time, it is more convenient to start with proper
defaults, especially for new users. However, as an advanced user you can customize
the predefined templates or add new ones.

For the first part of this introduction, simply select <None> and click the OK button.

Overview of the User Interface Structure

The following picture shows a screenshot of CST MICROWAVE STUDIO® as it is
embedded in CST DESIGN ENVIRONMENT™. Refer to the CST DESIGN
ENVIRONMENT™ documentation for more information on how to customize the user
interface according to your needs.



CST MICROWAVE STUDIO ® 2006 — Getting Started 13
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E File Edit View WCS Wyves Objects Mesh Solve Resubs Macros Window Help S -IES
- @ &g B ewd sia QA H Free v
i Gl R Mai A
“G B8 alifment S O0S/SE[EL e ®
SET
{2 Companents
% (2] Materials Toolbars
{3 Faces
{2 Curves
00 wCs
120 e \
{23 Lumped Elements N
{2 Plane Wave H H
o Navigation tree
{21 Current Dishibutions
(L Excitation Signals
{2 Field Manitors
(13 Veltage Monitors
{23 Probes Q Reset View
#-( Mesh Control e Rotate ¥
23 1D Resurs GY Rotate View Plane
(23 2D/30 Riesuits -
[ Farfields Edl Pan
@ Zoom
£ Dynamic Zoom 2 x
Uniide All 1
I Drawing plane
1 wes

Setwes

>
@ Clear Picks
Pick \

B wavequide Ports. \
oot Context menu

Voltage Monitors.
= s Status bar
Dran Axes
‘B Unttled 0 I3 —leell
ﬁ Name Yalue Desciiption J::th ﬂ /
Parameter window Message window

Global

Ready. Raster=1,000  PEC m Hz s

The navigation tree is an essential part of the user interface. From here you may access
structural elements as well as simulation results. The following sections explain the
different items in this tree window.

The context menus are a flexible way of accessing frequently used menu commands for
the current context. The contents of this menu (which can be opened by pressing the
right mouse button) change dynamically.

The drawing plane is the plane on which you will draw the structure’s primitives. As the
mouse is only a 2D locator, even when defining 3D structures, the coordinates must be
projected onto the drawing plane in order to specify a 3D location. Since you may
change the location and orientation of the drawing plane by means of various tools, this
feature makes the modeler very powerful.

The parameter window displays a list of all previously defined parameters together with
their current values.

The message window displays information text (e.g. solver output) whenever applicable.

The other elements of the user interface are standard for a Windows-based application.
We assume that you are familiar with these controls.
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Create and View Some Simple Structures

Let's jump into the procedure of creating a simple structure. Many complex structures
are composed of very simple elements or so-called primitives. In the following we draw
such a primitive: a brick.

Create a First “Brick”

1.

Activate the “Brick” tool by clicking the corresponding icon in the object toolbar: wf
(You can also select Objects=>Basic Shapes=*Brick from the main menu). You will
be prompted to select the first point of the brick’s base in the drawing plane (see the
text line in the main window).

You may set a starting point by double-clicking a location on the drawing plane.
Now you can select the opposite corner of the brick’s base on the drawing plane by
double-clicking on it.

Next, define the height of the brick by dragging the mouse. Double-click to fix the
height of the brick.

Finally, a dialog box will open showing the numerical values of all coordinate
locations you have entered. Click OK here to store the settings and create your first
primitive!

The picture here gives an overview of the three double-clicks used to define the brick:

Point 1

Point 2

Point 3

Before we continue drawing other simple shapes, let's spend some time on the different
methods of setting a point.

The simplest way to set a point is to double-click its location on the drawing plane as
above. However, in most cases the structure coordinates have to be entered at a high
precision. In this case, the snap-to-grid mode should be activated. You will find the
corresponding option dialog box under Edit=Working Plane Properties in the menu bar.
The following dialog box will appear:
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Working Plane Properties
20
b
‘width:
1 At
Shap width:
o1 Shap

Here you may specify whether the mouse coordinates should Snap to a raster (which is
the default) or not. Furthermore you may specify the raster Snap width in the
corresponding field. The raster Width entry influences only the size of the raster which is
drawn on the screen. The coordinate mapping is independent from this setting.

Please note that selecting the Help button in a dialog box always opens a help page
containing more information about the dialog box and its settings.

Another way to specify a coordinate is to press the Tab key whenever a location is
expected. In this case a dialog box will appear in which you may numerically specify the
location. The following example shows a dialog box that appears when the first point of
a shape must be defined:

Enter Point X
Mode (%) Cartesian () Polar
13
v: 58

You may specify the position either in Cartesian or in Polar coordinates. The latter type
is measured from the origin of the coordinate system. The Angle is between the x-axis
and the location of the point, and the Radius is the point’s distance from the origin.

When the first point has been set, the Relative option will be available. If you check this
item, the entered coordinates are no longer absolute (measured from the origin of the
coordinate system) but relative to the last point entered.

The coordinate dialog boxes always show the current mouse location in the entry fields.
However, oftentimes a point should be set to the center of the coordinate system (0,0). If
you press Shift+Tab, the coordinate dialog box will open with zero values in the
coordinate fields.

The third way to enter accurate coordinates is by clicking estimated values using the
mouse and then correcting the values in the final dialog box. You may skip the definition
of points using the mouse at any time by pressing the Esc key. In this case, the shape
dialog box will open immediately.
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Pressing the Esc key twice aborts the shape generation. Pressing the Backspace key
deletes the previously selected point. If no point has been selected, the shape
generation will also be aborted.

Please note that another mode exists for the generation of bricks. When you are asked
to pick the opposite corner of the brick’s base, you may also specify a line rather than a
rectangle. In this case, you will be asked to specify the width of the brick as a third step
before specifying the height. This feature is quite useful for construction tasks such as
building a micro strip line centered on a substrate.

To facilitate this, a feature exists which allows the line definition to be restricted to

orthogonal movements from the first selected point. Simply hold down the shift key and
move the mouse to define the next point.

An Overview of the Basic Shapes Available

The following picture gives a brief overview of all basic shapes that can be generated in
a similar way to the brick (as described above).

CyIinder @ Torus =

Sphere @

Rotation '5'

Elliptical
cylinder &

Extrude ae

At this stage you should play around a bit with the shape generator to familiarize
yourself with the user interface.
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Select Previously Defined Shapes, Group Shapes into Components
and Assign Material Properties

After a shape has been defined, it is automatically cataloged in the navigation tree. You
can find all shapes in the Components folder. If you open this folder, you will find a
each
. The

subfolder called component1, which contains all defined shapes. The name for
primitive is assigned to the final shape dialog box when the shape is created

default names start with “solid” followed by an increasing number: solid1, solid2, etc.

You may select a shape by clicking on the corresponding item in the navigation

down the Shift key while clicking on the shapes’ names. Take a few secon
familiarize yourself with the shape selection mechanism.

tree.
Note that after you select a shape, it will be displayed opaquely while all others will be
drawn transparently (see the picture below). This is how the modeler visualizes shape
selection. A shape can also be selected by double-clicking on it in the main window. In
this case, the corresponding item in the navigation tree will also be selected. Holding
down the Cirl key while double-clicking at a shape in the view allows you to select
multiple shapes. You may also select ranges of shapes in the navigation tree by holding
ds to

¥

‘/JZ solid1

] ey oy e Y ] S S RIE of

Material
Type
Epsilon
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/ solid2
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You may change the name of a shape by selecting it and choosing Edit=>Rename
Object from the menu bar or by pressing the F2 key. You can then change the name of

the shape by editing the item text in the navigation tree.

Now that we have discussed how to select an object, we should spend a little time on
the grouping of shapes into components. Each component is a subfolder of the
Components folder in the navigation tree. Each individual component folder can contain

an arbitrary number of shapes.

The purpose of the component structure is to group together objects which belong to the
same geometrical component, e.g. connectors, antennae, etc. This hierarchical grouping
of shapes allows simplified operations on entire components such as transformations

(including copying), deletions, etc.
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You can change the component assignment of a shape by selecting the shape and
choosing Edit=Change Component from the menu bar (this option can also be found in
the context menu when a shape is selected). The following dialog box will open:

-

Change Component
I ame:
_EIK
zolid1
Component:
component]| "

In this dialog box, you can select an existing component from the list or create a new
one by simply typing its name in the entry field. You may also select [New Component]
from the list. In the latter case, the newly created components will be automatically
named as component1, component2, etc.

The component assignment of a shape has nothing to do with its physical material
properties. In addition to its association to a particular component, each shape is
assigned a material that also defines the color for the shape’s visualization. In other
words, the material properties (and colors) do not belong to the shapes directly but to
the corresponding material. This means that all shapes made of a particular material
have the same material properties and are drawn in the same color.

The only way to change the material properties or the color of an individual shape is to
assign it to another material by selecting the shape and choosing Edit=>Change Material
from the menu bar (this option can also be found in the context menu when a shape is
selected). The following dialog box will open:

-

Change Material

MHame:

QK
o o |
tdaterial:
Aacuum e Help

In this dialog box you may select an existing material from the list or define a new one by
selecting the item [New Material...] from the list. In the latter case, another dialog box
will open:
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Mew Material Parameters:

General | Density

General properties
I aterial name:

materiall|
Type:
FEC '_V-

Color
0% Transparency  100%

| | I Change... l

._, .

[ Draw as wirsframe

[] &dd ta material library

I [H] H Cancel H Apply H Help ]

In this dialog box you must specify the Material hame and the Material type (perfect
conductor, normal dielectric, anisotropic, lossy metal, corrugated wall and ohmic sheet
material). Note that the material types corrugated wall and ohmic sheet are available for
the tetrahedral frequency domain solver only. You can also change the color of the
material by clicking the Change button. After clicking the OK button, the new material will
be stored and appears in the Materials folder in the navigation tree. Selecting a
particular material in the navigation tree also highlights all shapes that belong to this
material. All other shapes will then be drawn transparently.
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In order to simplify the definition of frequently used materials, a material database has
been implemented. Before a material definition from the database can be used, you
must add it to the current project by selecting Solve =Materials=Load from Material
Library. This operation will open the following dialog box displaying the contents of the
database:

Load from Material Library
b aterial library
b aterial 7 Tupe ~
1) Alurina [96%] [losz free] Mormal ]
$ Alumina [967%] [losay] Mormal
$ Alumina [99.5%] [loss free) Mormal
[ Alumina [99.5%] (lozzy) Mormal
[ Alurmirm Lozsy metal
[ Alurninrn Mitride [loss free] Mormal
$ alurnirrn Mitride [logzy) Marmal
$ Arlon A0 260 [logz free] Marmal
$ Arlon A0 250 [logay) Mormal w
[ Find... ] [ Renarme ] [ Delete

b aterial to import
Mame: | Alumina [967%] [loss free]

Type: Marmal

Attributes: Drezcription:
Type = Mormal

Epszilon =194

kue =1

[ Load l [ Cloze ] [ Help ]

You may select an existing material from the list and click the Load button to add the
material definition to the Materials folder in the navigation tree. Once the material is
available in this folder, it can be used in the current project. You can also add a material
that has been defined in the current project to the database by selecting the material in
the navigation tree and then choosing Solve =*Materials =>)Add to Material Library.
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Change the View

So far we have created and viewed the shapes by using the default view. You can
change the view at any time (even during shape generation) using some simple
commands as explained below.

The view will change whenever you drag the mouse while holding down the left button,
according to the selected mode. You can select the mode from the main menu by
choosing View=Mode =>Rotate/Rotate View Plane/Pan/Zoom/Dynamic Zoom or by
selecting the appropriate item from the view toolbar:

Rotate |

Reset View To Structure

Rotate View Plane Pan  Dynamic Zoom Zoom Reset View
The mode setting affects the behavior as follows:

O Rotate: The structure will be rotated around the two screen axes.

O Rotate View Plane: The structure will be rotated in the screen’s plane.

O Pan: The structure will be translated in the screen plane following the mouse cursor
movement.

O Dynamic Zoom: Moving the mouse upward will decrease the zoom factor while
moving the mouse downward will increase the zoom factor.

O Zoom: In this mode a rubber band rectangle will be defined by dragging the mouse.
After you release the left mouse button, the zoom factor and the view location will
be updated so that the rectangle fills up the screen.

The dynamic view-adjusting mode ends when you release the left mouse button. You
can reset the zoom factor by choosing View=Reset View from the main menu or from
the context menus. Alternatively you can select the corresponding item in the view
toolbar.

One of the most important view-changing commands is activated by View=Reset View
to Structure or by pressing the Space bar. This command will zoom the defined structure
to a point where it fits well into the drawing window. Furthermore, pressing Shift+Space
will zoom to the currently selected shape rather than the entire structure.

Since changing the view is a frequently used operation that will sometimes be necessary
even during the process of interactive shape creation, some useful shortcut keys exist.
Press the appropriate keys, and drag the mouse while pressing the left button:

O Ctrl: Same as “rotate” mode
O Shift. Same as “plane rotation” mode
O Shift + Ctrl: Same as “pan” mode

A mouse wheel has the same effect as the “dynamic zoom."
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In addition to the options described above, some specific settings are available to
change the visualization of the model.

All these settings can be specified by choosing the appropriate item from the View
menu. Furthermore these settings can be specified with the corresponding item in the

view toolbar:
@

Axes Drawing plane Wire frame

Axes (View=View Options dialog box, Ctr/+A): This option specifies whether or not the
coordinate system is displayed:

Working plane (View=View Options dialog box, Alt+W): With this flag you may specify
whether or not the drawing plane is visible.

2 M

Wireframe (View=View Options dialog box, Ctrl+W): This flag indicates whether all
shapes are displayed as simple wire models or as solid shaded objects.

__Nni
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Apply Geometric Transformations

So far you have seen how to model simple shapes and how to change the view of your
model. The first of the more advanced operations on your model is geometric
transformations.

We assume that you have already selected the shape (or multiple shapes) to which a
transformation will be applied (e.g. by double-clicking on a shape in the main view).

You can then open the transformation dialog box by choosing Objects=Transform
Shape in the main menu, by choosing the item Transform from the context menu, or by

selecting Elp in the objects toolbar.
In the dialog box, you are invited to choose one of the following transformations:

O Translate: This transformation applies a translation vector to the selected shape.

O Scale: By choosing this transformation, you can scale the shape along the
coordinate axes. You may specify different scaling factors in the different
coordinate directions.

O Rotate: This transformation applies a rotation of the shape around a coordinate
axis by a fixed angle. You may additionally specify the rotation center in the Origin
field. The center may be the center of the shape (calculated automatically) or any
specified point. Specify the rotation angle and axis settings by entering the
corresponding angle in the entry field for the corresponding axis (e.g. entering 45 in
the y field while leaving all other fields set to zero performs a rotation around the y
axis of 45 degrees).

O Mirror: This transformation allows you to mirror the shape at a specified plane. A
point on the mirror plane is specified in the Origin field, and the plane’s normal
vector is given in the Mirror plane normal entries.

For all these transformations you may specify whether the original shape should be kept
(Copy option) or deleted. Furthermore you can specify in the Repetition factor field how
many times the same transformation will be applied to the shape (each time producing a
new shape when the Copy option is active).

A final example will demonstrate the usage of the transformation dialog box. Assume a
brick has been defined and selected as depicted below. Open the transform dialog box
by choosing the appropriate item from the context menu (or Objects = Transform).
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Reset View
Rotate
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Zoom

Dynamic Zoom
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Now apply a translation to the shape by a translation vector (5, 0, 0), and produce
multiple copies as the transformation is applied twice:

= =

Transform Selected Object

D peration

Tranzlate
s

Onigin

i i 20

Translation vector
p—

=5 o0 Z |0

F epetitions

Fepetition factar, | 2
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Change destination

[ Campanent; [ M aterial:
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You should obtain the following shapes:

/1

Solid1

Solid1_1

Solid1_2

Note that for each transformation the name of the transformed shape is either kept (no
Copy option) or extended by appendices _1, 2, etc. in order to obtain unique names for
the shapes.

Combine Shapes Using Boolean Operations

Probably the most powerful operation to create complex shapes is combining simple
shapes using Boolean operations. These operations allow you to add shapes together,
to subtract one or more shapes from another, to insert shapes into each other, and to
intersect two or more shapes.

Let's consider two shapes — a sphere and a brick — on which to perform Boolean
operations.
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This list names all available Boolean operations and shows the resulting body for each
combination:

Add brick to sphere

Add both shapes together to obtain a single
shape. The resulting shape will assume the
component and material settings of the first
shape.

Subtract sphere from brick

Subtract the first shape from the second to
obtain a single shape. The resulting shape will
assume the component and material settings
of the shape from which the other shape is
subtracted.

Intersect brick and sphere

Intersect two shapes to form a single shape.
The resulting shape will assume the
component and material settings from the first
shape of this operation.

Trim sphere
= Insert brick into sphere

The first shape will be trimmed by the
boundary of the second shape. Both shapes
will be kept. The resulting shapes will have no
intersecting volume.

Insert sphere into brick
= Trim brick

The first shape will be inserted into the
second one. Again both shapes will be kept.
The resulting shapes will have no intersecting
volume.

Note that not all of the Boolean operations above are directly accessible. As you can
see, some of the operations are redundant (e.g. a trimming operation can be replaced
by an insertion operation when the order of the shapes is reversed).
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You can access the following Boolean operations from the main menu by choosing the
corresponding items: Objects=Boolean=*Add/Subtract/Intersect/Insert. Operations are
accessible only when a shape has been selected (in the following referred to as “first”
shape). After the Boolean operation has been activated, you will be prompted to select

the “second” shape. Pressing the Return key or selecting 4 from the objects toolbar
performs the Boolean combination. The result depends on the type of Boolean operation
and is listed below:

O Add: Add the second shape to the first one — keeps the component and material
settings of the first shape.

O Subtract: Subtract the second shape from the first one — keeps the component and
material settings of the first shape.

O Intersect: Intersect the first with the second shape — keeps the component and
material settings of the first shape.

O Insert: Insert the second shape into the first one — keeps both shapes while
changing the first shape only.

The trim operations are only available in a special “Shape intersection” dialog box which
appears when a shape is created that intersects or touches areas with existing shapes.
This dialog box will be explained later.

When multiple shapes are selected, you can access the Boolean add operation to unite

all selected shapes. You can also select more than one shape when you are prompted
to specify the second shape for Boolean subtract, intersect or insert operations.

Pick Points, Edges or Faces from within the Model

Many construction steps require the selection of points, edges or faces from the model.
The following section explains how to select these elementary entities interactively.

For each of the “pick operations,” you must first select the appropriate pick tool from
either the menu item Objects =Pick=>Pick Point/... or from an item in the pick toolbar:

Pick edge mid points “ Pick points on circles

AV OTORCEIE A |
| | T

Pick edge end points
Pick circle centers
Pick face centers

Pick edges

Pick faces

After you activate a pick tool, the mouse cursor will change indicating that a pick
operation is in progress. In addition, all pickable elements (e.g. points, edges or faces)
will be highlighted in the model. Now you can double-click on an appropriate item (point,
edge or face). Alternatively you can cancel the pick mode by pressing the Esc key,

selecting Leave pick mode from the context menu or clicking the ¥ item in the main
toolbar.

Note: You cannot pick edges or faces of a shape when another shape is currently
selected. In this case you should either select the proper shape or deselect all shapes.
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As soon as you double-click in the main view, the pick mode will be terminated; and the

selected point, edge, or face, will be highlighted. Note that if the <M symbol is selected
in the pick toolbar, the pick operation will not terminate after double-clicking. In this case
you have to cancel the pick mode as described above. This mode is useful when
multiple points, edges or faces have to be selected and it would be cumbersome to re-
enter the pick mode several times.

The following list gives an overview of which entities can be picked in the various pick
modes and what effect this picking will have. There are also some interesting shortcuts
for efficiently activating the pick modes which are available only when the main structure
view is the active window. You can activate this view by clicking in it with the left mouse
button. In the following list, all shortcuts are depicted in parentheses next to the
corresponding pick operation.

O Pick edge end points (P): Double-click close to the end point of an edge. The

corresponding point will then be selected.

Pick edge mid points (M): Double-click on an edge. The mid-point of this edge will

then be selected.

Pick circle centers (C): Double-click on a circular edge. The center point of this

edge will be selected. The edge need not necessarily belong to a complete circle.

Pick points on circles (R): Double-click on a circular edge. Afterward an arbitrary

point on the circle will be selected. This operation is useful when matching radii in

the interactive shape creation modes.

Pick face centers (A): Double-click on a planar face of the model. The center point

of this face will then be selected.

Pick edges (E): Double-click on an edge of the model to select it.

Pick faces (F): Double-click on a face of the model to select it.

Pick edge chain (Shift+E): Double-click on an edge of the model. If the selected

edge is a free edge, a connected chain of free edges will be selected. If the

selected edge is connected to two faces, a dialog box will appear in which you can

specify which one of the two possible edge chains bounding the faces will be

selected. In both cases the selection chain stops at previously picked points, if any.

O Pick face chain (Shift+F): Double-click on a face of the model. This function will
automatically select all faces connected to the selected face. The selection stops at
previously picked edges, if any.

O o O

ooo 0O

The pick operations for selecting points from the model are also valid in the interactive
shape creation modes. Here, whenever you are requested to double-click in order to
enter the next point, you may alternatively enter the pick mode. After leaving this mode,
the picked point will be taken as the next point for the shape creation.

Previously picked points, edges or faces can be cleared by using the Objects=Clear
Picks command (shortcut D in the main view) or by selecting @ in the pick toolbar.



CST MICROWAVE STUDIO ® 2006 — Getting Started 29

Chamfer and Blend Edges

One of the most common applications for picked edges is the chamfer and blend edge
operation. We assume you have created a brick and selected some of its edges, as
shown in the following picture:

Now you can perform a chamfer edge operation which can be activated either by

choosing Objects =*Chamfer Edges from the main menu or by selecting 4 in the objects
toolbar. In the following dialog box, you can specify the width of the chamfer. The
structure should look similar to the one depicted below:

Alternatively you can perform a blend edges operation which is activated either by

choosing Objects=*Blend Edges in the main menu or by selecting %4 in the objects
toolbar. In the following dialog box, you can specify the radius of the blend. The result
should look similar to the following picture:
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Extrude, Rotate and Loft Faces

The chamfer and blend tools are common operations on picked edges; and the extrude,
rotate and loft operations are equally typical construction tools for use on picked faces.
In the following, we assume an existing cylinder with a picked top face:

Now we can extrude this face by simply selecting the Objects =>Extrude ("") tool. When
a planar or cylindrical face is picked before this tool is activated, the extrusion refers to
the picked face, and the dialog box opens immediately:

-,

Extrude Face

tame:

solidd
Preview
Height;

oo Cancel

Twist: [deq.]
0.0

Taper: [deg.]
0.0 Help

I IIIM

Component:
companent] [

=)

b aterial:

= |

Wacuum [

If no face is picked in advance, an interactive mode will be entered in which you can
define polygon points for the extrusion profile. However, in this example you should
enter a height and click the OK button. Finally, your structure should look as follows:
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The extrusion tool has created a second shape by the extrusion of the picked face.

For the rotation, you should start with the same basic geometry as before:

The rotation tool requires the input of both a rotation axis and a picked face. The rotation
axis can be a linear edge picked from the model or a numerically specified edge. In this
example, you should specify the edge by selecting the Objects=*Pick=>Edge from

Coordinates ( A ) tool from the pick toolbar. Afterward you will be requested to pick two

points on the drawing plane to define the edge. Please select two points similar to those
in the following picture:
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Enter Edge Mum:
X (217
o
%2 (217 Help

Y2 &7

In the numerical edge dialog box, click the OK button to store the edge. Afterward you
can activate the rotate face tool by selecting Objects =>Rotate.

The previously selected rotation axis is automatically projected into the face’s plane
(blue vector), and the rotation tool dialog box opens immediately. In this dialog box, you
can specify an Angle (e.g. 90 degrees) and click OK. The final shape should look as
follows:
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Note that the rotate tool enters an interactive polygon definition mode similar to the one
in the extrude tool if no face is picked before the tool is activated.

One of the more advanced operations is generating lofts between picked faces. To
practice, construct the following model by defining a cylinder (e.g. radius=5, height=3)
and transforming it along its axis by a certain translation (e.g. (0,0,8)) using the Copy
option:

Transformed
cylinder

Next select the transformed cylinder and apply a scaling transformation to it by shrinking
its size along the x and y axes by 0.5 while keeping the z-scale at 1.0:



34

CST MICROWAVE STUDIO® 2006 — Getting Started

Now pick the adjacent top and bottom faces of the two cylinders as shown above.

Afterward you can activate the loft tool by selecting Objects =*Loft (.' ). In the following
dialog box you can set the smoothness to a reasonable value and click the Preview
button to get an impression of the shape. Drag the Smoothness slider such that the
shape has a relatively smooth transition between the two picked faces before clicking
OK.

Note: You should select the corresponding shape before picking its face. Since all other
shapes become transparent, it is easier to pick the desired face even “through” other
shapes.

5

Loft

Mame: 0K

]
-

Smoothness

i 1 Cancel
: N
: -
Lonw High
0.310000
Component:
|cump0nent1 M
I aterial:
= ]

Finally your model should look like the following picture (note that the actual form of the
lofted shape depends on the setting of the smoothness parameter).
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Face B

Finally, add all shapes together by selecting all three (holding down the Ctri-key) and
using the Objects =*Boolean =*Add operation. Now you can pick the two planar top and
bottom faces of the shape, select the shape by double-clicking on it and initiate the
Objects=Shell Solid or Thicken Sheet tool. Note that the shell command will be
accessible only when a shape has been selected previously.

1

Shell X |

Direction

o
() Centered

Thickness:

03 |

In the dialog box, you can specify a Thickness (e.g. 0.3) and click the OK button. After a
couple of seconds, your model should look similar to the following picture:
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Picking the two faces before entering the shell operation has the effect that the selected
faces will later be openings in the shelled structure. If no faces are selected, the
structure will be shelled to form a hollow solid.

Local Coordinate Systems

The ability to create local coordinate systems adds a great deal of flexibility to the
modeler. In the above sections we describe how to create simple shapes that are
aligned with the axes of a global fixed coordinate system.

The aim of a local coordinate system is to allow the easy definition of shapes even when
they are not aligned in the global coordinate system.

The local coordinate system consists of three coordinate axes. In contrast to the global
X, y and z axes, these axes are called the u, v and w axes. The local coordinate system
is also known as the Working Coordinate System (WCS).

Either the local or the global coordinate system can be active at any time. “Active” here
means that all the geometric data are specified in this coordinate system from now on.
You may activate or deactivate the local coordinate system from the WCS=Local
Coordinate System item in the main menu, from the WCS context menu item, or by

m
selecting the L item in the WCS toolbar. Each of these user interface items toggles the
local coordinate system on or off.

You have now learned what a local coordinate system (WCS) is and how it can be
activated, but you still need to know how to define this system in order to align its axes
with the desired location.

The most common way to define the orientation of a local coordinate system is to pick
points, edges or faces on the model and align the WCS with these entities.

O When a point is selected, the origin of the local coordinate system may be
translated onto this point (WCS =*Align WCS with Selected Point).

O When three points are selected, the u/v plane of the WCS can be aligned with the
plane defined by these points (WCS=Align WCS with 3 Selected Points).
Additionally this function will move the origin of the WCS onto the first selected
point.

O When an edge is selected, the u axis of the WCS may be oriented such that it
becomes parallel to the selected edge (WCS=Align WCS with Selected Edge).

O Finally, a planar face can be selected to which the u/v plane of the WCS can be
aligned (WCS =*Align WCS with Selected Face).

After picking a point, edge or face of the model, you could alternatively press the W key
in order to align the WCS with the most recently picked item. Together with the available
shortcut keys for the pick mode, this is the most efficient way of changing the location
and orientation of the WCS.

Besides aligning the WCS with entities selected from the model, there are three further
ways of defining the local coordinate system:

O Define local coordinate system parameters directly: (WCS=Define Local
Coordinates) In this dialog box, you may enter the origin and the orientation of the
w-axis and the u-axis directly.
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O Move local coordinate system: (WCS=Move Local Coordinates) In this dialog
box, you can translate the origin of the local coordinate system by a specified
translation vector.

O Rotate local coordinate system: (WCS =Rotate Local Coordinates) By using this
dialog box, you can rotate the local coordinate system around one of its axes by a
specified rotation angle.

The second and third options are especially powerful when combined with the pick
alignment options described above.

Most of the operations on the local coordinate system are also accessible from the WCS
toolbar, which is shown below:

Align WCS with selected face Align WCS with selected edge
e 2| e
| i
Toggle WCS on or off Move WCS Align WCS with 3 selected points
Rotate WCS Align WCS with selected point

The following example should give you an idea of what can be done by efficiently using
local coordinate system specifications:

The first step is to create a brick in global coordinates. Then rotate the brick around the
z-axis by 30 degrees using the transform dialog box:

1) 2)

z
ky
x

Next activate the local coordinate system, and align it first with the top face of the brick
and then with one of the vertices on the top face:
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Now align the coordinate system with one of the edges of the brick’s top face, and then
rotate the coordinate system 30 degrees around its v-axis:

Finally create a new cylinder in the local coordinate system. As soon as you have
defined the cylinder, a dialog box will open asking for the Boolean combination of the
two intersecting shapes. In this dialog box choose Add shapes and click OK:

W

7)
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The History List

Up to now, you have created some basic structures and performed some simple
geometric transformations. You can always correct mistakes made during the structure
generation by using the Edit=>Undo command to remove the most recent construction
step.

However, sometimes it may become necessary to return to a previous step in the
structure generation in order to change, delete or insert some operations.

This typical task is supported by CST MICROWAVE STUDIO® via the “History List." All
relevant structural modifications are recorded in a list you can see by choosing

Edit=>History List or by clicking "= in the objects toolbar.

In the following, we assume you have created the structure consisting of a brick and a
cylinder as shown in the last section covering local coordinate systems.
In this case, the history list will look like the following picture:

History List
niew compohent: component] Cloze
1 _: define brick: component]:zalid]
? — trangform: ratate component]:zolid]
pick face Restore
3 _E align wecz with face Step
pick end point
4 _C align weoz with paint [Un]kide
pick edge -
S _C align wes with edge Fix ' C5
6 — rotake wcs

) : . Delete
define cylinder: component] :zolid2
7 _E Macra...
Edit. ..
Find...

Update

Help

The list shows all previous operations in chronological order. The marker # indicates the
current position of the structure creation in the history list. You may restore the structure
creation to any step in the history list by selecting the corresponding line and clicking the
Restore button. Clicking the Step button will take you to the next step in the history list.
You can now experiment a bit with this feature.

Clicking the Update button completely regenerates the structure. The Edit button allows
you to perform changes to previous operations. In this case, select the “rotate wcs” line
and click the Edit button. The following dialog box will appear:
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Edit History List Item

rotate wos
WCS. Rotateh/T5 "y, 30"

[ ok [ Cancel ] [ Help ]

|

The text is actually the command, in macro language, which will perform the
corresponding task. Here the first argument “v” is the rotation axis while the second
argument specifies the rotation angle. You should now change the rotation angle to 10
degrees and click the OK button. Back in the history list, you should click the Update

button to regenerate the structure. Your structure should look like the following picture:

In general, the history functionality allows you to perform changes to the model quickly
and easily without having to re-enter the modified structure. However, some care has to
be taken when history items are altered since this may result in strong topological
changes appearing in the model. This often happens when some history items are
deleted or new items are inserted. In such cases, pick operations might select incorrect
points, edges, or faces (sometimes because the original picked items no longer exist).

As an example, assume you have deleted the creation of the first brick from the history
list. In this case, the pick of the brick’s top face in order to align the WCS with this face
will obviously fail.

In such cases we recommend you work through the history list from the beginning in
order to properly adjust the picks when needed. Even in this extreme case, the work
needed to change the model takes much less effort than completely re-entering the
model. Refer to the online documentation for details.
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The History Tree

The History List is the most powerful tool to edit the structure’s generation. However, in
many cases only some parameters of the basic shapes or transformations need to be
changed. In these cases, using the History Tree function is much more convenient.

Assume that you want to change the radius of the cylinder in the previous example. You
can open the history list and edit the generation of the cylinder. However, you can also
select the corresponding shape by double-clicking it and then choosing Edit=Object
Properties or Properties from the context menu.

A dialog box (the History Tree) will open showing the construction of the selected shape:

History Tree

Define brick
Transform [rotate]
= Add zshape: component];zolid2
Define cylinder

[ Cloze ] [ Help ]

You can now simply click the “Define cylinder” item. As soon as you have selected an
editable operation from the History Tree, the corresponding structure element will be
highlighted in the main view. Please note that subsequent transformations will not be
considered by this highlighting functionality.
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After clicking the Edit button in the History Tree dialog box, the cylinder creation dialog
box opens showing the parameters of the cylinder:

-,

Cylinder
Nans
Orientation: ()0 (O @i
Outer radius: Inner radius:

2 i
Ucenter: Yoenter:
a2 28
Wnir; Wma:
0 101
Seqgments:

1]

Cormponent;

td aterial:

You can now alter the cylinder radius and click the Preview button. You will get an
impression of how the structural changes will influence your model. If you are happy with
the result, click the OK button to update the structure.

Finally, your model should look as follows:

Play around a little with the History Tree to get an idea of what changes can be applied
to the existing structure using this functionality. Note that subsequent transformations
will not be visualized by the Preview option in the shape dialog box but will be applied
when you update the model.
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Curve Creation

The previous chapters show how a model can be generated from 3D primitives and their
modifications by using powerful operations such as blending, lofting, shelling, etc.

Another complex shape generation option is based on curves. A curve is a 3D line
drawn on the drawing plane. After a curve has been defined, it can be used for more
advanced modeling operations.

The following explanations give you only a basic introduction to the way curve modeling
works. A detailed description of all possibilities would exceed the scope of this
document. Refer to the online documentation for more information.

To practice, you should first create a new curve by selecting Curves=New Curve ( '5")
from the main menu. This operation will create a new item called “curve1” in the
navigation tree’s Curves folder.

Now activate the rectangle creation by choosing Curves=Rectangle (T:1 ) before
drawing a rectangle on the working plane. Creating curve items is similar to constructing
solid primitives.

Your result should look as follows:

Next draw a circle on the drawing plane which overlaps one of the rectangle’s edges.

Activate the circle creation by choosing Curves=Circle (@' ). Afterward, your screen
should look similar to the following:
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= <) cuvel .
At circle1
# circlel
WS
[i5]

(1 2D/2D Resuls
(0 Farfields

rectangle

E Unliled 0" [ Untited 0"

As a result of the previous steps, you now have two curve items — rectangle? and circle1
—in a curve named curve1. The navigation tree reflects this relationship.

Now let's trim both curve items so that the resulting curve contains only the outlines of
both curve items. First select one of the curve items, e.g. rectangle1 (either in the
navigation tree or by double-clicking on it in the main view). Afterward activate the Trim

Curves operation by choosing Curves=Trim Curves (=) from the main menu.

You will be prompted to select the item to be trimmed with the rectangle. Select the
circle and confirm your selection by pressing the Return (,4) key.

The next step will prompt you to double-click on any curve segments you wish to delete
from the model. When you move the mouse across the screen, all selectable curve
segments at the mouse location will be highlighted. You should now delete two
segments so that the result looks similar to the following picture before you press Return

(,4) to complete the operation.
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Now you can activate the local coordinate system and rotate it around its u-axis. Your
model should look as follows:

5

The next action is to draw an open polygon consisting of three points on the drawing
plane (Curves=Polygon, ™<").

Point 1

Point 3

Based on these two disjoint curves, you are going to create a solid using the sweep

curves operation which can be initiated by choosing Curves=Sweep Curve (H"\) from
the main menu.

As soon as this operation is activated, you will be prompted to select the profile curve.
Double-click on the curve consisting of the rectangle and the circle.
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After the profile is selected, you will be requested to double-click on the path curve given
by the polygon’s curve here. After you close the resulting dialog box by clicking OK, the
final shape should look as follows:

This short introduction into curve modeling provides a very basic understanding of these
powerful structure drawing tools. You should experiment a little with the curve modeling
features to become more familiar with this kind of structure modeling. Please refer to the
online documentation for more details.

Trace Creation

The next section focuses on a rather tedious part of the model creation: the definition of
conducting traces. Some structures (e.g. printed circuit boards) require many traces
which often entail many time-consuming construction steps.

To simplify this task, a trace tool has been added to allow the creation of solid traces
with finite width and thickness based on the definition of curves.

To practice using this powerful tool, draw an open but otherwise continuous curve such
as the following:
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Based on this curve, you can now easily create a trace by choosing Curves=*Trace

From Curve (@). As soon as this operation is activated, you will be prompted to select
the trace’s curve.

After you double-click on the previously defined curve, the following dialog box will open:

Create Trace from Curve
Marme:
solid!
Thickness:
width

Fiounded caps

[ 5tart CJEnd
Cormponent;
campanent] [V
td aterial:
WYacuum ~|

In this dialog box, you can specify the metallization Thickness and the Width of the
trace. You can also specify whether the trace should have rounded caps (instead of
rectangular caps) at the start or end of the trace’s path.

The resulting trace might look as follows (rounded caps at the end of the trace only):
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Bondwire Creation

You can create bondwires as frequently used structure elements easily using the
bondwire tool. The easiest way to define a bondwire between two points is to pick those
points first as shown in the following picture:

Once the points are picked, you can open the bondwire dialog box by choosing Objects=*Basic

Shapes =Bondwire ( £ ).

Bond Wire

Mame: |wire1

Geomety

Type: R adiuz:

|JEDEC# [v| |00 |
Height: Fozitiar of masirmun;
13.35 | o5 |

&lpha [angle at pamt 1] Beta [angle at pamt 2];

|75 | [35

Fazition
w1 1 21

[-3.05 | [1.3 | |01

| Uze pick

K Y 22

|3 55 | [1.3 | |c|.i

| Usze pick

tdodeling
[ 5olid wire model
I aterial:

FEC

Termination:
Extended

You can also open the dialog box without any points being picked previously. In this
case, you may specify the coordinates of the bondwire’s start and end points

numerically.

The type of the bondwire can be spline, JEDEC4 or JEDECS. The location of the
spline’s maximum can be specified whereas the other two models accept the
standardized parameters.
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The following picture shows the three different types of bondwires:

Spline JEDEC4 JEDECS

Refer to the online documentation for more information about JEDEC parameters.

You may also assign a finite radius to the wire by specifying a non-zero entry in the
Radius field. However, the wire will still be modeled as infinitely thin, but the solver
module will apply a special model to the wire in order to take the finite radius into
account. Please note that this feature is not supported by solvers based on tetrahedral
grids.

In addition to this option of modeling the bondwire as infinitely thin wire, the dialog box
also supports the creation of solid bondwires by offering the Solid wire model option. As
for every other solid, a solid bondwire needs a material to be assigned to it.

The Termination of the bondwire may be set to any one of the following types:

O Natural: The wire will be a solid tube with perpendicular cuts at the end.

O Rounded: The wire will be terminated by a part of a sphere.

O Extended: This is the most powerful option. In this case, the software detects
the plane in which the bondwire ends. Then the wire extends toward this plane
in order to ensure an optimal connection with this plane.

The following picture illustrates the three types of termination:

Natural Rounded Extended

N\
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Local Modifications

So far we have focused on how to change a structure that has been entirely constructed
within CST MICROWAVE STUDIO®. However, sometimes the model will consist of
imported geometry for which no information about the modeling process is available.

This section illustrates that even in these cases the structure can be parameterized
using Local Modifications. Before you can start using these advanced modeling tools,
you must create a structure similar to the following (a brick unified with a cylinder and a
chamfer operation applied to the cylinder's top edge):

In this structure you should first use the pick face tools in order to select the chamfer’s
face. Then you can initiate the remove feature command by selecting Objects=Local
Modifications =>Remove Feature from the main menu.

Chamfer’s
face

—

Remove
Feature

As you can see, the gap that would be produced by simply removing the face will
automatically be closed with the remove feature operation. Afterward, you should pick
the cylindrical face and select the Objects=Local Modifications =>Change Face Radius
command. A dialog box will open where you can specify a new radius of the cylinder.
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Cylindrical
face

—

Change
Face Radius

Finally, you can pick the cylinders top face and initiate the Objects=*Local
Modifications =>Offset Faces command. Specifying an offset in the dialog box will move
the face while again closing any gaps:

Top face
e
Offset
Face

The local modifications are powerful modeling operations. However, the modifications
will fail if there is no unique solution for closing the gaps. You should play around a bit
with these tools to get an impression of what is possible.
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The First Real World Application Example

The previous chapters focus on the elementary concepts of the structure modeler. Now
it is time to start on the first real world application example.

The following example shows a fairly simple S-parameter calculation. Studying this
example carefully will help you become familiar with many standard operations that are
important when performing a simulation with CST MICROWAVE STUDIO®.

Go through the following explanations carefully, even if you are not planning to use the
software for S-parameter computations. Only a small portion of the example is specific
to this particular application type while most of the considerations are general to all
solvers and application domains.

In subsequent sections you will find some remarks concerning the differences of the
typical procedures for other kinds of simulations.

The following explanations describe the “long” way to open a particular dialog box or to
launch a particular command. Whenever available, the corresponding toolbar item will
be displayed next to the command description. Because of the limited space in this
manual, the shortest way to activate a particular command (i.e. by either pressing a
shortcut key or by activating the command from the context menu) is omitted. You
should regularly open the context menu to check available commands for the currently
active mode.

The Structure

In the example, you will model a simple coaxial bend with a tuning stub. You will then
calculate the broadband S-parameter matrix for this structure before looking at the
electromagnetic field inside this structure at various frequencies. The following picture
shows the current structure of interest (it has been sliced open to aid visualization). The
picture is produced using the POV export option.
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Before you start modeling the structure, let's spend a few moments discussing how to
describe this structure efficiently. Due to the outer conductor of the coaxial cable, the
structure is sealed as if it were embedded in a perfect electric conducting block (apart, of
course, from the ports). For simplification, you can thus model the problem without the
outer conductor and instead embed it in a perfect conducting block.

In order to simplify this procedure, CST MICROWAVE STUDIO® allows you to define the
properties of the background material. Anything you do not fill with a particular material
will automatically be filled with the background material. For this structure, it is sufficient
to model the dielectric parts and define the background material as a perfect electric

conductor.

Your method of describing the structure should be as follows:

1. Model the dielectric (air) cylinders.

2. Model the inner conductor inside the dielectric part.

Start CST MICROWAVE STUDIO®

After starting CST DESIGN ENVIRONMENT™ and choosing to create a new CST
MICROWAVE STUDIO® project, you will be asked to select a template for a structure

which is closest to your device of interest.

-

Create a New Project

-,

Select a template for the new project

¢<Monex

Antenna [in Free Space, planar]
Antenna [in Free Space, waveguide]
Antenna [on Planar Substrate)
Antenna [with Ground Plane)
Antenna Srray Unit Cell [FO)
Conmectar [Coasial]

Cannector [Mulkipin]

EMC-EMI Problem

FS5 - Unit Cell [FD

|C Package

LTCC

MAFLA Project

Planar Coupler [Microstip, Coplanar]
Flanar Filter

RCS

Resonator

RFID

waveguide Coupler

waveguide Filter

I (1]:8 l [ Cancel

Dezcnption

. \ NS
-

Units: mm, ghz
Backaround: pec
Boundaries: electric

Shows thiz dialog bos when a new project iz created

For this example, select the coaxial connector template and click OK
default settings will adjust in order to simplify the simulation set up for the coaxial

connector.

. The software’s
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Open the Quick Start Guide

An interesting feature of the online help system is the Quick Start Guide, an electronic
assistant that will guide you through your simulation. You can open this assistant by
selecting Help =>Quick Start Guide if it does not show up automatically.

The following dialog box should now be positioned in the upper right corner of the main
view:

QuickStart Guide X

) Frequency Domain Analysis
Mewt »>

If your dialog box looks different, click the Back button to get the dialog above. In this
dialog box you should select the Problem Type “Transient analysis” and click the Next
button. The following window should appear:

QuicksStart Guide =
g

Tranzient Analyzis:
+ Set units
v Set background material
= Define stucture
Set frequency
Set ports
Set boundary conditions
Set field monitars
Start solbeer

Analyze results
<¢Back

The red arrow always indicates the next step necessary for your problem definition. You
may not have to process the steps in this order, but we recommend you follow this guide
at the beginning in order to ensure all necessary steps have been completed.

Look at the dialog box as you follow the various steps in this example. You may close
the assistant at any time. Even if you re-open the window later, it will always indicate the
next required step.

If you are unsure of how to access a certain operation, click on the corresponding line.
The Quick Start Guide will then either run an animation showing the location of the
related menu entry or open the corresponding help page.
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Define the Units

The coaxial connector template has already made some settings for you. The defaults
for this structure type are geometrical lengths in mm and frequencies in GHz. You can
change these settings by entering the desired settings in the units dialog box
(Solve =Units), but for this example you should just leave the settings as specified by the
template.

Define the Background Material

As discussed above, the structure will be described within a perfectly conducting world.
The coaxial connector template has set this typical default value for you. In order to
change these settings, you may make changes in the corresponding dialog box
(Solve =Background Material). For this example, you don’t need to change anything.

Model the Structure

The first step is to create a cylinder along the z-axis of the coordinate system:

1.

N

Noo ko

Select the cylinder creation tool from the main menu: Objects=Basic
Shapes =Cylinder ().

Press the Shift+Tab key and enter the center point (0,0) in the xy-plane before
pressing the Return key to store this setting.

Press the Tab key again, enter the radius 2 and press the Return key.

Press the Tab key, enter the height 12 and press the Return key.

Press Esc to create a solid cylinder (skip the definition of the inner radius).

In the shape dialog box, enter “long cylinder” in the Name field.

You may simply select the predefined material Vacuum (which is very close to air)
from the list in the Material field. Here we are going to create a new material “air” to
show how the layer creation procedure works, so select the New Material entry in
the list of materials.

In the material creation dialog box, enter the Material name “air," select Normal
dielectric properties (Type) and check the material properties Epsilon = 1.0 and Mue
= 1.0. Then select a color and close the dialog box by clicking OK.

In the cylinder creation dialog box, your settings should now look as follows:
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Finally, click OK to create the cylinder.

-

Cylinder

Mame:
lorng cylinder

Orientation: 3%

Outer radius:

2

Hoenter:
1]

Zmit;
1]

Seqgments:
1]

Campanent;

Oy @2

Inner radius:

o

Yoenter:
0

Zmas:
12

Preview
Cancel

|com|:u:nent1

[¥]

I aterial:

| air

o ]

The result of these operations should look like the picture below. You can press the

Space bar to zoom in to a full screen view.

==l

(] Components

(23 Materials
(2] Faces
(3 Curves
(3 wLs
(3 Wires
(1 Lumped Elements
(] Plane Wave
3 Paits
(L Current Distributions
(3 Excitation Signals
(2 Field Manitars
(13 Voktage Monitors:
(] Probes

(2 Mesh Control
(1 1D Resuks
(1 2D/30 Results
(2 Farfields

QuickStart Guide B
el

Transient Analysis:
 Setunits
+ Set background material
+ Define struchure
= Set frequency
Set ports
Set boundary conditions
Set field moritors

Start zobrer

Analyze results
<<Back

E  Unlitled_0* [} Unlitled_0"

The next step is to create a second cylinder perpendicular to the first. The center of the

new cylinder’s base should be aligned with the center of the first one.

Follow these steps to define the second cylinder:

1. Select the wire frame draw mode: View= View Options (@) or use the shortcut

Ctrl+W.

Activate the “circle center” pick tool: Objects =*Pick =Pick Circle Center (G').
Double-click on one of the cylinder’'s circular edges so that a point is added in the

wnN

center of the circle.
4. Perform steps 2 and 3 for the cylinder’s other circular edge.
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Now the construction should look like the following:

PL(X,Y,2) 12
PZ(X,Y,2)
Pz - P1

IPZ2 - P11

ool
)
=

=12

NES®
. v

-

Next replace the two selected points by a point in between the two by selecting
Objects Pick=>Mean Last Two Points from the menu.

You can now move the origin of the local coordinate system (WCS) to this point by
choosing WCS=Align WCS With Selected Point (k") from the main menu. The screen
should look like this:
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Now align the w axis of the WCS with the proposed axis of the second cylinder.

1. Select WCS=Rotate Local Coordinates (&) from the main menu.
2. Select the U axis as rotation Axis and enter a rotation Angle of —90 degrees.
3. Click the OK button.

Alternatively you could press Shift+U to rotate the WCS by 90 degrees around its u axis.
Thus pressing Shift+U three times has the same effect as the rotation by using the
dialog box described above.

Now the structure should look like this:

The next step is to create the second cylinder perpendicular to the first one:

1. Select the cylinder creation tool from the main menu: Objects=Basic
Shapes =Cylinder (€).

Press the Shift+Tab key and enter the center point (0,0) in the uv-plane.

Press the Tab key again and enter the radius 2.

Press the Tab key and enter the height 6.

Press Esc to create a solid cylinder.

In the shape dialog box, enter “short cylinder” in the Name field.

Select the material “air” from the material list and click OK.

Nooakod

Now the program will automatically detect the intersection between these two cylinders.
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=l
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In the “Shape intersection” dialog box, choose the option Add both shapes and click OK.
Finally the structure should look like this:

The creation of the dielectric air parts is complete. The following operations will now
create the inner conductor inside the air.
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Since the coordinate system is already aligned with the center of the second cylinder,
you can go ahead and start to create the first part of the conductor:

1. Select the cylinder creation tool from the main menu: Objects=Basic
Shapes =Cylinder (&).

Press the Shift+Tab key and enter the center point (0,0) in the uv-plane.

Press the Tab key again and enter the radius 0.86.

Press the Tab key and enter the height 6.

Press Esc to create a solid cylinder.

In the shape dialog box, enter “short conductor” in the Name field.

Select the predefined Material PEC (perfect electric conductor) from the list of
available materials and click OK to create the cylinder.

Noakon

At this point we should briefly discuss the intersections between shapes. In general,
each point in space should be identified with one particular material. However, perfect
electric conductors can be seen as a special kind of material. It is allowable for a perfect
conductor to be present at the same point as a dielectric material. In such cases, the
perfect conductor is always the dominant material. The situation is also clear for two
overlapping perfectly conducting materials, since in this case the overlapping regions will
also be perfect conductors.

On the other hand, two different dielectric shapes must not overlap each other.
Therefore the intersection dialog box will not be shown automatically in case of a perfect
conductor overlapping with a dielectric material or with another perfect conductor.

Background information: Some structures contain extremely complex conducting parts
embedded within dielectric materials. In such cases, the overall complexity of the model
can be significantly reduced by NOT intersecting these two materials. This is the reason
CST MICROWAVE STUDIO® allows this exception. However, you should always make
use of this feature whenever possible, even in such simple structures as this example.

The following picture shows the structure as it should currently look:



CST MICROWAVE STUDIO ® 2006 — Getting Started 61

Now you should add the second conductor. First align the local coordinate system with
the upper z circle of the first dielectric cylinder:

1.
2.

3.

Select Objects =>Pick =>Pick Face (M) from the main menu.
Double-click on the first cylinder’s upper z-plane. The selected face should now be
highlighted:

Now choose WCS=Align WCS With Selected Face (L) from the main menu.

The w-axis of the local coordinate system is aligned with the first cylinder’s axis, so you
can now create the second part of the conductor:

1.

NooRLN

Select the cylinder creation tool from the main menu: Objects=>Basic
Shapes=Cylinder (€).

Press the Shift+Tab key and enter the center point (0,0) in the uv-plane.

Press the Tab key again and enter the radius 0.86.

Press the Tab key and enter the height —11.

Press Esc to create a solid cylinder.

In the cylinder creation dialog box enter “long conductor” in the Name field.

Select the Material “PEC” from the list and click OK.

The newly created cylinder intersects with the dielectric part as well as with the
previously created PEC cylinder. Even if there are two intersections (dielectric / PEC and
PEC / PEC), the Shape intersection dialog box will not be shown here since both types
of overlaps are well defined. In both cases the common volume will be of type PEC.

Congratulations! You have just created your first structure within CST MICROWAVE
STUDIO®. The view should now look like this:
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The following gallery shows some views of the structure available using different
visualization options:

Shaded view Shaded view Shaded view
(deactivated working (long conductor (cutplane activated
plane, Ctrl+W) selected) View=Cutting Plane, -]

Appearance of part above
cutplane = transparent)

Define the Frequency Range

The next important setting for the simulation is the frequency range of interest. You can
specify the frequency by choosing Solve =*Frequency (") from the main menu:

= =~

Frequency Range Settings E
Ermire
0.0 ) :

i
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In this example you should specify a frequency range between 0 and 18 GHz. Since you
have already set the frequency unit to GHz, you need to define only the absolute
numbers 0 and 18 (the status bar always displays the current unit settings).

Define Ports

The following calculation of S-parameters requires the definition of ports through which
energy enters and leaves the structure. You can do this by simply selecting the
corresponding faces before entering the ports dialog box.

For the definition of the first port, perform the following steps:
1. Select Objects >>Pick=Pick Face (H) from the main menu.

2. Double-click on the upper z-plane of the dielectric part. The selected face will be
highlighted:

3. Open the ports dialog box by selecting Solve =Waveguide Ports (Jl) from the main

menu:
Waveguide Port
G I
M ame: 1 4

Orientation:  (O) Positive (3) Negative
Teut gize: » large
I

Pazition

Coodinates: () Free () Fullplane (%) Use picks

Hrin; | -2 - |00 Hrnaw |2 + 0.0
roin: -2 - 0o mas | 2 + 0.0
Zpox 12

Reference plans

Distance to ref. plane; |0

Mode seftings
[ Multipin part Murnber of modes:
1 [

E3

[ Impedance and calibration [ Polarization angle
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Everything is already set up correctly for the coaxial cable, so you can simply click
OK in this dialog box.

Once the first port has been defined, the structure should look like this:

You can now define the second port in exactly the same way. The picture below shows
the structure after the definition of both ports:

The correct definition of ports is very important for obtaining accurate S-parameters.
Please refer to the Choose the Right Port section later in this manual to obtain more
information about the correct placement of ports for various types of structures.
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Define Boundary and Symmetry Conditions

The simulation of this structure will only be performed within the bounding box of the
structure. You may, however, specify certain boundary conditions for each plane
(Xmin/Xmax/Ymin/Ymax/Zmin/Zmax) of the bounding box.

The boundary conditions are specified in a dialog box you can open by choosing
Solve =Boundary Conditions from the main menu.
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While the boundary dialog box is open, the boundary conditions will be visualized in the
structure view as in the picture above.

In this simple case, the structure is completely embedded in perfect conducting material,
so all the boundary planes may be specified as “electric” planes (which is the default).

In addition to these boundary planes, you can also specify “symmetry planes." The
specification of each symmetry plane will reduce the simulation time by a factor of two.

In our example, the structure is symmetric to a yz-plane perpendicular to the x-axis in
the center of the structure. The excitation of the fields will be performed by the
fundamental mode of the coaxial cable for which the magnetic field is shown below:

l—
=5 b ) FF»\\\
vverHrhAL
AhAhaad
/{jj:;yy gggxxkh\
IV EEAALL

V4

-

S

Y Y S

»»;?w\\\\

(4 4 2 3 3 N N
YyvvwerrbhhbhAAA
vV EEERAAAAL
yyww<ass
T WCddaddh

Q
4
)
<
A
Y
v
14
¥
4
»r
»

CYVvEEBRAAAAL
4vvvv>~AA:\

/

YYNNRAALL S

yyvvwvfhasssrsp
YYVY RN ALALLL PP

yvvvwwhkaasss s/
\iyww~<4445y

Il
—

Plane of structure’s symmetry (yz-plane)

0}
<
<
|
A\l
Al
v
14
4
[
4
»
»

YYVVeERddda




66

CST MICROWAVE STUDIO® 2006 — Getting Started

The magnetic field has no component tangential to the plane of the structure’s symmetry
(the entire field is oriented perpendicular to this plane). If you specify this plane as a
“‘magnetic” symmetry plane, you can direct CST MICROWAVE STUDIO® to limit the
simulation to one half of the actual structure while taking the symmetry conditions into
account.

In order to specify the symmetry condition, you first need to click on the Symmetry
Planes tab in the boundary conditions dialog box.

For the yz-plane symmetry, you can choose magnetic by either selecting the appropriate
option in the dialog box or double-clicking on the corresponding symmetry plane
visualization in the view and selecting the proper choice from the context menu. Once
you have done so, your screen will appear as follows:

B8

Boundaries | Symmetty Planes | Boundary Temperalure

YZ plane: | magnelic (Ht = 0) [+

®eoo®

® B
porpooroooorororeo,

ok [ cancel ][ Heh

E Untilled_0* |d United 0"

Finally click OK in the dialog box to store the settings. The boundary visualization will
then disappear.
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Visualize the Mesh

In a first simulation we will run the transient simulator based on hexahedral grids. Since
this is the default mesh type, we don’t need to change anything here. In a later step we
show how to apply a tetrahedral mesh to this structure, run the frequency domain solver
and compare the results. However, let's focus on the hexahedral mesh generation
options first.

The hexahedral mesh generation for the structure analysis will be performed
automatically based on an expert system. However, in some situations it may be helpful
to inspect the mesh to improve the simulation speed by changing the parameters for the
mesh generation.

The mesh can be visualized by entering the mesh mode (Mesh=Mesh View (£)). For
this structure, the mesh information will be displayed as follows:

VR W — S R S
o R O L WO S W

One 2D mesh plane is always kept in view. Because of the symmetry setting, the mesh
plane extends across only one half of the structure. You can modify the orientation of
the mesh plane by choosing Mesh=X/Y/Z Plane Normal (3./Z%/Z%). Move the plane
along its normal direction using Mesh =Increment/Decrement Index (58/%8) or using the
Up ! Down cursor keys.

The red points in the model are critical points (so-called fixpoints) where the expert
system finds it necessary to have mesh lines at these locations. In addition, the yellow
dots show points where the automatic mesh generation finds the need for improving the
mesh density.

In most cases the automatic mesh generation will produce a reasonable initial mesh, but
we recommend that you later spend some time on the mesh generation procedures in
the online documentation when you feel familiar with the standard simulation procedure.
You should now leave the mesh inspection mode by again toggling: Mesh=Mesh View
().
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Start the Simulation

After defining all necessary parameters, you are ready to start your first simulation.

Start the simulation from the transient solver control dialog box: Solve =*Transient Solver
'

(=T).

-

Transient Solver Parameters

Salver zethings Start
Aoouracy:

A0 w | dB [ Stare result data in cache Dptimize...

Far. Sweep...
Stimulation gettings

Source type: | Al Ports W [JInhamogenesaus part

Specials...
accuracy enhancement
Maode: All w [ Calculate modes anly Simplify Model...
S-parameter zettings
= = Apply
[] Marmalize to fixed impedance [15-parameter symmetries o
ose
Oz

Help

III II III x|

Adaptive mezh refinement

[] &daptive mesh refinement

Metwork, computing

[] Metwork computing

In this dialog box, you can specify which column of the S-matrix should be calculated.
Therefore select the Source type port for which the couplings to all other ports will then
be calculated during a single simulation run. In our example, by setting the Source type
to Port 1, the S-parameters S11, S21 will be calculated. Setting the Source Type to Port
2 will calculate S22 and S12.

In some cases where the full S-matrix is needed, you may also set the Source Type to
All Ports which implies that one calculation run will be performed for each port. However
for loss free, two port structures (like the structure investigated here), the second
calculation run will not be performed since all S-parameters can be calculated from one
run using analytic properties of the S-matrix.

In this case you should compute the full S-matrix and leave All Ports as your Source
type setting.

The S-parameters which are calculated will always be normalized to the port impedance

(which will be calculated automatically) by default. In this case the port impedance will
be approximately

2
138-log(—2—) = 50.58 Ohms
& 36’
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for the coaxial lines with the specified dimensions and dielectric constants. However,
sometimes you need the S-parameters for a fixed normalization impedance (e.g. 50
Ohms), so check the Normalize to fixed impedance button and specify the desired
normalization impedance in the entry field below. In this example we assume that you
want to calculate the S-parameters for a reference impedance of 50 Ohms. Note that the
re-normalization of the S-parameters is possible only when all S-parameters are
calculated (Source Type = All Ports).

While solution accuracy mainly depends on the discretization of the structure and can be
improved by refining the mesh, the truncation error introduces a second error source in
transient simulations.

In order to obtain the S-parameters, the transformation of the time signals into the
frequency domain requires the signals to have sufficiently decayed to zero. Otherwise a
truncation error will occur causing ripples on the S-parameter curves.

CST MICROWAVE STUDIO® features an automatic solver control that stops transient
analysis when the energy inside the device, and thus the time signals at the ports, has
sufficiently decayed to zero. The ratio between the maximum energy inside the structure
at any time and the limit at which the simulation will be stopped is specified in the
Accuracy field (in dB).

In this example we will limit the maximum truncation error down to 1% for which you
should keep the default solver Accuracy at —40 dB.

The solver will excite the structure with a Gaussian pulse in time domain. However, all
frequency domain and field data obtained during the simulation will be normalized to a
frequency independent input power of 1 W.

After setting all these parameters, the dialog box should look like this:

Transient Solver Parameters
Salver zettings
Accuracy:
.40 | dB [] Stare result data in cache Optimize...

Far. Sweep...
Stimulation zettings

Source type: | Al Ports w |:| Inhomogeneous part

Specialz...
accuracy enhancemment e
Mode: All v [ Calculate modes orily Simplify Model...
S-parameter settings
F . Apply
Maormmalize to fired impedance [15-parameter symmatries o
oze
a0 Ohms

Help

Adaptive mezh refinement

[] &daptive mesh refinement

Metwork, computing

[] Metwork computing

You can now start the simulation procedure by clicking the Start solver button. A
progress bar will appear in the status bar which will update you on the solver's progress.
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Information text regarding the operation will appear next to the progress bar. The most
important stages are listed below:

1.

2.

Calculating matrices, preparing and checking model: During this step, your
input model is checked for errors such as invalid overlapping materials.

Calculating matrices, normal matrix and dual matrix: During these steps, the
system of equations, which will subsequently be solved, are set up.

Transient analysis, calculating the port modes: In this step, the solver calculates
the port mode field distributions and propagation characteristics as well as the port
impedances. This information will be used later in the time domain analysis of the
structure.

Transient analysis, processing excitation: During this stage, an input signal is
fed into the stimulation port. The solver then calculates the resulting field distribution
inside the structure as well as the mode amplitudes at all other ports. From this
information, the frequency dependent S-parameters are calculated in a second step
using a Fourier Transformation.

Transient analysis, transient field analysis: After the excitation pulse has
vanished, there is still electromagnetic field energy inside the structure. The solver
then continues to calculate the field distribution and the S-parameters until the
energy inside the structure has decayed below a certain limit (specified by the
Accuracy setting in the solver dialog box).

For this simple structure, the entire analysis takes only a few seconds to complete.

Analyze the Port Modes

After the solver has completed the port mode calculation, you can view the results (even
if the transient analysis is still running).

In order to visualize a particular port mode, you must choose the solution from the
navigation tree. You can find the mode in port 1 from NT (stands for the navigation
tree) =2D/3D Results=>Port Modes=Port1. If you open this subfolder, you may select
the electric or the magnetic mode field. Selecting the folder for the electric field of the
first mode e 7 will display the port mode and its relevant parameters in the main view:

(1 1D Results
E123 20/3D Results
123 Port Modes

(2 Farfields Mode type = TEM

V/m
16631
93062
7973
6644
5315
3986
2658
1329
a

=42 Portl
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Iy Trre = E-Field (peak)

Accuracy = Z.16399e-614
Beta = 188.626 1/m
Wave Imp. = 376.73 Ohms
Line Imp. = 58.6191 Ohms

Plane at z = 12
Frequency =9
Phase = 0 degrees
Maximum-Zd = 10630.6 Y/m at ©.286667 / -0.86 / 12

E getting started il getting started
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Besides information on the type of mode (here TEM), you will also find the propagation
constant (beta) at the central frequency. Additionally port impedance is calculated
automatically (line impedance).

You will find that the calculated result for the port impedance of 50.62 Ohms agrees well
with the analytical solution of 50.58 Ohms. The small difference is caused by the
discretization of the structure. Increasing the mesh density will improve the agreement
between simulation and theoretical value. However, the automatic mesh generation
always tries to choose a mesh that provides a good trade off between accuracy and
simulation speed.

You can adjust the number and size of arrows in the dialog box, which can be opened
by choosing Results =Plot Properties (or Plot Properties in the context menu).

Furthermore you may perform a scalar field visualization by opening the e? folder and
selecting one of its field components (e.g. X). The selected field component will be
visualized as a contour plot by default:
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You may change the type of the scalar visualization by selecting a different visualization
option in the corresponding dialog box: Results=Plot Properties (or Plot Properties in
the context menu).

You should play around a bit here to become familiar with the different visualization
options before you proceed with the next step.
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Analyze the S-Parameters

After a simulation has finished, you should always look at the time signals of the port
modes. You can visualize these signals by choosing NT{(navigation tree)=1D
Results =Port signals. After selecting this folder, the following plot should appear:

Time Signals
1
il
ol 1
02,1
000 e e N e
O e vﬁ ]
05 H : i
0 01 0.2 0.3 04

Tirme / ns

The input signals are named with reference to their corresponding ports: i1 (for port 1),
i2 and so on. The output signals are similarly named “01,1," “02,1," etc. so that the
number following the comma indicates the corresponding excitation port.

To obtain a sufficiently smooth frequency spectrum of the S-parameters, it is important
that all time signals decay to zero before the simulation stops. The simulation will stop
automatically when this criterion is met.

The most interesting results are, of course, the S-parameters themselves. You may
obtain a visualization of these parameters in linear scale by choosing NT=1D
Results =2|S| linear.
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S-Parameter Magnituide
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You can change the axis scaling by selecting Results=1D Plot Options =Plot Properties
from the main menu (or the context menu). In addition, you can display and hide an axis
marker by toggling Results=1D Plot Options=Show Axis Marker. The marker can be
moved either with the cursor keys (Left or Right) or by picking and dragging it with the
mouse.

The marker helps to determine the minimum of the transmission (S1,2 or S2,1) at about
12.87 GHz.

In the same way as above, the S-parameters can be visualized in logarithmic scale (dB)
by choosing NT=1D Results=|S| dB. The phase can be visualized by choosing NT=1D
Results=arg(S).

Furthermore the S-parameters can be visualized in a Smith Chart (NT=1D
Results ®Smith Chart).

o 0.0000 S-Pararneter Srrith Chart S1,1( 50 chm)

. 1500 $2,2( 50 0hm)

Parameter = Frequency / GHz
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In this plot you can add markers to the curves by simply double-clicking on the
corresponding positions on the curves. You may delete these markers in a properties
dialog box: Results=>1D Plot Options=Plot Properties (or Plot Properties from the
context menu).

Adaptive Mesh Refinement

As already mentioned above, the mesh resolution influences the results. The expert
system-based approach analyzes the geometry and tries to identify the parts that are
critical to the electromagnetic behavior of the device. The mesh will then automatically
be refined in these regions. However, due to the complexity of electromagnetic
problems, this approach may not be able to determine all critical domains in the
structure. To circumvent this problem, CST MICROWAVE STUDIO® features an
adaptive mesh refinement which uses the results of a previous solver run in order to
improve the expert system’s settings.

Activate the adaptive mesh refinement by checking the corresponding option in the
solver control dialog box.
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III II III ]

Help

Adaptive mesh refinement

[“litdaptive mesh refinement [ Adaptive Properties... ]

Metwork computing

[ I Metwork computing

Click the Start button. The solver will now perform several mesh refinement passes until
the S-parameters no longer change significantly between two subsequent passes.

After two passes have been completed, the following dialog box will appear:

CST MICROWAVE STUDIO

<9 The expert systen has now been brained o vield resulks
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Do wou wish bo deackivate the mesh adapation Ffor Further
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| Yes | [ Mo
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Since the automatic mesh adaptation procedure has successfully adjusted the expert
system’s settings in order to meet the given accuracy level (2% by default), you may
now switch off the adaptive refinement procedure for subsequent calculations. The
expert system will apply the determined rules to the structure even if it is modified
afterward. This powerful approach allows you to run the mesh adaption procedure just
once and then perform parametric studies or optimizations on the structure without the
need for further mesh refinement passes.

You should now confirm deactivation of the mesh adaptation by clicking the Yes button.

When the analysis has finished, the S-parameters and fields show the converged result.
The progress of the mesh refinement can be checked by looking at the NT=1D
Results=Adaptive Meshing folder. This folder contains a curve which displays the
maximum difference between two S-parameter results belonging to subsequent passes.
This curve can be shown by selecting NT=1D Results =*’Adaptive Meshing=Delta S.

Maxdmurn Delta S versus Passes
0.0034
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0.0032 _

0.0031 _

___________________________________________________________________________________________________________________________________________
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___________________________________________________________________________________________________________________________________________
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00028 _

0.0027

18 19 2 21 2.2

Since the mesh adaptation requires only two passes for this example, the Delta S curve
consists of a single data point only. The result shows that the maximum difference of the
S parameters from both runs is around 0.3% for the whole frequency range. The mesh
adaptation stops automatically when the difference is below 2%. This limit can be
changed in the adaptive mesh refinement Properties (accessible from within the solver
dialog box).

Additionally, the convergence of the S-parameter results can be visualized by selecting
NT=1D Results=>Adaptive Meshing=|S| linear=*S1,1 versus Passes, and NT=1D
Results 2Adaptive Meshing =*|S| linear=S2,1 versus Passes, respectively.
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You can see that expert system-based meshing provides a good mesh for this structure.
The convergence of the S-parameters shows only small variations from the results
obtained using the expert system generated mesh to the converged solution.

Another result from the adaptive meshing procedure is the ability for you to visualize
how the port impedance changes versus the number of adaptive passes by selecting
NT=1D Results =>Adaptive Meshing=>Port Impedance.
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Port Impedance versus Passes
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In practice it often proves wise to activate the adaptive mesh refinement to ensure
convergence of the results. (This might not be necessary for structures with which you
are already familiar when you can use your experience to refine the automatic mesh.)

Analyze the Electromagnetic Field at Various Frequencies

To understand the behavior of an electromagnetic device, it is often useful to get insight
into the electromagnetic field distribution. In this example, it may be interesting to see
the difference between the fields at frequencies where the transmission is large or small.

The fields can be recorded at arbitrary frequencies during a simulation. However, it is
not possible to store the field patterns at all available frequencies as this would require a
tremendous amount of memory space. You should, therefore, define some frequency
points at which the solver will record the fields during a subsequent analysis. These field
samples are called monitors.

Monitors can be defined in a dialog box that opens after choosing Solve =>Field Monitors

(@) from the main menu. You may need to switch back to the modeler mode by
selecting the Components folder in the navigation tree before the monitor definition is
activated.
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After selecting the proper Type for the monitor, you may specify its frequency in the
Frequency field. Clicking Apply stores the monitor while leaving the dialog box open. All
frequencies are specified in the frequency unit previously set to GHz.

For this analysis you should add the following monitors:

Field type Frequency / GHz
E-Field 3

E-Field 12.8

H-Field 3

H-Field 12.8

All defined monitors are listed in the NT(navigation tree)=Monitors folder. Within this
folder you may select a particular monitor to reveal its parameters in the main view.

You should now run the simulation again. When the simulation finishes, you can
visualize the recorded field by choosing the corresponding item from the navigation tree.
The monitor results can be found in the NT=2D/3D Results folder. The results are
ordered according to their physical quantity (E-Field/H-Field/Currents/Power flow).

Note: Since you have specified a full S-matrix calculation, two simulation runs would
generally be required. For each of these runs, the field would be recorded as
specified in the monitors, and the results would be presented in the navigation
tree, giving the corresponding stimulation port in brackets. However, in this loss
free example, the second run is not necessary, so you will find that the monitor
data are not available. You can advise the solver to perform both simulation
runs even if they are not necessary for the S-parameter calculation by
deselecting the option Consider two port reciprocity under the Solver tab in the
solver’'s Specials dialog box.
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You can investigate the 3D electric field distribution by selecting NT=2D/3D Results =E-
Field=e-field(f=3)[1]. The plot should look similar to the picture below:
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You should now play around with the various field visualization options for the 3D vector
plot (Results =*Plot Properties.)

If you select the electric field at 12.8 GHz (NT=2D/3D Results=E-Field=e-
field(f=12.8)[1], you may obtain a plot showing very small arrows only:

V/m
54956
48087 I

41217
34348

27478

¥ 70609
/\\ 13739
g 5878

z x

Type E-Field (peak)
Monitor e-field (f=12.8) [1]
Maximum-3d 54956.3 VY/m at 0.172 / -0.86 / 1.9326%

12.8
B degrees

Frequency
Phase

This problem is partly due to the selected phase of the fields which you can change by
using the left / right cursor keys or by modifying the Phase value to 90 degrees in the
Results =Plot Properties dialog box.

Another reason for the small arrow size is the very large fields at the edges of the
conductor. Because of the finite number of arrows drawn in the structure, there might be
no arrows at all visualized at the singularities. However, since the field maximum is
taken as a reference for the arrow scaling, the smaller fields inside the volume will be
visualized with very small arrows only. The visualization can be improved by adjusting
the object scaling or density in the Results >Plot Properties dialog box.
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After adjusting these settings, you should obtain a useful plot similar to the following:

V/m
54956
48087 I
41217
34348
27478 4
20609

13739
6870

e =

Type = E-Field (peak)

Monitor = e-field (f=12.8) [11

Maximum-3d = 54856.3 V/m at 6.172 / -06.86 / 1.03264
Frequency = 12.8

Phase = 90 degrees

The surface currents can be visualized by selecting NT=2D/3D Results=>Surface
Current=h-field(f=3)[1]. You should obtain a plot similar to the following picture:

Afm
56.8
49.7
42.6
35.5
28.4
21.3
14.2

71

[}

Type = Surface Current (peak)
Monitor = h-field (f=3) [1]
Maximum-3d = 56.7834 A/m at 8 / 0.86 / 7
Frequency
Phase

You may now change the plot options in the plot dialog box: Result=Plot Properties (or
Plot Properties from the context menu). You can obtain a field animation by clicking the
Start button located in the Phase/Animation frame in this dialog box. Here the phase of
the field will be automatically varied between 0 and 360 degrees. You can stop the
animation by clicking the Stop button or pressing the ESC key. After clicking in the main
view with the left mouse button, you can also change the phase gradually by using the
Left and Right cursor keys.

At the frequency of 3 GHz you can see how the current flows through the structure. If
you perform the same steps with the other magnetic field monitor at 12.8 GHz, you will
see that almost no current moves along the 90-degree bend of the coaxial cable.

After obtaining a rough overview of the electromagnetic field distribution in 3D, you can
inspect the fields in more detail by analyzing some cross sectional cuts through the
structure. To do this, select an electric or magnetic field (no surface currents) for display
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and toggle the Results=3D Fields on 2D Plane (ﬁ]}) option on. The same plot options
are available in the 2D plot mode you have already used for the port mode visualization.
Since the data are derived from a 3D result, you may additionally specify the location of
the plane at which the fields will be visualized. This can be done in the corresponding
Results =Plot Properties dialog box by changing the Cufplane Control and Location
settings at the bottom of the dialog boxes.

Due to the limited space, not all plotting options can be explained here. However, the
following gallery shows some possible plot options. Can you reproduce them?

Tangential component of surface Vector blot of h-field at 3 GHz
current at 3 GHz using 3D Fields on 2D Plane option

3D vector plot of h-field at 3D vector plot of surface current at
3 GHz using hedgehog option 3 GHz using hedgehog option

/ |

X component of h-field at 3 GHz Vector plot of e-field at 3 GHz
using 3D Fields on 2D Plane option using 3D Fields on 2D Plane option
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Abs plot of h-field at 3 GHz Several 3D Field on 2D Plane
plots of h-field using Overlay
Multiple Plots option

Parameterization of the Model

The steps above demonstrate how to enter and analyze a simple structure. However,
structures will usually be analyzed in order to improve their performance. This procedure
may be called “design” in contrast to the “analysis” done before.

After you receive some information on how to improve the structure, you will need to
change the structure’s parameters by simply re-entering the structure. This, of course, is
not the best solution.

CST MICROWAVE STUDIO® offers a lot of options to parametrically describe the
structure in order to easily change its parameters. The History List function, as described
previously, is a general option, but for simple parameter changes there is an easier
solution described below.

Let's assume that you want to change the stub length of the coaxial cable’s inner
conductor. The easiest way to do this is to enter the modeler mode by selecting the
NT(navigation tree) ®Components folder.

Select all ports by clicking on the NT=Ports folder. Then press the right mouse button to
choose Hide All Ports from the context menu. The structure plot should look like this:
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Now select the long conductor by double-clicking on it with the left mouse button:

You can now choose Edit=Object Properties (or Properties from the context menu)
which will open a list showing the history of the shape’s creation:

IHistury Tree

= icomponent]:long conductor;
Define cylinder

Edit. [ Oose | | Hep |

A

Select the “Define cylinder” operation in the tree folder “component1:long conductor”
from the history tree (see above). The corresponding shape will be highlighted in the
main window.

After clicking the Edit button in the History Tree, a dialog box will appear showing the
parameters of this shape.
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In this dialog box you will find the length of the cylinder (Wmin=-11) as specified during
the shape creation. Change this parameter to a value of -9 and click OK. Since you are
going to change the structure, the previously calculated results will no longer match the
current structure; therefore, the following dialog box will appear:

Results May Become Incompatible to Struc...

Thiz operation will change the madel and thus requires to
delete the exizting results.

Fleaze select one of the fallowing options:

(®)Delete cument results [keep result cache i present

() Stare current results in result cache

() Store current results to a new fils

[ ak. l l Cancel ] l Help ]

Here you may specify whether to store the old model together with its results in a cache
or as a new file or just go ahead and delete the current results. In this case you should
simply accept the default choice and click OK.

After a few seconds, the structure plot will change showing the new structure with the
different stub length.
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You can now dismiss the History Tree dialog box by clicking the Close button.

Generally, you can change all parameters of any shape by selecting the shape and
editing its properties. This fully parametric structural modeling is one of CST
MICROWAVE STUDIO®'s most outstanding features.

The parametric structure definition also works if some objects have been constructed
relative to each other using local coordinate systems. In this case, the program will try to
identify all the picked faces according to their topological order rather than their absolute
position in space.

Changes in parameters occasionally alter the topology of the structure too severely so
that the structure update may fail. In this case, the History List function offers powerful
options to circumvent these problems. Please refer to the online documentation, or
contact technical support.

In addition to directly changing the parameters, you may also assign variables to the
structure’s parameters. The easiest way to do this is to enter a variable name in an
expression field rather than a numerical value. Therefore, you should now open the
cylinder dialog box again as shown above. Afterward, you can just enter the string
“length” in the Wmin field.
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The dialog box should look as follows:

Cylinder
ane
Orientation: (U v &)W
Outer radius: Inner radius:

0.86 i
Ucenter: Wioenter
0 i}

W min: Wmas:
-lenigth| I}
Segments:

0

Component:

I aterial:

Since the parameter “length” is still undefined, a new dialog box will open after you click
OK in the cylinder dialog box:

Mew Parameter
Define mizzing parameter
°F
Parameter; lenath
Walue: 11
Dezcrphion:

You can now assign a value to the new parameter by entering 11 in the Value field. You
may also provide a text in the Description field so that you can later remember the
meaning of the parameter. Click OK to create the parameter and update the model.
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All defined parameters will be listed in the parameter docking window as shown below:

=lx

= -3 Components
= #3 companent
£ long cylinder
& short conductor
G long conductar
=423 Materials
it
§ PEC
& Vacuum
(0 Faces
(2 Curves
1 wes
(20 wires
(3 Lumped Elemerts
(0 PlaneWave
-] Ports
(23 Current Distributions
& ([ Excitation Signals
= 3 Field Monitors
g efield [1=3)
g efield (f=12.8]
he hield [f-3)
he hiield (f=12.8]
(2 Woltage Moritors
(0 Probes
i [ Mesh Contral
(23 1D Rresults
(23 2D/30 Riesuls
(C2 Farfields

Mater ial = PEC

Trpe = PEC

. getting started il getting star...
E £
A Hame Value Description Type =
“f terath n None

Unknown

Global

You can change the value of this parameter in the Value field. Afterward, the message
“Some variables have been modified. Press Edit->Update Parametric Changes” will
appear in the main view.

=
= /3 Components Some var iables have been modified. Press ‘Edit->Update Parametric Changes”
= %3 companent]
(@ long cylinder
3 short conductor
9 long conductor
= 3 Materials
@ air
& PEC

@ Vacuum
(3 Faces
{2 Curves
03 wes
£ wwires
{1 Lumped Elements
(1 Plane Wave
w1 Ports
(0 Current Distributions
@ (L Excitation Signals
=423 Field Monitars
eg efield (=3)
eg elield <128
he hield (=3)
hg hiield (<128
{3 Voltage Manitars
(1 Probes
{1 Mesh Contiol
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Material
Type
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In addition to using the menu command in order to update the structure, you can select

the corresponding toolbar button ( ! ). You can also select Update from the context
menu which appears when you press the right mouse button in the parameter list. You
may need to click on an empty field in the list first in order to obtain this context menu.

When performing this update operation, the structure will be regenerated according to
the current parameter value. You can verify that parameter values between 7 and 11.5
give some useful results. The function Edit=>Animate Parameter is also useful in this
regard.
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Parameter Sweeps and Processing of Parametric Result Data

Since you have now successfully parameterized your structure, it might be interesting to
see how the S-parameters change when the length of the conductor is modified. The
easiest way to obtain these variation results is to use the Parameter Sweep tool which
you can access from within the transient solver dialog box by clicking the Par. Sweep
button to reveal the following dialog box:

Parameter Sweep

Seguences Rezult watch

Add watch... v

Hetwark, computing

[ Use network computing

[ ]

In this dialog box you can specify calculation “sequences” which will consist of various
parameter combinations. To add such a sequence, click the New Seq. button now. Then
click the New Par... button to add a parameter variation to the sequence:

-

.
Parameter Sweep Parameter

Marne: length v

To 11.5

Samples: &

¢

In the resulting dialog box you can select the name of the parameter to vary in the Name
field. Then you can specify the lower (From) and upper (To) bounds for the parameter
variation after checking the Sweep item. Finally enter the number of steps in which the
parameter should be varied in the Samples field.

In this example, you should perform a sweep From 10.0 To 11.5 with 5 Samples. After
you click the OK button, the parameter sweep dialog box should look as follows:
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Parameter Sweep

Sequences

= Sequence 1
length =10..11.5 (3]

[NewSeq.] [ew Par._{ [ Edit... l [ Delete ]

Metwork, computing

[JUse network computing

Fresult watch

Add watch...

Yiew Logfie...| |

Cloze

[

)

Note that you can define an arbitrary number of sequences with each of them containing
an unlimited number of different parameter combinations.

In the next step you have to specify which results you are interested in as a result of the
parameter sweep. Therefore select “S-Parameter...” from the Result watch combo box.
A dialog box opens in which you can specify an S-parameter to store:

S-Parameter Watch

Type

Cutput
Port:
1 w
b ode: -
1 w

() Maa. llinear) (33 Mag. [dB] ) Phase

|mput
Poit:
1

M ode:
1

YWwiatch S-Parameter. 157.1]in dB

First select the option of recording the magnitude of S1,1 in dB by checking Mag. (dB) in
the Type field and clicking the OK button.
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Next add another “watch” for the magnitude of S2,1 in dB as follows:

Select “S-Parameter...” from the Result watch combo box.
Specify Mag. (dB) in the Type field.

Select 2 in the Output Port field.

Click OK.

i

The parameter sweep dialog box should look as follows:

Parameter Sweep
Sequences Fiesult watch
= Sequence 1 Gidd waich ™
length =10..11.515) &1 1]in dB
152.11in dB

[NewSeq.] [New F'ar...] [ Edit... l [ Delete ]

Metwork, computing

[JUse network computing

[ Check l [ Start ] [View Logfile...l [ Cloze
[ ]

Now start the parameter sweep by clicking the Start button.

Note that the parameter sweep uses the previously specified solver settings. If you
change the solver settings (e.g. for activating the adaptive mesh refinement), make sure
that the modified settings are stored by clicking Apply in the solver control dialog box.

After the solver has finished its work, close the dialog box by clicking the Close button.
The navigation tree will contain a new item called “Tables” from which you should select
the item Tables=|S1,1| in dB first:
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151,1] in dB

length = 10
length = 10,375
length = 10.75
length = 11,125

-60

Frequency [/ GHz

Similarly, you can also plot the magnitude of the transmission coefficient by selecting
Tables=|S2,1| in dB.

152,1] in dBs
8]

length = 10
length = 10.375
length = 10.75

10 length = 11.125

-20 .

=30 .

-40
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More properties for parametric data visualization can be accessed from the table
properties dialog box (Results=Table Propetrties):

Table Plot: |52,1] in dB
Plat type: Flat mode:
Cartezian | | Tune el
Parameter nanne Selected Walue Ture Actual Valus
lerath 10 - |] 10
[ (0] 4 ] [ Apply ] l Cancel ] [ Ex=port... ] [ Help ]

After you change the Plot mode to Tune, a slider appears which provides quick access
to the parametric result data. Dragging the slider allows you to quickly select the
corresponding result for the parameter value as shown in the Selected Value or Actual
Value fields.

Note that no interpolation of result data is performed here. For more than one parameter
it may, therefore, be that no parametric result is available for the currently Selected
Values. In this case, that data point whose parametric settings are closest to the
selected ones will be displayed. However, the actual parametric settings of the currently
displayed data point will always be shown in the Actual Value field.

Once you close the table properties dialog box by clicking OK or Cancel, the parametric
view will be restored. Refer to the online documentation for more information about the
many options for displaying parametric data.

It may be interesting to see how the location of the transition minimum changes as a
function of the parameter. This and other special result data can be automatically
computed using Result Templates. Open the corresponding dialog box by choosing

Results ®Template Based Postprocessing (@ ):

Template Based Postprocessing

1D Resultz | 0D Results

Add new postprocessing step... K4

Fiezulk name Template name

23]

[ Cloge ] [ Help
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First, load the transmission S-parameter data into the post processing chain in order to
later derive its minimum location. Select the post-processing step S Parameter from the
list of available 1D result templates to open the following dialog box:

E! s Parameter

Type
() Mag. linear]l (%) Mag. [dB]
Clutput Input
Puort: . Puort:
2 [l 1
tode: Mode:

Usze &R -Filter Resultz, if existing

() Phase

In this dialog box, you should specify |S21| in dB scaling (similar to the settings before in
the parameter sweep). The new post-processing step will be listed in the dialog box:

Template Based Postprocessing
1D Resultz | 0D Results
Add new postprocessing step... V
Fiezulk name Template name
1;521dB S Parameter
| 1 | elete &t | [Evalusteai]
[ Cloge ] [ Help l

Based on the broadband S-parameter data,

you can now extract the location of the

minimum which is a single data point (or 0D Result). Switch to the 0D Results page and
select 0D Value From 1D Result from the list available 0D result templates.
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A dialog box will open where you can specify details about the post-processing step:

E! 0D Value from 1D Result

1D Result: [x=1.col, p=2.col)
521dB

Select DD-Result:

w at y-Minirmum

Conzidered =-Fange

(%) botal wloy;
) subwindow  =high:

[ ak l l Cancel ]

The only available 1D data is |S21| in dB, so you have no choice in the 1D Result list.
Since you want to know the location of the curve (y-) minimum, you should choose x at
y-Minimum as the desired result from the Select 0D Resuilt list. Clicking OK will complete
the definition of the specific post processing chain in this example.

After any solver run, these post-processing operations are automatically carried out, and
the result of each of these steps is stored in a table. Once a Result Template is defined,
a corresponding line is automatically added to the Result watch list:

Parameter Sweep

Sequences

1 Sequence 1

[NewSeq.] [New F'ar...] [ Edit... l [ Delete ]

Metwork, computing

[JUse network computing

Fresult watch
Add watch... v
[51.11in dB

Postproceszing template. ..

[

Check || Stat | [viewLogiie...| |

Cloze

[

)

Restart the entire parameter sweep now. You will be asked what to do with the currently
available result data. In this dialog box, select Delete current results and click OK.
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Of course, the additional post processing steps could also be defined before the first
parameter sweep is started, but for didactical reasons we have separated this task into
two steps here.

Once the solver finishes the parameter sweep, you can access the result template data
from the Tables 0D Results=>S21dB_x folder in the navigation tree:

S21dB_x

length

This curve clearly illustrates how the location (=frequency) of the transition minimum
changes as a function of the geometrical parameter.

Because of the limited scope of this manual, we give a very brief introduction to this
powerful feature, so please refer to the online documentation for more information.

Automatic Optimization of the Structure

Let's now assume you wish to obtain the minimum of the transmission S2,1 at 13 GHz
(which can be achieved within a parameter range of 10 to 11 according to the curve
above). By measuring the curve (activate the axis marker tool by choosing Results=1D
Plot Options =*Axis Marker), you can check that the desired parameter value is around
10.96. However, figuring out the exact parameter value may be a lengthy task which can
be performed equally well automatically.

Before you continue to optimize this structure, set the length parameter to a value within
the valid parameter range (e.g. 10.5) and update the structure. You must enter the
modeler mode (e.g. by clicking at the “Components” item in the navigation tree) before
you can modify the parameters.

CST MICROWAVE STUDIO® offers a powerful built-in optimizer feature for these kinds
of parametrical optimizations.

To use the optimizer, simply open the transient solver control dialog box as before. In
this dialog box, click the Optimize button to open the optimizer control dialog box:
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-

Cptimizer

-

Parameters | Goals

Info

(et 1

Farameter

Iin

Specials

% of initial value

(LE

Samples

Use current as initial values

[mitial

Current

Best

(¢ length

mn

1

5

105

105

[

Start

| |

Cloze

J |

Apply

J |

Help

)

First check the desired parameter(s) for the optimization in the Parameters tab of the

optimization dialog box (the “length” parameter should be checked).

Next specify the

minimum and maximum values for this parameter during the optimization. Enter a
parameter range between 10 and 11. For this example, the other settings can be kept as
default. Refer to the online documentation for more information on these settings.

The next step is to specify the optimization goal. Click on the Goals tab.

Optimizer

Parameters | Goals

Type

Ifo

Specials
Operatar Target Range Wieight
[ Stark ] [ Cloze ] [ Apply ] [ Help ]

Now you can specify a list of goals to achieve during the optimization. In this example,
the target is to move the minimum of the S-parameter S2,1 to a given frequency, so
define an “S Parameter” goal by selecting it from the list that appears when you select
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the Add new goal entry. Once you have selected the proper goal type, the following
dialog box should appear:

Define S-Parameter Goal

Type
() Mag. (linear) (3) Maa. [dB)

Cancel

Clutput Input
Part: tdode: Fort: M ode:
2 w 1 w 1 ~ 1 w
Conditions
Operator: Target: Frequency:
MOYe min | % 13
Wwieight:
10
Frequency range
(&) Tatal
at:
) Range mir; TR

In this dialog box, you should first select the magnitude of the S-parameter in dB for
optimization by clicking on the Mag.(dB) entry in the Type frame. Next specify which S-
parameter should be optimized. Select S2,1 by setting Port = 2, Mode = 1 in the Output
frame and Port = 1, Mode = 1 in the Input frame.

Now specify the actual goal for the previously specified S-parameter data. Since you
want to move the minimum of S2,1 in this example, you should select the move min
operator in the conditions frame. Afterwards, set the Frequency to which the minimum
should be moved to 13 GHz. If more than one minimum exists in the S-parameter data,
you can limit the frequency range for searching the minimum in the Frequency range
frame. In this example, you can just skip these settings and accept the defaults. After
you click OK, the optimizer dialog box should look as follows:
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-

ertimizer
Parameters | Goals | [nfa Specials
idd new goal ... v
Type Operatar Target Fange wieight
m 521]indE MOYE mir - 13 total 1.0
[ Start ] [ Cloge ] [ Apply ] [ Help ]

Since you now have specified optimization parameters and goals, the next step is to
start the optimization procedure by clicking the Start button. The optimizer will show the
progress of the optimization in an output window in the /nfo tab which will be activated

automatically.

When the optimization has finished, you should confirm the new parameter settings
have been saved. The optimizer output window will show the best parameter settings

with respect to the given goal.

Cptimizer

Parameters | Goals | Info

Specials

Pas= 1 7 1

Munber of evaluations: ZZ
(=olwer: &,

First goal function walue

Last goal function walues

Best goal function walue

Best parameters =so far:

length = 10.3&6%74

interpolation: 1&)
= 1.345
= 0_.004
=0
[ Start ] [ Close ] [ Apply ] [ Help ]

Note that due to the sophisticated optimization technology, only six transient solver runs
were required to find the optimal solution with high accuracy.
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You can now visualize the S-parameters for the optimal parameter setting (length
=10.967 ) and should obtain the following picture (you can activate the axis marker tool
by choosing Results=1D Plot Options=Axis Marker to verify that the location of the
peak is at 13 GHz).

S-Parameter Magnitude in dB
0 13

=20 .

-30 .

40 .

50 i i . 0.009406
i ‘ 52,1:-99.92

; : $1,2:59.92
0. i i $2,2 1 -0.009428

=70

Frequency f GHz

Instead of defining a “move min” goal for the optimization, you could also have chosen
to optimize the value of the previously defined result template S27dB_x to be equal to
the desired resonance frequency of 13 GHz.

Comparison of Time and Frequency Domain Solver Results

So far, all explanations have focused on the transient solver. In the next steps you will
compare the results of the transient solver based on hexahedral grids with the frequency
domain solver using tetrahedral grids. Since these two simulation methods are based on
different techniques, this comparison allows you to verify the accuracy of the results.
Although the transient solver is much faster for this and many other examples, the
frequency domain solver may be the better choice for lower frequency problems or
filters. In the latter case, the primary simulation and optimization should be performed
using the frequency domain solver whereas the final verification can then be done using
the transient solver. The seamless combination of these different techniques in a
homogeneous environment is another outstanding feature of CST MICROWAVE
STUDIO®.

The frequency domain solver may not be available to you due to license restrictions.
Please contact your sales office for more information.

Before you recalculate the S-parameters using the frequency domain solver, you should
first copy the results from the transient solver into a new folder for easier comparison
afterward.

Select the 1D Results folder in the navigation tree, and choose Edit=*Add New Tree
Folder from the main menu. You can then assign a name (e.g. “Comparison”) to the
newly created navigation tree item. After creating the new folder, you can select the 71D
Results =|S| dB folder and choose Edit=>Copy Result Curve(s). Finally, select the newly
created 1D Results=>Comparison folder and choose Edit=>Paste Result Curve(s). Note
that the copied result curves are fixed and will be neither deleted nor changed when
parameters are changed or S-parameters are recalculated. For organizational purposes,
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you should now click at each of the new curve entries in the 1D Results=>Comparison
folder, choose Edit=>Rename (or just press the F2 key) and add an appendix TD to the
curve name in order to indicate that this is a result from the transient solver. The
navigation tree should finally look as follows:

+-[23 Energy
+-[_3 Optimizer
=-£3 Comparizaon
511 TD
51.2TD
521 71D
S522TD
=3 2D/30 Results
+-27] Port Modes

[T

Once you save the transient solver results for later comparison, you can simply open the
frequency domain solver dialog box by choosing Solve =*Frequency Domain Solver
which will open the following dialog box:

Frequency Domain Solver Parameters
Methiod Solver settings
(#) General Purpose [ 5ave allfield results —

() Resonant; Fast 5-Parameter [ Stare result data in cache
_
(") Resonant: S-Parameter, fields [ Caleulate modes anly
Mesh type: Accuracy -
Tetrahedral Mesh » Te-d4 w
Simplify Model...
Ewxcitation settings S-parameter settings
Port: Mode: Mormalize to fised impedance Apply
All | (Al w 50 Ohms
Frequency samples
Auto | Samplez | From To rit ||
Max.Range (3 0 18 GHz
Adapt Freq. [ 1 18 GHz
Frequency [ GHz
Frequency [ GHz
Frequency [ GHz [a
Add samplez for monitors
|Jze broadband frequency sweep
Adaptive meszh refinement
Adaptive tetrahedral mesh refinement

The default settings of the frequency domain solver use a tetrahedral mesh, automatic
mesh adaptation and full S-parameter matrix calculation so that you do not need to
change anything here. The S-parameter normalization to 50 ohms also activates
automatically since you have already specified this for the transient simulation before.
You can now perform the frequency domain simulation by clicking the Start button and
confirming the deletion of the non-frequency domain solver results.
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In order to see the tetrahedral mesh used for this simulation while the solver is running,
activate the mesh mode (Mesh=>Mesh View):

The solver first performs a mesh adaptation at the ports first before the mesh inside the
structure is adapted at the highest frequency of interest in the second step. Once the
mesh adaptation has converged, the solver calculates the S-parameters as a function of
frequency by using its fast sweep capability.

When the solver has finished its work, you can again view the results by selecting 1D
Results =|S| dB from the navigation tree:

S-Parameter Magnitude in dB
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As you can see, the results are quite similar to the results previously obtained from the
transient solver. A better comparison can now be achieved by copying and pasting the
frequency domain solver results to the 71D Results=>Comparison folder again. You
should again add an appendix “FD” to the new frequency domain solver results:
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S-Parameter Magnitude in dB
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As you can see, the results from the transient solver using hexahedral grids and the
frequency domain solver using tetrahedral grids are in excellent agreement here.

Summary

This example should have given you an overview of the key concepts of CST
MICROWAVE STUDIO®. You should now have a basic idea of how to do the following:

Model the structures by using the solid modeler

Specify the solver parameters, check the mesh and start the simulation
Use the adaptive mesh refinement feature

Visualize the port modes

Visualize the time signals and S-parameters

Define field monitors at various frequencies

Visualize the electromagnetic field distributions

Define the structure using structure parameters

. Use the parameter sweep tool and visualize parametric results

10. Use result templates for customized post processing

11. Perform automatic optimizations

12. Compare the results from the transient solver and the frequency domain solver

CoNoaRrWN =

If you are familiar with all these topics, you have a very good starting point for further
improving your usage of CST MICROWAVE STUDIO®.

For more information on a particular topic, we recommend you look at the contents page
of the online help manual which can be opened with Help=*Contents. If you have any
further questions or remarks, do not hesitate to contact your technical support team. We
also strongly recommend that you participate in one of our special training classes held
regularly at a location near you. Ask your support center for details.
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Which Solver to Use

Since we have mainly focused on the transient solver and somewhat on the general
purpose frequency domain solver in the previous example, it's time to clarify which
solver fits which application best. The transient solver is general and can solve the
widest range of electromagnetic field problems. However, for some applications,
specialized solvers will show much better performance while maintaining the same high
level of accuracy.

The table here lists a few typical applications together with the solvers that are most
frequently used for solving the particular problem. Please note that because of the very
wide application spectrum, not all possible examples can be listed in the table.
Furthermore, depending on the particular structure, it may be that other solvers are more
efficient for a particular application than those shown in the table. Therefore use this
table as a guideline rather than a rule for which solver to use.

| Application Name | Solver Type(s)

Connectors (coaxial, multi-pin) Transient

Strip lines (micro strip, coplanar lines)

Transient, General Purpose
Frequency Domain

Strip line circuits

Transient, General Purpose
Frequency Domain

Cross-talk calculations Transient
Printed circuit boards Transient
Digital circuit simulation Transient

Packaging problems

Transient, General Purpose
Frequency Domain

Network parameter (SPICE) extraction

Transient, General Purpose
Frequency Domain

Nonlinear diode applications Transient
EMI problems Transient
Radiation problems Transient
Shielding (irradiation) problems Transient
Monopole, dipole and multipole antennae Transient

Patch antennas

Transient, General Purpose
Frequency Domain

Conformal antennae

Transient, General Purpose
Frequency Domain

Helical and spiral antennae Transient
Antenna arrays Transient
Waveguides (hollow, dielectric, coaxial) Transient
Transmission line networks Transient
Optical wave guides Transient
Optical couplers Transient
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| Application Name | Solver Type(s) |

Optical diplexers and filters Transient, General Purpose
Frequency Domain, Resonant Fast
S-parameter Frequency Domain

Filters and diplexers Transient, General Purpose
Frequency Domain, Resonant Fast
S-parameter Frequency Domain

Cavities, resonator design Eigenmode

Traveling wave structures Eigenmode

Periodic problems (frequency selective General Purpose Frequency
surfaces, periodic band gap structures) Domain, Eigenmode, Transient

Periodic problem with nonzero phase shift General Purpose Frequency
Domain, Eigenmode

Please note that the application range of the transient analysis can be extended quite a
way toward more resonant devices by applying some advanced digital signal processing
techniques rather than simply using a Discrete Fourier Transform. CST MICROWAVE
STUDIO® features an Auto Regressive (AR) Filter capable of predicting the long-term
response of a device from a short-term response.

The performance of the transient solver also degrades if the device operates at very low
frequencies. In these cases, the general purpose frequency domain solver may be
faster, especially since in most cases a few frequency samples are sufficient to
characterize the structure’s behavior by using the fast broadband frequency sweep tool.
On the other hand, the performance of the frequency domain solver decreases more
rapidly with the number of mesh cells than the performance of the transient solver.

Besides these general considerations, there are also some applications that require the
selection of a particular solver since the corresponding electromagnetic problem can be
solved only by using the corresponding method:

1. Structures containing nonlinear diodes: The frequency domain solver can not
handle nonlinearities. Therefore the time domain solver must be used for these
applications.

2. Very large structures / high frequencies: The frequency domain solver requires
the solution of a matrix equation. This becomes very slow and memory intensive
when the number of mesh cells is large. Whenever the number of cells is in the
order of several million, the time domain solver should be used.

3. Periodic structures with nonzero phase shift: The transient solver can handle
only periodic structures with zero phase shifts, so the frequency domain solver must
be used instead. The phase shift between adjacent boundary planes or the
geometrical angle of incidence has to be specified in the boundary condition dialog
box. Note that both the electrical phase angle between the boundary planes and the
geometrical angle of incidence are not identical. The frequency domain solver in
combination with tetrahedral grids also offers a special Unit Cell feature allowing the
simulation of periodic structures with a non-rectangular lattice.

4. Calculation of S-parameters for structures with large losses at the waveguide
ports: The frequency domain solver can handle lossy ports and can calculate
waveguide port modes for lossy wave guides.
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Summarizing these statements, the following diagrams show a rough guideline for the
application ranges of the methods:

Transient Resonant
Analysis Frequency
with AR-Filter Domain analysis

rpose Frequency Domain Analysis i

Highly resonating devices

Transient
Analysis

Frequency (weakly-resonating device)

>

You should now have an impression of the pros and cons of the methods. If you are not
sure which solver may best suit your application, please contact your local sales office
for assistance.
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General Purpose Frequency Domain Computations

The basic procedure of running the frequency domain solver is demonstrated in the
example above. The following explanations provide some more information about the
settings in the frequency domain solver dialog box which you can open by choosing
Solve 2Frequency Domain Solver:

Frequency Domain Solver Parameters

hethiod Solver sethings
[ 5ave all field results —
() Resonant; Fast 5-Parameter [ Stare result data in cache
_
(") Resonant: S-Parameter, fields [ Caleulate modes anly
Mezh type: Accuracy -
Tetrahedral Mesh w 1e-4 "
Simplify Model...
Excitation settings S-parameter zethngs
Part; Mode: Mormnalize ko fised impedance
All | (Al “ 50 Ohms
Frequency samples
Auto | Samplez | From To rit ||
Max.Range (3 0 18 GHz
Adapt Freq. [ 1 18 GHz
Frequency [ GHz
Frequency [ GHz
Frequency [ GHz [+

Add samplez for monitars

|Jze broadband frequency sweep

Adaptive mesh refinement

Adaptive tetrahedral mesh refinement

The Method field allows for the selection of the principal solution method. Refer to the
section Which Solver to Use earlier in this chapter for more information concerning the
difference of these three techniques.

The General Purpose solver can be seen as the counterpart of the transient solver. The
other two solvers have some very special applications and are described in the next
section. The following explanations focus on the General Purpose solver.

A special feature of the General Purpose solver is the support of both hexahedral and
tetrahedral meshes. In most cases, you will compare the results from the tetrahedral
frequency domain solver and the hexahedral transient solver. This selection gives you
the ability to compare the results from two completely independent simulation
techniques.

The tetrahedral mesh generation normally generates relatively coarse initial meshes.
Therefore we strongly recommend using the Adaptive tetrahedral mesh refinement
option in order to ensure accurate results.
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The mesh adaptation strategies of the transient solver and the frequency domain solver
are fundamentally different. The transient solver runs the entire broadband simulation for
every mesh adaptation pass and evaluates the worst-case deviation of two subsequent
S-parameter results (broadband). The mesh refinement is then done based on
information from the broadband result data. In contrast, the frequency domain solver
runs the mesh adaptation at a single frequency point only. Once the adaptation is
complete, the broadband results are computed by keeping the adapted mesh fixed.
Even though this procedure is a little less safe in general, it normally provides quite good
results.

Since the frequency domain solver mesh adaptation runs only at a single frequency
point, the location of this point within the frequency spectrum is very important.

For weakly resonating devices, it is usually a good choice to select the highest
frequency of interest for the mesh adaptation (which is the default setting). This will
ensure that fields with the shortest wavelength in the frequency sweep are still sampled

properly.

The situation is different for strongly resonating devices as shown in the following picture
(e.g. Low Pass Filter (3 Stubs) example):

S-Parameter Magnitude in dB

0 5 10 15 20

Frequency / GHz

This low pass type of structure has very low transmission at the highest frequency of
interest. Running the mesh adaptation at this frequency will not get sufficient information
about the actual filter characteristics. Therefore the adaptation will keep refining the
mesh around the input port since all the energy is stored there and too little information
is available about the behavior of the fields inside the structure.

In cases like the one shown above (typically filters), it is very important to specify the
adaptation frequency such that it is located in the pass band of the filter. This can be
done by un-checking the Auto button in the Adapt.Freq. line in the frequency list.
Afterwards you can specify the adaptation frequency in the From column of the list.
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Auto | Samplez | From Ta |Init
- = - = -y
AdaptFreq [ 1 10 GHz
GHz
Frequency I GHz
Frequency I GHz

Another important difference between the transient solver and the frequency domain
solver is the number of frequency samples to be calculated. Whereas in the time domain
the number of frequency samples has almost no influence on the solver time, a classical
frequency domain calculation has to carry out the simulation frequency point by
frequency point. Every frequency point requires a complete solver run.

The frequency domain solver used by CST MICROWAVE STUDIO®, however, uses a
special broadband frequency sweep technique in order to derive the full broadband
spectrum from a relatively small number of frequency samples.

In order to make use of this technique, you should allow an automatic sampling of
frequency points by checking the Auto button in a Frequency line and then activating the
Use broadband frequency sweep option. The solver will then automatically adapt the
selection of frequency points so that the broadband curve can be obtained by calculating
a minimum number of samples.

Auto | Samplez | From Tao rit ||

Max.Range (&) 0 18 GHz

Frequency GHz
- =1n|
Frequency I_ GHz [s

‘bmadband frequencysE

To store the fields at particular frequencies, monitors need to be defined in advance as
described previously for the transient solver. These monitor frequencies are then added
to the list of calculated frequency points if the Add samples for monitors option is
activated.

The frequency domain solver cannot calculate the fields at a frequency of zero.
Therefore a zero frequency will automatically be shifted to a reasonably small value.

The S-parameters and fields can be accessed as usual from the items in the navigation
tree.

By default, the tetrahedral frequency domain solver uses second order elements to get
an excellent sampling of the fields at high frequencies. This also allows the use of
relatively few elements per wavelength as compared with the first order elements used
by the solvers based on hexahedral grids.

However, some structures require a relatively fine mesh due to their geometry which is
much finer than required to properly sample the wave phenomena. Typical application
examples for this are often PCB types of structures or IC packages. In such cases, using
first order elements rather than the standard second order elements can significantly
reduce simulation time and memory requirement significantly.
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To use first order elements, select 1st (low memory) in the Solver order field in the
Specials dialog box:

Special Frequency Domain Solver Param...

Linear zalver
0K
Solver type:

Cancel

Help

[T tdax mumber of processors:

Solver arder;

1zt [low memary)

b aterials

[] Canstant fit and dispersian fit
a5 in Time D'omain

Open boundaries

£dd space before mesh
generation

Another important difference between the frequency domain solver and the transient
solver is the way both simulators handle dispersive materials.

For a given list of material parameters at various frequencies, the transient solver always
needs to fit a certain dispersion model to the data (first or second order). During the
simulation, the broadband material behavior will then be taken from the model rather
than using the originally specified data.

However, since the frequency domain solver computes the broadband sweep by a
sequence of individual frequency point calculations, the solver can simply interpolate the
given list of frequency points directly. As a result, the frequency domain solver can use
user-specified material property tables more directly than the transient solver can.

For the sake of comparing these two solvers results, it may be advantageous to advise
the frequency domain solver to use the same material model fitted data as the transient
solver does by checking the Constant fit and dispersion fit as in Time Domain box in the
solver Specials dialog box.
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The following summarizes the input necessary for frequency domain analysis
calculations:

Select an appropriate project template (optional).

Set units (optional).

Set background material (optional).

Define the structure.

Set the frequency range.

Set the boundary conditions (optional).

Define the excitation ports.

Set the monitors (optional).

Start the frequency domain solver.

0. Analyze the results (S-parameters, field patterns, result templates, etc.).

SOVOoNoORWN =
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Resonant Frequency Domain Computations

Besides the general purpose solver mentioned above, the frequency domain solver also
features two additional solver methods specialized for the simulation of strongly
resonant structures such as filters:

1. Resonant: Fast S-Parameter
2. Resonant: S-Parameter, fields

Please note that both solvers are currently based on hexahedral grids only. For more
information, refer to the Filter tutorial.

Resonant: Fast S-Parameter

The Resonant: Fast S-Parameter method calculates only the S-parameters but does not
produce any field results. The solver is able to handle weak losses such as lossy
dielectrics, etc. The strong advantage of this method is its performance which can, in
some cases, be significantly better than any other simulation method. Despite its
limitations, the performance advantage makes this solver the ideal choice for a certain
type of applications.

Using this solver is relatively straightforward. The first step is to select the corresponding
method in the solver control dialog box (Solve =>Frequency Domain Solver):

Frequency Domain Solver Parameters
b ethiod Solver settings
(*)Fesonant: Fast S-Parameter [] Stare result data in cache
( .
(") Resonant: 5-Parameter, fields [ Calculate modes orly
Aocuracy
1e-B w
Simplify Model...
Rezonant sokver zettings S-parameter zettings
Eval Freq.: Samples: [[] Memalize ta fived impedance
9 (default) 100 Ohms
Frequency zamples
Auto | Samplez | From To nit ||
MaxFange ‘& i} 14 GHz
Frequency % GHz
Frequency B GHz
Frequency B GHz
Frequency B GHz [«

Adaptive mesh refinement

[ &daptive hexahedral mesh refinement
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The Accuracy setting is not critical so that it can normally be kept at the default of 1e-6.
The number of uniformly spaced frequency samples can be specified in the Samples
field in basically the same way as it is done for the transient solver. The number of
frequency samples only slightly influences the performance of the simulation, but
excessive values should be avoided since this may require a lot of disk space and may
slow down further post processing operations.

The only setting which requires a bit more explanation here is the Eval.Freq. field. The
default setting equals the center frequency of the simulation frequency range. Material
properties (including losses) will be calculated at this frequency and remain fixed over
the entire frequency band. The same happens for waveguide ports for which the mode
patterns are also calculated at the center frequency. While the port mode pattern does
not change as a function of frequency for hollow waveguides or coaxial lines, it does
change for micro strips and coplanar lines. Therefore, using a fixed mode pattern may
cause some mismatch at the ports and result in slightly inaccurate S-parameters for
frequencies farther away from the Eval.Freq. However, the resulting error normally is
quite small. Especially for narrowband structures (which are the primary application area
for this solver), the frequency bands of interest are relatively small, and the variation of
the material properties or port modes within these frequency bands is negligible.

After running the solver by clicking the Start button, you can access its S-parameter
results as usual from within the navigation tree.

The following summarizes the simulation flow for this solver module:

Select an appropriate project template for filter structures (optional).
Set units (optional).

Set background material (optional).

Define structure.

Set frequency range.

Set closed boundary conditions (optional).

Define excitation ports.

Start Resonant: Fast S-parameter frequency domain solver.
Analyze results (S-parameters, result templates).

N>R WN =~

Resonant: S-Parameter, fields

The main difference between the Resonant: S-Parameter, fields solver and the
Resonant: Fast S-Parameter solver is the calculation of fields in addition to the S-
parameters.

However, performance is significantly affected by the field calculation such that this
solver should only be used when the calculation of fields is essential. Note that the
Resonant: S-Parameter, fields solver is limited to handle loss free structures only.

The specification of which fields to calculate is done by the standard monitor concept as
explained earlier in this manual.

A very interesting feature of this solver is that some intermediate information concerning
the fields is stored even if no field monitors are specified. Once a simulation is finished
and the S-parameters are visualized, it is relatively fast and straightforward to obtain the
fields at certain frequencies.



CST MICROWAVE STUDIO ® 2006 — Getting Started 113

To demonstrate this feature, let us assume that you ran a simulation for a filter structure
using the Resonant: S-Parameter, fields solver and are now inspecting the S-
parameters:

S-Parameter Magnitude in dB

s1,1
52,1
51,2
52,2

058 059 05 0.61 0.62

Frequency / GHz

You may now be particularly interested in the fields at the resonance peak. The easiest
way to obtain this information is to place the axis marker at the location of the resonance
(Results 1D Plot Options =>Show Axis Marker.):

S-Parameter Magritude in dB
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Finally choose Results=*Calculate fields at axis marker to obtain the fields at this
particular frequency. The field computation itself will be relatively quick since a lot of
intermediate data have already been stored during the initial S-parameter calculation.
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All other settings are identical for the Resonant: Fast S-Parameter described above.
Therefore the typical simulation flow is as follows:

1. Select an appropriate project template for filter structures (optional).
2. Set units (optional).

3. Set background material (optional).

4. Define structure.

5. Set frequency range.

6. Set closed boundary conditions.

7. Define excitation ports.

8. Define monitors (optional).

9. Start Resonant: S-parameter, fields frequency domain solver.

10. Analyze results (S-parameters, result templates, fields, etc.).
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Eigenmode (Resonator) Computations

The eigenmode solver calculates a finite number of modal field distributions in a closed
device. CST MICROWAVE STUDIO® provides two different eigenmode solvers: AKS
(Advanced Krylow Subspace) and JDM (Jacoby Davidson Method).

These methods work on a completely different mathematical foundation. The JDM solver
can be considered as a more robust solver technology, but the AKS solver may be faster
if many modes are to be calculated. Therefore we recommend the JDM solver only if a
small number of modes (e.g. 1-5) has to be calculated. Otherwise the AKS solver should
be used.

Since the eigenmode analysis does not require the definition of excitation ports, this step
can be omitted. The definition of monitors is also not necessary because the modes
themselves contain all available information about the device.

Thus, after setting up the model, you can immediately proceed to the eigenmode solver
dialog box (Solve =*Eigenmode Solver) which looks as follows:

.
Eigenmode Solver Parameters

Ikerations: | 2 Simplify Model...

[T 5tare all result data in cache

[(-+tactor caloulation

[ Caleulate external Q-factar

Apply

Adaptive mesh refinement
Close

[]Enable

Help

The solution of lossy eigenmode problems is a challenging task which implies that the
proper consideration of losses will significantly slow down the simulation. Even if the
JDM solver is able to directly solve the lossy eigenmode problem, it may sometimes be
advisable (especially for very small losses) to first calculate the loss free eigenmode
problem and then obtain losses and Q-factors of the device using a perturbation method
in the post processing.

The perturbation method requires material losses to be defined before the eigenmode
simulation is started. Running the AKS solver will always calculate the loss free problem
by simply ignoring the loss definition. The JDM solver can be advised to do so by
activating the Use perturbation method box as shown below:
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Eigenmode Solver Parameters

Solver settings Start
Method: | /DM Optimize. ..
todes: 10 Far. Sweep...

[ Choose rumber of modes

automatically [0 ... 10 GHz] -
Specials...

II IIIm

[teratiors: Simnplify Modsl...

[ 5tare all result data in cache

[-factor calculation

[“]ilse pertubation method

Adaphive meszh refinement

Apply

Cloze
[JEnable

Help

In the eigenmode solver control dialog box, the most important controls are the Method
(as discussed above) and the number of Modes.

The typical simulation procedure is as follows:
1. Depending on the number of modes, choose the proper solver method:

O For the direct solution of lossy problems choose JDM.

O For loss free problems with a small number of modes (e.g. 1-5) choose
JDM.

O For loss free problems with many modes (e.g. >5) choose AKS.

2. Enter the desired number of Modes (N). The solver will then compute the first N
modes of the device. For the AKS solver, it is often advantageous to specify more
modes to be calculated than you actually need, e.g. enter 20 modes to be
calculated if you actually need 15. In most cases it is a good choice to calculate at
least the first 10 modes of the device.

3. Click the Start button.

After the solver has finished, a summary of the calculated modes will appear in the
message window:
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ﬁ i) Final Results: -~
Mode Frequenicy Accuracy
1 3288 GHz 1.02%-011
2 J4.56 GHz 1.23e011
3 3923 GHz 1.156=-011
4 4368 GHz 4 529010
5 4368 GHz 9247011
B 4E.64 GHz 1.062e-012
7 47.84 GHz 9.008=-013
g 54.79 GHz 1.995=-0086
9* 54.79 GHz 0.003338
10 56,38 GHz 33689007
* = Thiz mode haz a bad accuracy.
1'_'\, The lowest Eigenmode frequency iz greater than the upper frequency range limit. Pleaze check the
frequency range.
Optimum guess for the highest eigenfrequency would be: B 3821
A\ 1 wamning ocoured, —

When using the AKS solver, sometimes a few of the higher modes will not be calculated
with sufficient accuracy and thus be marked with “*”. However, this does not affect the
accuracy of the lower modes and is the reason you should specify more modes to
calculate than you actually need.

The AKS eigenmode solver internally needs an estimation for the frequency of the
highest mode of interest. Usually this frequency is estimated automatically and improved
by refinement passes if necessary.

Performing estimation refinement passes reduces the performance of the AKS
eigenmode calculation. To speed up the AKS eigenmode calculation in these cases, you
can manually enter a guess for the frequency of the highest mode you are looking for.
The AKS eigenmode solver automatically derives such a guess from previously
calculated results and prints this value in the message window.

A The lowest Eigenmode frequency is greater than the upper frequency range limit. Please check the
fi )

Optirmum guess for the highest eigenfrequency would be: BE. 3821, >
AT AT .

You can set this guess by opening the special settings dialog box by clicking the
Specials button in the solver control dialog box. In the Guess field you should enter the
proposed guess as 56.3821 (GHz) in this example. If you are unsure about this setting
you should specify zero for automatic estimation. Note that this setting is used only by
the AKS method.
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-

Eigenmode Solver Specials

E shin ot g

B6.3521|

Automatic estirmation rehnement
elp

Max. number of cycles: |5

Guess [0 unknown]:

Special zolver controls
Penalty factor: 1

Accuracy: Tel12

Uze parallelization

This guess will now affect all subsequent calculations and should speed up the AKS
solver significantly.

You can access the eigenmode solver results for the N-th mode from the navigation
tree:

Navigation tree Type of result
2D/3D Results=>Modes=>Mode N=¢ Electric field
2D/3D Results =Modes =>Mode N=h Magnetic field

2D/3D Results=Modes=*Mode N=*Surface Current | Surface current field
2D/3D Results »Modes =Mode N=Energy Density Energy density

Refer to the Resonator Tutorial for more information on post-processing the results.
The following summarizes the input necessary for eigenmode calculations:

Select an appropriate project template (optional).

Set units (optional).

Set background material (optional).

Define structure.

Set frequency range.

Set closed boundary conditions (optional).

Start eigenmode solver.

Analyze results (field patterns, frequencies, losses/Q-factors, result
templates, etc.).

Nk WN =
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Choose the Right Port

The proper definition of ports is essential for accurate S-parameter computations. In
measurement setups, the device under test needs to be connected to the network
analyzer by using low reflection probes or applying proper de-embedding techniques.
Care must be taken with the probe connection because the measured S-parameters will
otherwise become inaccurate.

For EM field simulations, generally the same problems exist. The port connection needs
to be loss free and have very low levels of reflection. The basic problem here is to
launch and extract the fields as seamlessly as possible at the ports. Fringing effects
should be kept to a minimum.

In general, two types of ports need to be distinguished:

1. Discrete ports
2. Waveguide ports

Discrete ports can be seen as lumped circuit elements with an internal resistor and a
current source in parallel. These ports consist of a single lumped element in the middle
and two perfectly electric conducting wires connecting the port to the structure. A certain
voltage / current relation is then introduced along the lumped element, and the S-
parameters are calculated based on the element’s currents and voltages.

It is important to note that there may be a fringing effect at the transition of the structure
to the discrete port. This will always be the case when the geometry of the structure’s
transmission lines is different from the geometry of the discrete ports. Unfortunately, this
will be the situation in most cases.

On the other hand, discrete ports provide a convenient and flexible way to attach ports
to a given structure. The accuracy of the simulation is normally sufficient when the size
of the discrete port is a tenth of a wavelength or less.

The most accurate results can be obtained by using waveguide ports. These ports
normally provide very low levels of reflection and distortion and, therefore, are the best
choice whenever very high accuracy is required.

Note that CST DESIGN STUDIO™ is capable of de-embedding the port influence from
the S-matrix by removing the effect of the port to structure transmission matrix from each
of the ports. Refer to the CST DESIGN STUDIO™ Getting Started manual for more
information.

The following sections focus on the definition of discrete ports and waveguide ports. For
waveguide ports the most common types of transmission lines are treated separately.
The sections are designed so that each is self-contained. Therefore you may use them
as a reference once a particular type of port needs to be defined rather than reading
through all of them at once.
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Discrete Ports

Although the waveguide ports are the most accurate way to terminate a waveguide,
discrete ports are sometimes more convenient to use. Discrete ports consist of a current
source with an internal resistor and have two pins with which they can be connected to
the structure.

This kind of port is often used as feeding point source for antennae or as the termination
of transmission lines at very low frequencies. At higher frequencies (e.g. the length of
the discrete port is longer than a tenth of a wavelength) the S-parameters may differ
from those when using waveguide ports because of the improper match between the
port and the structure.

The typical way to define a discrete port is to pick its two end points from the structure
using the common pick tools and then to enter the discrete port dialog box:

.y (/

1. Pick end points

2. Open the discrete
port dialog box:
Solve =Discrete Ports

Discrete Port

Part lype Froperties o
Name: 1 ]

(O Wolage Impedance: | 50.0 Ohms

x| (&
z |8
2z |=
Tl|e

O Current [ Monitor voltage and current

Location

_

Use picked points as location

3. Click OK to
define the port

Note: The S-Parameter ports are the most frequently used Port Types and contain
internal resistors for calculating S-Parameters with fixed reference impedances. In
contrast, the Voltage and Current ports are ideal sources. The latter types of ports are
normally used for EMC types of application.
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Waveguide Ports

This kind of port simulates an infinitely long waveguide connected to the structure. The
waveguide modes travel out of the structure toward the boundary planes thus leaving
the computation domain with very low levels of reflections.

Very low reflections can be achieved when the waveguide mode patterns in the port
match perfectly with the mode patterns from the waveguides inside the structure. CST
MICROWAVE STUDIO® uses a 2D eigenmode solver to calculate the waveguide port
modes. This procedure can provide very low levels of reflection below -100dB in some
cases.

In general, the definition of a waveguide port requires enclosing the entire field filled
domain in the cross section of the transmission line with the port area. The eigenmode
solver can then calculate the exact port modes within these boundaries. The strategies
to properly define waveguide ports depend a bit on the type of the transmission line. In
the following we focus on the most commonly used applications.

Empty Waveguides

The most frequently used waveguide type of this category is the rectangular waveguide
shown below:

The port assignment for this type of waveguide is quite simple. However, it is important
to make sure that the port covers the entire waveguide cross-section. The easiest way to
define a port’s face is to pick structure elements such as points / edges / faces before
opening the port definition dialog box. The port dimensions will then automatically adjust
to the bounding box of the picked elements.

If the interior of the waveguide is modeled by a dielectric material block, you can simply
pick the end face of the waveguide as shown in the picture below:
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The bounding box of the picked end face will then exactly define the dimension of the
port.

When the background material is not made of PEC material, it is often required to model
the wall of the waveguide, too. For a construction like the one shown in the first picture
above, the end face of the rectangular waveguide has not been modeled directly.

We therefore recommend to pick the edges on the circumference of the waveguide or to
pick two opposite points on the corners:

In both cases, the bounding box of the picked elements will be large enough to cover the
entire field filled cross-section of the waveguide. The resulting port definition will then
look as follows:

CST MICROWAVE STUDIO® solvers generally allow using more than just the
fundamental mode in the waveguide port. This becomes especially important when
higher order modes need to be taken into account. As a rule, the number of modes to be
considered at a waveguide port should at least be the number of propagating modes.
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If an evanescent port mode result is selected, a box will appear visualizing the distance
from the port where the port mode has decayed by -40dB:
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Multiple waveguide modes can convert energy into each other at the structure’s
discontinuities. Due to these phenomena, the S-parameters of the propagating modes
can also be affected by the evanescent modes. Therefore a certain number of
evanescent modes needs to be taken into account. We recommend that the number of
modes used for the simulation be chosen such that the -40dB distance of the last
considered mode is shorter than the distance to the next discontinuity. This setting will
ensure that all modes not considered for the simulation will make only very small
contributions to the mode conversion.

In the case of quadratic or circular waveguides, the mode polarization is an issue. For
the example below, two propagating modes are calculated. By default, the orientation of
these modes is arbitrary:

v
77/
77444477
AT
b gy

Note that the waveguide port is still shown as a rectangular face. However, the
computation of the waveguide mode is automatically restricted to the interior of the
waveguide. The most important point here again is that the port’s face covers the entire
cross-section of the waveguide.
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You can specify the polarization of the modes by setting the Polarization angle in the
waveguide port dialog box. The orientation of the fundamental mode’s electric field is
then visualized by an arrow in the port face which is shown when the corresponding port
is selected. The second mode will then be calculated perpendicularly to the first one:

Polarization

Coaxial Waveguides

The most frequently used waveguide type of this category is the coaxial cable shown in
the picture below:

The port assignment for this type of waveguide is very simple. However, it is important to
make sure that the port covers the entire cross-section of the coaxial cable. The easiest
way to define the port face is to pick structure elements such as points / edges / faces
before opening the port definition dialog box. The port dimensions will then automatically
adjust to the bounding box of the picked elements.
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In most cases, the dielectric part of the coaxial cable will be modeled with a solid
cylinder. If this is the case, simply pick the end face of the dielectric as shown below:

The bounding box of the picked end face will then define the dimension of the port. Note
that the waveguide port is still shown as a rectangular face. However, the computation of
the waveguide mode will be automatically restricted to the interior of the coaxial cable.

If the end face of the dielectric can not be picked for some reason, you can also pick
edges or points on the circumference of the coaxial cable as described for the empty
waveguides.

In most cases, you will need to consider the fundamental mode of the coaxial cable so
that you don’t need to worry about the number of modes for the port. The mode is
automatically polarized so that the electric fields point from the inner conductor to the
outer conductor as shown in the following picture:
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Microstrip Lines

The microstrip line is one of the most commonly used transmission lines for high
frequency devices.

Unfortunately, this line type is relatively complex from an electromagnetic point of view.
Therefore a few things need to be considered when defining ports for this type of
structure.

This type of structure requires modeling the air above the microstrip line, too. The
easiest way to achieve this is to specify an extension in the Background Material dialog
box as shown in the Planar Structure tutorial.

In general, the size of the port is a very important consideration. On one hand, the port
needs to be large enough to enclose the significant part of the microstrip line’s
fundamental quasi-TEM mode. On the other hand, the port size should not be chosen
unnecessarily large because this may cause higher order waveguide modes to
propagate in the port.

The following pictures show the fundamental microstrip line mode and higher order
mode.

Fundamental mode Higher order mode

el

e

i
i
il s
il
4 4
A 4
a4

\
|
|-
A
4
qr
A=
4=

Bolefode il b

44
ddad=
d4aa=
ddd7=
440>
)/'t ///V

i o o =

Lttt et et utlont
ey e

LA At
PV TR T

e

it b

4 AP PETTTEErEEE
4 4 L
P
e
i o,

VA VPFFF T =

\ AAA

v v o E //-/:-,
ped b bR AAdAAAANRAGddd vy o ree
hoi b A A AR R AR AN A A A s s

The higher order modes of the microstrip line are very similar to modes in rectangular
waveguides. This behavior can be explained by an enclosure that is automatically added
along the port’s circumference for the port mode calculation. The boundary conditions at
the port's edges will adopt the settings from the 3D model. In case of an “open”
boundary in the 3D model, a “magnetic’ port boundary will be used. This enclosure
around the port causes the port to behave like a rectangular waveguide and thus is
responsible for the particular pattern of the higher order modes.

The larger the port, the lower the cut-off frequency of these modes. Since the higher
order modes are somewhat artificial, they should not be considered in the simulation.
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Therefore, the port size should be chosen small enough that the higher order modes can
not propagate, and only one (fundamental) mode should be chosen at the port.

If higher order microstrip line modes become propagating, this normally results in very
slow energy decays in the transient simulations and sharp spikes in the frequency
domain simulation results, respectively. On the other hand, choosing a port size too
small will cause degradation of the S-parameter’s accuracy or even instabilities of the
transient solver. If you experience an unexpected behavior like this, check the size of
the ports.

As a rule, the size of the port should be chosen according to the following picture:
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Ideally you would make the port 10 times as wide as the width of the microstrip line, but
this may be reduced to around 6 times the microstrip line width in case of geometrical
constraints.

One way to define the port for this type of structure is to enter all its coordinates
numerically. However, since this is a cumbersome solution, we will illustrate how ports
for microstrip lines can be defined based on picked geometry.

You can pick the entire end face of the microstrip line or pick the edge of the end face
which is located on the surface of the dielectric substrate. The following pictures
illustrate these options:

Pick end face Pick bottom edge (on substrate

After picking the geometry, you can open the port definition dialog box
(Solve =Waveguide Ports). In this dialog box, simply specify an extension of the port
around the picked geometry by entering the distances in the corresponding entry fields.
In case of a single picked line, you also need to set the port’'s normal direction and
orientation since it cannot be automatically derived from the picked geometry.
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You need an extension space of ideally 4.5 times the width of the microstrip line (here
25) at each side of the microstrip line. Furthermore, you should specify a distance of 4
times the substrate height (here 25) above the strip line.

Note: Make sure to enter exactly the height of the substrate for the port extension below
the microstrip line or you will introduce some unwanted additional space between the
substrate and the ground metallization, or the port may not be connected to ground at
all. We therefore recommend defining a parameter for the substrate’s height (e.g.
substrate_height). This parameter can then be used for specifying the bottom extension
as shown above.
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The explanations given above mainly refer to the unshielded microstrip lines. When a
shielded microstrip problem needs to be simulated, the port can usually be chosen in
such a way that it covers the entire dimension of the structure. The physical problem of
unwanted box resonances appears much earlier in these cases than the artificial
problem of unwanted propagating modes so that you do not need to worry about the
latter here.

The picture below shows the assignment of ports for a shielded structure with perfect
electric conducting walls at each side:

The easiest way to define a waveguide port covering the entire boundary face of the
computation domain is to use the Full plane option in the port definition dialog box rather
than using previously picked elements.

Some structures require more than one microstrip line being located at the same
boundary of the computation domain. In general, you should try to avoid this situation if
possible because it adds complexity to the port assignment.

However, if the microstrip lines are far enough away from each other that the interaction
of fields is negligible, then ports can be assigned in the same way as described above
using the same port size rule. An example for a structure like this is shown in the picture
below:

If the lines get even closer, then they no longer work as two independent microstrip lines
since the mode fields interact with each other and the waveguide becomes a multipin
waveguide. Refer to the explanations later in this section for this type of waveguide.
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Another important aspect in the simulation of microstrip lines is that the mode pattern is
frequency dependent (unlike the mode patterns in empty guides or coaxial lines).

The frequency domain solvers automatically recalculate the mode patterns for every
frequency point so that this frequency dependent behavior does not cause a difficulty for
the analysis.

In contrast, the time domain solver uses the same mode pattern for the entire frequency
band which may cause port mode mismatches at frequencies other than the mode
calculation frequency. The error increases with increasing distance to the mode
calculation frequency.

By default, the transient solver computes the mode pattern at the center frequency of
the frequency band, but this behavior can be changed by specifying the Mode
calculation frequency in the solver specials dialog box on the Waveguide page.

Despite this small mismatch at the ports, broadband simulation results will still be
sufficiently accurate in most cases. However, very high accuracy requirements or very
large bandwidths may require you to activate the Inhomogeneous Ports option in the
transient solver control dialog box. This feature will improve the accuracy of the S-
parameters but on the other hand will slow down the simulation. Refer to the online
documentation for more information concerning this feature.

Coplanar Lines
The coplanar line is a frequently used transmission line for high frequency devices.

Depending on whether the substrate is backed by a metallic shielding or not, the
waveguide is either called ungrounded coplanar line or grounded coplanar line.

Ungrounded coplanar line Grounded coplanar line

Unfortunately, this waveguide type is relatively complex from an electromagnetic point of
view. Therefore some things need to be considered when defining ports for this type of
structure. Many of the explanations in this subsection are similar to those for the
Microstrip line case. However, we will repeat everything here once again for your
convenience.

First of all, the size of the port is a very important consideration. On one hand, the port
needs to be large enough to enclose the significant part of the coplanar line field. On the
other hand, the port size should not be unnecessarily large because this may cause
higher order waveguide modes to propagate in the port.

The following pictures show the fundamental even and odd modes as well as a higher
order mode for an ungrounded coplanar waveguide:
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Even mode - OdeVm

Higher order mode
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The higher order modes of the coplanar line are very similar to modes in rectangular
waveguides. This behavior can be explained by an enclosure that is automatically added
along the port’s circumference for the port mode calculation. The boundary conditions at
the port’s edges adopt the settings from the 3D model. In case of an “open” boundary in
the 3D model, a “magnetic’ port boundary is used. This enclosure around the port
causes the port to behave like a rectangular waveguide and thus is responsible for the
particular pattern of the higher order modes.

The larger the port, the lower the cut-off frequency of these modes. Since the higher
order modes are somewhat artificial, they should not be considered in the simulation.
Therefore, the port size should be chosen small enough that the higher order modes can
not propagate, and only the fundamental modes should be considered at the port.

If higher order coplanar line modes become propagating, this normally results in very
slow energy decays in the transient simulations and sharp spikes in the frequency
domain simulation results, respectively. On the other hand, choosing the port size too
small will cause degradation of the S-parameter’s accuracy or even instabilities of the
transient solver. If you experience an unexpected behavior like this, check the size of
the ports.
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In the following we will draw a distinction between grounded and non-grounded coplanar
lines. The following pictures show the recommended sizes of the port for both cases:

Ungrounded coplanar line
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Grounded coplanar line
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Ideally you would make the port three times as wide as the width of the inner conductor
plus the width of the two gaps, but this may be reduced to around two times the inner
conductor width plus the gaps in case of geometrical constraints.

For ungrounded coplanar lines, you should enlarge the port by at least half of the inner
conductor’'s width plus the width of the gaps above and below the metallization. For
grounded coplanar lines the same is true above the inner conductor, but you should
make the port large enough to touch the ground metallization below.
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One way to define the port for this type of structure is to enter all its coordinates
numerically. However, since this is of course a very cumbersome solution, we will
illustrate how ports for coplanar lines can be defined based on picked geometry.

The easiest way to define a coplanar waveguide port is to pick the two innermost
substrate corners of the outer conductors as shown in the picture below:

After picking the geometry, you can now open the port definition dialog box
(Solve =Waveguide Ports). In this dialog box, simply select the port's normal direction
and orientation before you specify an extension of the port around the picked geometry
by entering the distances in the corresponding entry fields:
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You need an extension space of ideally the width of the inner conductor plus the gaps
line (here 3) at each side of the inner conductor line. Furthermore, you should specify a
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distance of half of the width of the inner conductor plus the gaps above and below the
inner conductor.

In the case of grounded coplanar lines, make sure to enter exactly the height of the
substrate for the port extension below the inner conductor or you might introduce some
unwanted additional space between the substrate and the ground metallization, or the
port may not be connected to ground at all.

Grounded coplanar line

Ungrounded coplanar line

The explanations above mainly refer to unshielded coplanar lines. When a shielded
coplanar line problem needs to be simulated, the port can be normally chosen so that it
covers the entire dimension of the structure. The physical problem of unwanted box
resonances appears much earlier in these cases than the artificial problem of unwanted
propagating modes so that you do not need to worry about the latter here.

The picture below shows the assignment of ports for a shielded structure with perfectly
electric conducting walls at each side:

The easiest way to define waveguide ports covering the entire boundary face of the
computation domain is to use the Full plane option in the port definition dialog box rather
than using previously picked elements.

Some structures require more than one coplanar line located at the same boundary of
the computation domain. In general, you should try to avoid this situation if possible
because it adds complexity to the port assignment.
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However, if the coplanar lines are far enough away from each other that the interaction
of fields is negligible, ports can be assigned in the same way as described above using
the same port size rule. An example for a structure like this is shown here:

If the lines get even closer, then they no longer work as two independent coplanar lines
since the mode fields interact with each other and the waveguide becomes a multipin
waveguide. Refer to the explanations later in this section for this type of waveguide.

If no symmetry condition is defined in the middle of the coplanar line, both even and odd
modes can exist and therefore need to be taken into account. If an electric symmetry
condition is specified, only the odd mode can exist. On the other hand, setting a
magnetic symmetry condition will consider the even mode only.

If the microstrip line is grounded, another parasitic microstrip mode will exist too as long
as no electric symmetry is defined. All this leads us to the following table for the number
of modes normally used for the simulation at the coplanar port:

Symmetry Ungrounded Coplanar | Grounded Coplanar
None 2 modes 3 modes
Electric 1 modes 1 modes
Magnetic 1 modes 2 modes

The corresponding number can be specified in the Number of modes field in the port
properties dialog box.

Note that the order in which the port modes are calculated may vary depending on the
dimensions of the structure as well as the frequency. Therefore we highly recommend
always inspecting the port mode results in order to avoid misinterpreting the S-
parameter data.

Another important aspect in the simulation of coplanar lines is the fact that the mode
pattern is frequency dependent (unlike the mode patterns in empty guides or coaxial
lines).

The frequency domain solvers automatically recalculate the mode patterns for every
frequency point so that this frequency dependency does not constitute a difficulty for
analysis.

In contrast, the time domain solver uses the same mode pattern for the entire frequency
band which may cause port mode mismatches at frequencies other than the mode
calculation frequency. The error increases with increasing distance to the mode
calculation frequency.
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By default, the transient solver computes the mode pattern at the center frequency of
the frequency band, but this behavior can be changed by specifying the Mode
calculation frequency in the solver specials dialog box on the Waveguide page.

Despite this small mismatch at the ports, the broadband simulation results are still
sufficiently accurate in most cases. However, very high accuracy requirements or very
large bandwidths may require you to activate the Inhomogeneous Ports option in the
transient solver control dialog box. This feature will improve the accuracy of the S-
parameters but on the other hand will also slow down the simulation. Refer to the online
documentation for more information concerning this feature.

Multipin Waveguides

A multipin waveguide is characterized by having more than two conductors (e.g. two
inner conductors plus shielding) in the port. According to this definition, a coplanar line is
also a multipin waveguide. However, due to the importance of this particular
transmission line type, it is explained in detail separately in the preceding subsection.

Let's first consider a simple case of a waveguide being homogeneously filled with a
dielectric substrate and having more than two conductors:

®
Se
®

The mode patterns for this type of waveguide are frequency independent. For
waveguides having N isolated conductors, (N-1) propagating TEM type modes exist, all
sharing exactly the same propagation constant. These modes are also called
degenerated modes. The electric port mode fields for the example above are shown in
the following picture (5 conductors = 4 modes):

The port mode solver calculates an arbitrary superposition of the fundamental TEM
modes, which unfortunately is not often the desired solution. More constraints are
required to specify how to superimpose these modes to obtain the favored mode
patterns.
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Let's now assume that you want to obtain the S-parameters for two differential pairs.
Each of these differential pairs is built by two opposite conductors as shown in the
following picture:

Pair 1 Pair 2

The transient solver features a special multipin port option that allows you to specify
additional constraints. However, since this option is currently not available for the
tetrahedral frequency domain solver and also has some limitations, an alternative
approach using standard waveguide ports is explained later in the next subsection
(Handling Multipin Waveguides by Using Standard Ports).

Each of the desired excitations in the example above corresponds to a particular mode
which is a superposition of the structure’s TEM modes. The necessary constraint to get
the proper modes for the two pairs can be defined by assigning potential values to the
conductors. The following picture shows the potential definition which yields the desired
mode patterns:

Pair 1 Pair 2

The definition of a multipin port starts by defining a port area of correct size (not too
large and not too small) as shown in the sections above. Refer to the explanations of the
transmission line type closest to your structure for more information.

Once the port size is determined, check the Multipin port box in the port dialog box:



138

CST MICROWAVE STUDIO® 2006 — Getting Started
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Clicking the Define Pins button opens the following dialog box where you can assign the

desired potential settings to the conductors:

e

Potential Set Definitions

w

Set Patential

A Set corresponds to a particular mode defined by assigning a certain potential
distribution to the conductors. Each Set can therefore contain multiple potential
definitions and represents a particular superposition of the port’'s eigenmodes. In the
example above, you need to define two Sets, each of which represents the mode for

one of the differential pairs.

To define the first conductor potential, click the Add button to open another dialog box:
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The Set Number is the first setting to make here. All Sets are simply enumerated,
starting with 1. In our example, we define two sets, named as 1 and 2.

After selecting the correct set number, you can specify whether you are going to define a
positive or negative potential. In this example, you need to define a positive and a
negative potential for the two conductors within each pair.

In most cases, it is recommended to place the potential assignment by picking the
corresponding conductor in the structure view, so you can simply keep the Location
being set to Picked.

Clicking OK enters an interactive mode so that you can simply double-click on an end
face of a conductor in order to assign the potential definition there. Once you define the
two potentials for the conductors belonging to pair 1, the model should look as follows:

Each of the potential definitions is labeled using the following convention: The port
number is followed by a label enclosed in brackets. The first entry within the bracket
gives the set number whereas the second entry depicts the type of the potential (positive
or negative).
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You can now assign the corresponding potentials to the two conductors in the second
mode set (corresponding to the second differential pair):

Taking these potential constraints into account, the port modes will be calculated as
follows:

Pair 1 Pair 2

The transient solver and the hexahedral frequency domain solvers then calculate the S-
parameters belonging to these mode definitions.

Please note that in order to calculate the interaction of even and odd modes in a single
simulation run, it is also possible to use a conductor in several mode sets at the same
time.

The multipin ports should not be applied to conductors that are completely shielded
against each other:
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For structures like this one, standard ports are preferred as shown below:

For inhomogeneous waveguides such as microstrip lines, coplanar lines, etc., the
modes are generally not degenerated. In those cases, a superposition of the modes is
not allowed and may lead to incorrect results. However, for relatively small frequencies
or weak inhomogeneities, the modes may still be sufficiently degenerated. The solvers
automatically check the level of mode degeneration and show a warning if the multipin
ports should not be applied.

If the usage of multipin ports is not possible (for whatever reason), the next subsection
gives some suggestions of how to handle this situation.

Handle Multipin Waveguides Using Standard Ports
In some cases, multiple transmission lines are located at the same side wall of the

bounding box and are too close to each other to be handled as isolated transmission
lines.

The preceding subsection explains the multipin port feature which provides a good
solution in many cases. However, for tetrahedral frequency domain simulations or
inhomogeneous waveguides at higher frequencies, this convenient feature cannot be
applied.

Please note that closely neighboured transmission lines are truly physically coupled.
Therefore all measurement set up will introduce some mismatch which needs to be de-
embedded properly. Keep this in mind when comparing S-parameters from simulation
and measurement. Disagreement is observed quite regularly when the simulation set up
does not replicate the measurement set up.
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The easiest way to handle strongly coupled transmission line cases is to introduce a
shielding at the ports in order to properly separate them. Afterward, waveguide ports can
be individually applied to each of the transmission lines:

Even if this approach introduces some mismatch at the ports, of course, it may still be a
viable solution. If you are unsure about the level of reflection added to the S-parameter
matrix by this artificial shielding, you can simulate a short line segment alone. Ideally the
reflection for the homogeneous line is zero. Therefore the actual reflection level provides
some indication about the port mismatch for the particular structure.

If the former approach does not produce sufficiently accurate results, the only way to
handle this problem is to calculate the S-parameters for the multimode matrix by taking
all propagating modes into account at each port. In transient simulations, you may also
consider using the Inhomogeneous port accuracy enhancement option in the solver
control dialog box to further increase the accuracy of the broadband S-parameter
solution.

Once the multimode matrix is calculated, single-ended S-parameters can be obtained as
a secondary result using the macro Macros=Results=S-Parameter=>Multiline
Common+differential mode->single ended. Refer to the macro’s documentation for more
information.

Inhomogeneous Waveguides

A waveguide is called inhomogeneous whenever more than one different dielectric
material is present in the cross-section of the waveguide. This is the case for microstrip
lines and coplanar lines — these two very common transmission lines are discussed
earlier in this section.

The following explanations therefore exclude these types of waveguides and focus on
dielectrically loaded waveguides. A typical example is shown in the following picture:
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In terms of assigning ports to these waveguides, the procedure is very similar to the
Empty waveguide case explained earlier in this section. The main difference here is that
the port mode pattern is no longer frequency independent.

The frequency domain solvers automatically recalculate the mode patterns for every
frequency point so that this frequency dependency does not constitute a difficulty for the
analysis.

In contrast, the time domain solver uses the same mode pattern for the entire frequency
band which may cause port mode mismatches at frequencies other than the mode
calculation frequency. The error increases with increasing distance to the mode
calculation frequency.

If you are interested in only very small frequency ranges, a viable solution may be to set
the mode calculation frequency equal to the center frequency of this frequency band.
This setting can be made by specifying the Mode calculation frequency in the solver
specials dialog box on the Waveguide page.

However, if you are interested in broadband results within larger frequency ranges, the
transient solver needs to be advised to make a special (and computationally expensive)
treatment for the inhomogeneous ports. The Broadband for inhomogeneous waveguide
ports (no QTEM modes) option can also be activated on the Waveguide page of the
solver’s specials dialog box:

Special Solver Parameters

Waveguide | Steady State | &R-Filter | Lossy Metal | Solver | PB&

Fort zettings

Humber of zapplssksketine

Broadband for inhomogeneous waveguide ports [no OTEM modes
umber of frequency samples; g

Ahzorb unconzidered mode Tields for nhomogeneous ports

[ &dd electric: shielding around part region
Activate TST at ports

tode calculation frequency: Frmin Frnax

iz j

[ Ok ][ Cancel ][ Help ]

This option will provide much more accurate broadband results for this type of port.
Unfortunately, it is limited to the fundamental (propagating) mode only. Refer to the
online documentation for more information about this feature.
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Antenna Computations

An antenna computation is usually performed using the transient solver and is thus quite
similar to the procedure explained in the previous example.

In some rare cases it may be advantageous to use the frequency domain solver. The
only difference between these calculations and the procedure described below is that
the frequency domain solver needs to be initiated rather than the transient solver. Refer
to the frequency domain solver online help for more information.

With respect to the transient analysis, the main difference between an antenna
calculation and the S-parameter calculations described earlier in this document lies in
the definition of the boundary conditions. Since the antenna radiates into free space,
open (or absorbing) boundary conditions must be applied. Therefore simply select
“open” boundaries in the Solve z>Boundary Conditions (&7) dialog box:

= =

Boundary Conditions

Boundaries | Symmetry Planes | Boundary Temperature

Hmir: | electric [Et=0) w | Hmax | electic [Et =10] b
;| electic [Et = 0] » | Tmaw | electnc [Et=10] -
Zmir: | electric [Et=0) | Zmax | electic [Et =10] b

e

magnetic [HE = 0]

apen

open (add space]

conducting Wa K ] [ e l [ Help ]

Open boundary conditions require some space between the device and the boundary
planes for optimum performance. Since the open boundary conditions are very accurate,
only a small distance is necessary. However, if you are not sure about the amount of
space needed, simply choose “open (add space)’ from the boundary options. In this
case, the necessary space is estimated automatically.

For the calculation of the antenna farfield gain or directivity patterns (farfield distribution
in spherical or Ludwig coordinate systems, left and right hand polarization, axial ratio),
“farfield monitors” need to be defined before the simulation starts. Similar to the
definition of the other field monitors, an arbitrary number of these monitors can be
defined for various frequencies. This means that you can compute the antenna farfield
for multiple frequency points from a single transient analysis. The farfield monitors are
specified in the Solve =Field Monitors (#) dialog box:
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7= =

Monitor
Labeling
M arme: farfield [f=1000] Automatic labeling
Type Specifization
) E-Field (® Frequency
() HField/S urface current Frequency: 1000
() Poweer flow BT 0.0
() Curent density hiere 2000
) Power loss density/[S8R)
20 Pl
() Electic energy density s
petic energy dengsit
Y ¥ Orientatian:
Position:
[ (]S ] [ Apply ] [ Cancel ] [ Help ]

After the transient analysis is complete, you can access your farfield results from the
Navigation Tree=*Farfields folder. Typical antenna characteristics such as main beam
direction, gain, efficiency, side lobe suppression, etc. are automatically calculated and
displayed. Please refer to the tutorial Patch Antenna for more information.

The farfield monitors introduced above are especially useful when the farfield needs to
be calculated for a wide angular range (theta, phi) but only at a few frequency points. On
the other hand, some applications require the calculation of the farfield at a few locations
(theta, phi) only but as a function of frequency. In these cases, it is advantageous to use
the farfield probes: Solve =Probes, Field = E-field (Farfield) or H-field (Farfield):

Probes

General | Origin | Decoupling Plane | Specials

hame:

probel

Field: Coordinate system:

E-field [Farfield) Sl Cartesian v |

Orientation Fozition

[ (]S l[ Apply H Cancel ][ Help ]

In this dialog box, you can specify the type of the farfield, the location and the orientation
of the desired probe in Cartesian, spherical or Ludwig coordinate systems. Please refer
to the online documentation for more information about this feature.

Another very interesting functionality in combination with farfield calculations is the result
templates whose basic functionality has already been demonstrated in the previous
example. There are also some 1D Result templates available for automated farfield
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processing, e.g. the Farfield (single frq.) template. Choosing this template from the 1D
Result template list (Results=Template Based Postprocessing) will open the following
dialog box:

EL 1D Farfield Plot

Farfield Monitor and Excitation Plat Mode and Scaling

farfield [F=900] W Gain [IEEE] w

Ewcitation String: |['|] Component: | Abs

Cutplane ’_ ’_ ’_

Waming Anagle Fired Angle
i Theta:
(%) Theta () Phi eta Olnsar G log [cB]

Stepzize: |5— deg Phi: 0

[ 0K ll Cancel l

Here you can specify which one of the previously defined farfield monitors should be
processed and which farfield component and excitation ([1] corresponds to excitation at
port 1) should be considered. Furthermore you need to specify the cutplane in the
spherical coordinate system in order to derive a 1D curve from the farfield monitor. The
result of this farfield processing template is a single result curve which can then be
further processed by other result templates.

As an example, you could extract the location of the maximum by using a 0D result
template (0D Value From 1D Result) and then use this value for optimizations of the
main lobe direction to a certain angular location or magnitude. Please refer to the online
documentation and the Advanced Topics manual for more information.

The following summarizes the input necessary for antenna calculations:

Select an antenna project template (optional).

Set units (optional).

Set background material (optional).

Define structure.

Set frequency range.

Set (open) boundary conditions (optional).

Define excitation ports.

Set (farfield) monitors and/or probes.

. Specify farfield result processing templates (optional).
10 Start transient or general purpose frequency domain solver.
11. Analyze results (input impedance, farfields, etc.).

CoN>OR®ON =~
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Simplifying Antenna Farfield Calculations

In many cases where only the antenna farfield pattern is of interest rather than the
feeding point impedance, it is not necessary to model the actual geometry of the feeding
point. However, when you want very accurate results of the antenna’s input reflection, it
is essential to model the feeding point exactly as it is.

In cases where you are able to use a simplified model, you can use discrete ports rather
than waveguide ports (please refer to the Discrete Ports section earlier in this chapter).

If you start the analysis of a new antenna it is usually a good approach to begin with a
discrete port. Since the model is easier to build, you will obtain initial S-parameter and
farfield pattern results quickly. This will allow you to assess the principal operation of the
antenna before increasing the accuracy (optional) by generating a detailed model of the
feeding point geometry.

The following pictures show feeding point models of a simple patch antenna as an
example.

a) Simplified model of the feeding point with a discrete port

b) Detailed model of the feeding point using a waveguide port

In picture a), the antenna is fed by a discrete port which represents a current source with
an internal resistance. This approach delivers accurate farfield results but may yield S-
parameters which are not directly comparable to the measurements.

In picture b), the antenna is fed by a coaxial line (as in the real-world structure) which
gives accurate farfield patterns and S-parameters.
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Digital Calculations

A digital calculation is typically performed using the transient solver. Thus the overall
simulation procedure is similar to the procedure described earlier in this document.

The main difference between a digital calculation and a typical S-parameter calculation
is the definition of the excitation signal.

For S-parameter calculations the excitation signal for the transient analysis is typically
defined by a Gaussian shape for which the Fourier spectrum is also given by a Gaussian
shape covering the entire frequency band of interest. Therefore the time signal is
determined mainly by the demands on the frequency band.

In contrast, the excitation signal for a digital simulation is described in the time domain
by specifying rise-, hold- and fall-times of a rectangular pulse. You can change the
excitation signal’'s shape by first selecting it in the navigation tree NT=Excitation
Signal=default and then changing its properties (Edit=*Object Properties) to open the
following dialog box:

7 -
Excitation Siznal
o Settings
ame: | default
i Tiotat |1000
() Gaussian Trise: | 100
{(*) Rectangular Thald: | 200
() User defined Tfall: 100

In the example studied above (with the time unit set to ps) the settings define a
rectangular shape with a rise-time of 100 ps, a hold-time of 200 ps and a fall-time of 100
ps. The rise- and fall-times of 100 ps correspond to a bandwidth of approximately 10
GHz. The maximum simulation time is given in the Ttotal field and is set to 1000 ps in
this example. The solver automatically stops after simulating the given total time range.
The parameters of the rectangular excitation function are specified in the currently
selected time units.
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Once the rectangular excitation signal has been defined, it can be viewed by selecting it
from the navigation tree NT=Excitation Signals:

Excitation: defait

default

--------------------------------------------------------------------------------------------------------------------------------------------

__________________________________________________________________________________________________________________________________________

500 00 1000

Tirne / ps

After the default excitation signal has been changed, the modified signal is used for all
subsequent transient simulations. You can also specify additional excitation signals in
order to excite different ports with individual excitation signals. Refer to the online
documentation for more information about this feature.

The transient solver also stops automatically when the energy in the calculation domain
is below the level specified in the Accuracy field. This may be the case even before the
time specified by the Ttotal setting (see above) is simulated. To turn off this automatic
termination, select No Check in the Accuracy field as shown in the transient solver
control dialog box below:

Transient Solver Parameters

Solver zettings

o Chack +| dB [ 5tare result data in cache Optimize...

Far. Sweep...
Stimulation settings

Sowrce type: | Al Ports w [ Inhomogeneous port Specials...
accuracy enhancement
tode: All w [ Calzulate modes only Simplify Madel...

S-parameter seftings
= = Apply

[T Mormalize to fixed impedance
Cloze

Ohmsz

Help

Adaptive mesh refinement
[ &daptive mesh refinement

Metwork computing

[ I Metwork computing
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In our example, the coaxial bend shows the following response to the digital excitation:

Time Signals

i1

ol 1
02,1
ol,2

200 400 600 800 1000

Time / ps

The excitation signal “i1” shows the given rise-, hold- and fall-times. The output signal
“02.1” has a distinctly distorted pulse shape (due to the dispersion of the coaxial bend)
and a time delay because of the finite length of the transmission line.

In addition to this simplified description of the excitation signal, it is also possible to set a
user defined pulse shape. Refer to the online documentation for details.

The following summarizes the input necessary for digital calculations:

TP NoOaRwN =~

0.
1.

Select an appropriate project template (optional).
Set units (optional).

Set background material (optional).

Define the structure.

Set the frequency range (covering all desired harmonics).
Set the boundary conditions (optional).

Define the excitation ports.

Set the monitors and/or probes (optional).

Define the excitation signal parameters.

Start the transient solver.

Analyze the results (usually the time signals).

There are some post-processing macros available especially dedicated to digital
simulations such as eye diagram computation (Time Signal Processing=Eye Diagram)
or exchange of excitation signals after the simulation (Time Signal Processing
=Exchange Excitation).
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Add Circuit Elements to External Ports

The integration of CST MICROWAVE STUDIO® with CST DESIGN ENVIRONMENT™
allows for a straightforward coupling of EM simulation and circuit simulation.

For each CST MICROWAVE STUDIO® structure, two fundamentally different views on
the model exist. The standard view is the 3D model representation which is visible by
default. However, in addition, a schematic view can be activated by selecting the
corresponding tab under the main view:

=

(] Components

{2 Smith Chart
(] Balance
(2 Energy
(1 20730 Results
(1 Farfields
B Readme

Once this view is activated, a schematic canvas is shown where the 3D structure is
represented by a single block (MWS block) with terminals:

ME
=123 Projects Recently used blocks
=8 145
8 Drawing ]
=E3 Blacks
@ MWSSCHEMI
[ Esternal Port:
[0 Cireuit Port: \ A '
0 s MWS block
[0 Tasks
[ Resuls
[ Macios
. Miscellaneous
Block selection pane Tiarsmission e
Waveguite
Microstrip
Circuit Basic
[Ll I Cireuil it Semicon: ductor
E 145" [ T] 145" Circuit Rt
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The terminals are a one-to-one correspondence to the 3D structure’s waveguide or
discrete ports. The schematic view now allows for easy addition of external circuit
elements to the terminals of the 3D structure.

Adding circuit elements to the schematic view is straightforward. The general procedure
is to select a circuit element from the block selection pane and drag it onto the
schematic canvas.

The block selection pane is organized into several categories containing elements that
may or may not be accessible to you according to license restrictions. Contact your
sales office for more information.

Basic circuit elements such as R, L, C, GND and ports are normally included in the basic
CST MICROWAVE STUDIO® license.

You can access the circuit elements from the block selection pane after clicking on the
Circuit Basic tab:

hd

Recently used hlocks

Miscellaneous

Transmission Line

Waveguide

Microstrip

Circuit Basic

Graund

L L

Capacitor

A L

Yoltage DC Source

Circuit Semiconductar
Circuit Bf
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These elements can now either be dragged by pressing the left mouse button on the
element itself or even more easily by pressing the left mouse button while the cursor is
on one of the element’s terminals. Note that an element’s terminal is highlighted by a red
circle whenever the mouse pointer is located over it.

Once an element is selected at its terminal and then dragged onto the schematic
canvas, a red dot will appear whenever the terminal is located close to the end of an
already existing connection line (here shown for the RJ45 connector example):

S

Releasing the mouse button there will then place and connect the circuit element on the
canvas. Red terminal lines illustrate that this line is still open-ended whereas blue lines
indicate proper connection.

Selecting a circuit element by single-clicking on it will reveal its properties in the
parameter window as shown below:

ill Hame Walue Uit
Fesistance R0.0 & Ohm -
Global }, Block

The element’s properties can be modified in the usual way by clicking into the
corresponding entry field and changing the value.

Ground (GND) elements and ports can also be accessed by dragging and dropping
them from the block selection pane (for ports select the Miscellaneous section), but
convenient shortcuts exist for these frequently used elements:

Shortcut Description

g Place a ground element. Simply click on the end
of a connection line after activating this shortcut.
p Place a port element. Click on the end of a

connection line to place the port

All elements can be dragged with the mouse to a new location while the elements stay
connected via the connection lines. Furthermore, after you select an element, you can
rotate it by choosing View=Tools=Rotate/Flip Tools=Rotate Left (shortcut 1) and
View=Tools =*Rotate/Flip Tools=>Rotate Right (shortcut r), respectively.
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The following picture shows an exemplary external circuit where the original 8-port
structure has been reduced to a 2-port device by applying loads to all the other
terminals:

5:0.0 Oluui ] 5:0.0: Ol:uu:

I
1

©50.0 Ohm 37 50,0 Ohm
[ 1| & 2 7
L ==
‘| 3 L [ ||
50.0 Ohm 4/ 8 50.0 Ohm

Once all terminals of the MWS block are connected to circuit elements, an S-parameter
simulation of the structure including the external circuitry can be performed. The
resulting S-matrix will have two ports in the example above, since only two external ports
have been placed in the schematic (represented by diamond-like symbols).

In order to run an S-parameter circuit simulation, choose Simulation=>Update. The circuit
simulator supports a variety of different analysis options, so you will be prompted to
select one of them:

e 1
Select SimulationTask
Simulation Task
= [ Standard

=) [ Circuit mmulatlnnw
Operating point (DC)
3 AC
[L] Spectral lines
Mixer
Amplifier
[R] Generic
FQ Transient

Detailz

Calculate 5-Parameter

0k ] [ Cancel l [ Help ]
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Not all of these options may be available to you due to license restrictions. Here you
should select S-Parameters and click OK. A dialog box will appear in which you can
specify the settings of the S-parameter calculation:

S-Parameters Simulation Task

Frequencies | Antenna
Frequency Limits

Lawer limit; |0 Upper limit; |1

Units APLAC
S () Local units (®) D5 APLAC

Frequencies:

S-Parameter Settings

M axirum frequency range
Frnir: Frnaw:
Murnber aof frequency steps: 101

[ Logarithmic sweep

[ ak. H Cancel H Help ]

The most important setting is the Number of frequency steps here. Clicking OK will start
the S-parameter simulation of the coupled EM and circuit problem. If all simulation
results of the 3D EM simulation are already present, the circuit simulation will only take a
few seconds to complete. Otherwise, the missing EM simulation data will be
automatically computed first.

Once the simulation is complete, the results will be added to the navigation tree. The
Projects folder will contain a list of sub-folders, each of which represent a currently
opened project. All data will be stored under the folder for the corresponding project.
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The S-parameters will be shown as top-level results of the project folder. Simply clicking
on the S-Parameters entry will show the external S-parameters:

S S
=a gmem Recently used blocks
RSN

g S-Parameters Magnitude Miscellaneous
‘B8 Impedances [S-Parameters] Transmiggion Line
i=-F8 §-Parameters [5-Parameters]] 1 —— Wavaguide
‘ & 511 S 51,1

% o C T 512 Circuit Basie
52 52,1
oL Blocks 52,2
= L3 (e e e e I e B
¢ 1
L
[ Circuit Ports
[ Probes
= Tasks
B S-Parameters] L R s ROt AERRERIILELLECRRRRED
3 Resuls
[ Macros

L T T kit

0 + + + t
4] 0.2 0.4 0.6 08 1
Frequency [ GHz
Circuit Semiconductor
E  #F @b @5 i 55 Paam. | I Circutt RY

The schematic view also supports the parameterization of the 3D model in a
straightforward way by making the structure parameters available as block parameters
for the MWS block. This tight coupling of the different simulation methods allows for true
EM / circuit co-simulation.

For more information on how to use the schematic canvas or the many simulation
options, refer to the CST DESIGN STUDIO™ Getting Started manual.
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SPICE Network Model Extraction

Some applications require the derivation of SPICE compatible network models which
have the same port behavior as the 3D structure.

Therefore CST MICROWAVE STUDIO® offers Network parameter extraction features
that allow the automatic generation of a SPICE compatible netlists for a given device.

Two different extraction methods are available:

1.  The general purpose extraction scheme based on a model order reduction
2. The specialized extraction scheme based on a fixed topology (network of coupled
transmission lines)

The following sections provide a brief introduction to the particular advantages and the
typical applications for each of these schemes. Please refer to the online documentation
for more detailed information.

Model Order Reduction Based Network Parameter Extraction

This model is based on a SPICE network with controlled sources and does not assume
any particular topology. The advantage of this approach is that the SPICE model can be
extracted for arbitrary structures, but on the other hand the network parameters do not
have any physical meaning. Therefore the SPICE model should be considered as a
black box that has the same electrical behavior at its ports as the full 3D structure.

For the practical usage of this extraction technique, it is usually required to calculate the
full generalized S-matrix of the structure first.

Let us now consider the previous example and derive an equivalent SPICE circuit for the
coaxial bend.

Once all generalized S-parameters have been calculated (All Ports option, no re-
normalization to a fixed port impedance), open the dialog box by choosing Results=
Network Parameter Extraction=Model Order Reduction:
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Metwork Parameter Extraction (MOR)
Settings
|mitial Number of Poles: 10
Accuracy: Ted0z |w

[JEntarce pazsivity far all frequency values

[ Use &R -Filker Results if available

SPICE netlist filename

getting started "MOR . net

[ Start ] l Cancel ] [ Help ]

In most cases, you can accept the default settings and click the Start button. After the
network parameter extraction calculation is complete, you should carefully check its
output in the message window:

é) Perfarming Metwork Model Order Reduction
i) Stepi
12 polez will be uzed for approximation

Mawx. Error 4.33e-001
Average Error: 6.97e-002

Ay Step?
22 poles will be uzed for approximation

kaw. Error: 2. 74e-001
Average Error: 1.05e-003

Ay Step3
32 poles will be uzed for approximation

Mar. Eror B.02e-003
Ayverage Error: B.05e-004

;5) MHetwork MOR completed succesfully

x|
E

First, check whether the network extraction has completed successfully or whether any
warning or error messages have been issued. The generated SPICE netlist file
containing a subcircuit representing the actual S-parameter data will then look as
follows:

IR R R EEEE S EEEEEEEEEE SR SRR EEERE RS SRR EEEREEEEEEEEEEEREEEEEEEEEEEEESEEEES
*** Netlist for Macromodel generated by CST DESIGN ENVIRONMENT ***

**%x Thig file was generated automatically *kk
IR R EEE R ESEEEEEEEEEESEEEEEEERE RS SRR EEEREEEEEEEEEEEEEEEEEREEEEEEEEEEEES
*** Generated 14-Sep-2005, 19:00 * %k K

kkhkkhkkhkhkkkkhkhhkhkhkhkkhdhhhkhkhkhkhhhhkhkkhkdhhhhkhkkhhhhhkhkkhkhhhkhkkddhhkhkdkkhkkhdhkhkkkkhkkkkk*kkk*x

*** Connect the external circuit to ports 1, 2 ..... * kK
.subckt getting started 1 2

*** Nodal Ckts Associated With Each State Variable **=*
Cnl nodel O le-9

Rall nodel O 3.580667898402919e-005
Gbl1l nodel 0 1 O -1.000000000000000e+000
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** End of Nodal Ckt for State Variable #1 *x*

Cn2 node2 0 le-9
Ra22 node2 0 3.580667898402919e-005
Gb22 node2 0 2 0 -1.000000000000000e+000

** End of Nodal Ckt for State Variable #2 *x*

Having verified that the calculation was successful, you should then look at the
approximation error which is significantly below 1% for the entire frequency band in this
example.

Furthermore, the passivity requirements are met which means that the equivalent SPICE
circuit is stable and passive and therefore ideally suited for embedding in larger system
or circuit simulations.

Some more information about the results of the network extraction can be found in the
navigation tree’s NT=Network Extraction folder. Check the agreement of the original
data and the data provided by the model order reduction by selecting the NT=Network
Extraction =Error=>Relative =*|S| linear folder:

Relative Error of S-parameter magnitude
0.007

Rel. Aprox, Error of 5 1,1
Rel. Aprox, Error of 5 2,1
Rel. Aprox, Error of 5 1,2
Rel. Aprox., Error of 5 2,2

0.006 .

0.005 .

0.004 _

0.003 .

0.00z2

0.001

0 5 10 15 20

Frequency in GHz

A final verification of the generated netlist can be obtained by loading the netlist into the
schematic and comparing its S-parameter results with the original block data.

Now switch to the canvas by clicking the corresponding tab and add two ports to the
CST MICROWAVE STUDIO® block representing the current 3D structure. For more
information about how to use the schematic canvas, refer to the section Adding Circuit
Elements to the External Ports earlier in this chapter. The canvas should then look as
follows:

Ol IO

You should now place a CST MICROWAVE STUDIO® netlist file block in the canvas by
dragging it from the block selection pane, Miscellaneous section. When you are asked to




160

CST MICROWAVE STUDIO® 2006 — Getting Started

select a netlist file, simply browse for the file which has previously been generated by
the SPICE netlist extraction tool. After adding ports to the netlist block again, you should

obtain the following schematic:

Ol

Running an S-parameter circuit simulation and looking at the results as described in the
section Circuit Elements to the External Ports will produce a plot as follows:

S-Parameters Magnitude

*5i,1
¥51,2
=521
52,2

53,4

0 54,4

Frequency [ GHz

As the picture shows, there is excellent agreement between the results obtained by the
circuit simulator using the extracted netlist and the original S-parameter data.
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Transmission Line Based Network Parameter Extraction

Since this model is based on a network of coupled transmission lines, the approximation
is best for transmission line type devices such as connectors or IC packages. It should
not be used when the topology of the simulated device is not fundamentally equivalent
to a simple network of coupled transmission lines.

The practical usage of this network parameter extraction is based on the definition of so-
called Wires for which a T-shaped network representation will be generated. The
frequency range for sufficiently accurate representations can be extended by cascading
the model.

Please note: In contrast to the Model Order Reduction based network parameter
extraction, this method requires only the excitation of one port for each wire rather than
an excitation at each port of the structure. Therefore it is advantageous not to calculate
the full S-matrix in advance by using the All Ports setting in the transient solver but to let
the network parameter extraction feature do the selection of necessary excitation ports.

The extracted network model will describe both the behavior of each of the transmission
lines and the coupling (cross-talk) between these lines.

The procedure for calculating the network model is similar to the simulation procedure of
a transient analysis. After modeling the structure, defining its material properties, its
frequency range, etc., the ports need to be defined.

Since the network model assumes that the structure can be described by a lumped
element network, the validity of this approach is limited to frequency ranges within which
the structure behaves like a transmission line network. Therefore it is usually sufficient to
use discrete ports for this kind of calculation.

The following example calculates the network model of two coupled transmission lines.
To reproduce this calculation, enter a structure that looks similar to the picture below:

Port 2

Port 1
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All conductors (including the ground plane) are modeled as perfect conductors here. It is
not necessary to model the ground plane because the corresponding boundary plane
can simply be set to electric.

The next step is to open the network parameter extraction dialog box by selecting:
Results = Network Parameter Extraction=>Transmission Line:

Metwork Parameter Extraction

Wwire  Portd Mode & PortB  Mode B

‘ Add Wire... I»

First specify which solver should be used for the calculation of the network model. This
is usually set to Transient Analysis.

Then define the wires for which the network model will be generated. In this example,
the two conductors above the ground plane will be defined as wires. The first wire starts
at port 1 (= Port A) and ends at port 2 (= Port B). Analogously, the second wire is
defined between port 3 and port 4. Since only discrete ports are used here, the
specification of modes is not required.

Metwork Parameter Extraction

Solver lupe:

Trahzient Analyziz 4
Frequency: Mumber of cascades: Lancel
25 4 Specials...
Wire  Portd Mode & FortB  Mode B
Calculate
1 1 2
2 3 4

Add Wire. ..

Help
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Afterwards you should define the Frequency for the SPICE model extraction. In most
cases this frequency should be set so that the corresponding wave length is
approximately 100 times larger than the length (/) of the transmission lines,

thus: f =0.01¢/!/.

Now specify the number of cascades so that both the accuracy and the complexity of the
generated SPICE circuit increases with this setting. A value of 4 is a good compromise
for many practical applications. Refer to the online documentation for more details.

Finally start the network parameter extraction by clicking the Calculate button. If the S-
parameter results are not yet available, the transient solver will automatically be initiated
before the actual SPICE model generation is performed. The transient solver will need to
be started only once per wire (not once per port as is the case for Source Type = All
Ports).

After the solver has finished, click the Show results button to view the lumped element
parameters of the equivalent network model.

To check the quality of the approximation, an S-parameter calculation using SPICE can
be performed, and the results of this calculation can be compared with the results of the
3D analysis. The difference between these two results is a direct measure of the error of
the approximation. This common task is simplified by a macro which is installed as
global macro by default.

To use this macro you will first need to generate a SPICE netlist by clicking on the
Create netlist button. Save the netlist with the same name as your structure, and then
close the parameter extraction dialog box by clicking OK.

The macro can then be called by selecting Macros=*Touchstone + SPICE=*Calculate
SPICE S-Parameters (TEM) which opens the following dialog box:

ELSPICE S-Parameter Simulation (TEM)

Metlizt file name

|E:'\G etting Started Examplesi.chnes. net

Browse...

l ()4 ] [ Cancel ]

Check the Netlist file name before clicking OK. Afterward SPICE will be called
automatically before a dialog box appears reporting the successful calculation of the S-
parameters.

As a result, a new folder named 71D Results=>SPICE will be created containing the
SPICE calculated S-parameters and the error curve which shows the maximum error
between the network approximation and the real 3D device.
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SPICE S-Parameter Approximation Error
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This result shows that the approximation has an error of less than 0.1% up to a
transmission line length of a tenth of a wavelength. The error increases with frequency
since the approximation of the 3D structure by a transmission line model becomes less
accurate for higher frequencies. Nevertheless even for a transmission line length of a
third of a wavelength, the approximation error remains roughly below 3%.
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Cadence® Allegro / APD Plug in

The Cadence® Allegro / APD Plug in is a component installed on top of an existing
Cadence® Allegro or APD installation. The plug in’s user interface is then embedded
into the corresponding tool’s environment and allows exporting models from within the
Cadence® flow. The exported models can directly be opened in CST MICROWAVE
STUDIO®. The plug in is compatible with both the UNIX and the Microsoft Windows
versions of the Cadence® tools.

The following section explains the installation of the Cadence® Allegro / APD plug in first
before focusing on how to export models from within the Cadence® flow.

The plug in is written in Cadence’s Skill® programming language, so the Cadence®
Allegro / APD installation needs to include the Skill language components. As an
example, Allegro PCB Studio without the Allegro Performance options does not provide
a Skill interface.

The plug in is compatible with the following tools:

e AP Designer / AP Engineer

e Allegro PCB Design Expert

e Allegro PCB Designer

e Allegro PCB Studio (with Allegro Performance option)
Installation

The installation of the plug in has been greatly simplified by an installation program
which is provided in form of a Cadence® script file.

First, you need to copy the contents of the Cadence Allegro APD Plug in folder in the
installation directory of CST STUDIO SUITE™ into your home directory. If you are using
FTP to transfer the files, make sure to copy the entire directory structure using the binary
file transfer option. Afterward, a folder named “CST_Link” should exist in your home
directory.

Next, you need to set an environment variable named CST_Link_ HOME pointing to the
full file path name of the “CST_Link” directory. Both the name of the environment
variable and the path are generally case sensitive. Make sure that this environment
variable is available whenever you run Cadence® Allegro or APD.

Please note: Use forward slashes for the path specification only, even on
Windows operating systems, e.g. use C:/Allegro/CST_Link rather than
C:\Allegro\CST _Link.

After starting Cadence® Allegro or APD, select the item File =>Script from the main menu
to open a dialog box similar to the following (depending on the actual version of the
Cadence® tool):
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3 Scripting X
—acript File
Browse...
Mame:  |shomesdd92/CST_Linkdinstall.scr
I = Library...
_|Macro record mode Generate...
—Record/Replay
Record | stop | Replay
Cancel Help

Now browse for the file “install.scr” which is contained within the plug in’s “CST_Link”
folder. Clicking the Replay button installs all required components and creates
subdirectories as necessary. Once the installation is complete, the Cadence® program
closes automatically.

The plug in can be used after restarting Cadence® Allegro or APD. The following screen
shot shows the main window of Cadence® Allegro after successfully installing the plug
in:

Allegro Expert: unnamed.brd Project: /home/dd92/Cadence

CST Link Help
Export Full Design...
Export Area...
Export Selected Nets...

Export Custom Selected Objects...

File Edit View Add Display Setup Shape Logic Place Route Analyze Manufacture Tools

| wlEl | el e e =] alalalale)®| Gl 9] o] =lf

Layout Cross- Section...

Board Geametry 4/‘
........... . . . . . . . B B O lm

Loading axlcore.cxt DCmd. Idle

Starting new drawing

Grids are drawn 4000, 400.0 apar for enhanced viewability P| | 11z00.0, 13300.0

Command = Stoj
r| [ Stop |

Background information: The installation program has copied the currently used menu
configuration files into the “CST_Link” folder and has added the plug in specific menu
settings to these files. Furthermore, customized initialization files have been copied to
the “pcbenv” folder in your home directory.
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The following list shows all files created during this procedure in the pcbenv directory:
“allegro.ilinit”, “allegro.ini”, “apd.ilinit” and “cst.cxt’. The plug in can be uninstalled by

simply deleting those files together with the entire “CST_Link” folder.
Exporting Models from Cadence® Allegro / APD

We will demonstrate the usage of the plug in for the case of exporting a Cadence®
Allegro model. The procedure for exporting Cadence® APD models is similar, and the
explanations in this section can be applied in a straightforward manner.

In the following we assume that a Cadence® Allegro model is loaded and the plug in is
installed properly:

[E Allegro Expert: Allegro.brd Project: /home/dd92/Cadence E]@
File Edit View Add Display Setup Shape Logic Place Route Analyze Marmfacture Tools CST Link Help

wlgl| | zlex=HE ]| alalalaa| ||

pd D IR EES
_/Optlons ! .l' Find \, i'\flslblllly \,
= Active Class and Subclass:
E |Eten W
E, L] ||:| Gn V|

|:|Cmd: Z00m points
F| & 406292, 130291

St

Pick 1st Corner Of Mew Window.

Pick 1st Corner OF Mew Window.
Fick 15t Corner OF Mew Window.
Command =

;‘

First, make sure that the layout cross-section information is correctly stored in the
technology information by choosing CST Link=Layout Cross-Section:
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[ CST Layout Cross Section
—Cross-Section Setup
Edit Material Layer Type Eich Subclass Mame Thickness Elevation Electric Cond (5/m)|Dielectric Constant Expnnl
-= ||[COPFER = | Conductar - |TOP 1.2000 27.6000 59550000.0000 1.0000) &
== ||FR-4 = |Dielectric % 6.0000 19.6000 0.0000 4.5000] X J
== ||[COPPER = |Plane - |GND 1.2000 18.4000 59530000.0000 45000 &
== |[FR-4 = |Dielectric X §.0000 10.4000 0.0000 45000 @
== ||COPFER = |Plane =|vVCC 1.2000 9.2000 59550000.0000 45000 X
== ||FR-4 = |Dielectric = 5.0000 1.2000 0.0000 4.5000] X
-= ||COPFPER ~ | Conductar - |BOTTOM 1.2000 0 59530000.0000 1.0000] B
i
—Technology File Unit:
CST technology file I.r‘hnmefddSZﬂ‘CST_Lmk/AIIegrn_n:st tech Browse Design units Mils V]
Save | Load | view | Load/Restore hoard setup | Layer thickness units l—Mils ¥
(o' Cancal about | Update elevation |

This dialog box allows you to modify the current stackup (= cross section) information as
well as save and load the modified data to an external CST Technology File. Clicking the
Load/Restore board setup button resets the stackup information to the data stored in the
board’s technology file.

A context menu can be opened by pressing the right mouse button on a layer's “->”
button. This menu allows deleting the corresponding layer or adding a new layer above
or below the current one. The layer's properties can be changed by directly editing the
corresponding entry fields similar to the procedure in Cadence® Allegro.

Unchecking the Export option hides the corresponding layer from the export procedure.
Please note that this also causes the layer's thickness not to be considered when
calculating the stackup’s elevations.

After changing the thickness of a layer, click the Update elevations button to recalculate
the elevation values for all layers. Otherwise, the stackup may contain gaps between
adjacent layers and overlapping layers, respectively.

The settings can be confirmed by clicking OK which also closes the dialog box.

Once the stackup information is verified, you can choose one the following options to
export the model:

Export Full Design

Export Area

Export Selected Nets

Export Custom Selected Objects

The following sections discuss the usage of each of these options in more detail. The
Export Area option is probably the most frequently used choice since it combines ease
of use with good performance even when working with large models.

For each of these options, two files with the extensions “mod” and “.par” will be created
by the plug in. These files need to be transferred to a location that is directly accessible
through CST MICROWAVE STUDIO®. Make sure to activate the text mode when using
FTP to transfer those files.



CST MICROWAVE STUDIO ® 2006 — Getting Started 169

The model files contain an intermediate file format after exporting them using the plug in.
However, the files can be opened as usual by CST MICROWAVE STUDIO®. The files
will then be automatically converted and saved as standard model files. This conversion
process requires a Cadence® link license which may not be available to you due to
license restrictions. Contact your sales office for more information.

Export Full Design

The easiest way to export the current model is to select the Export Full Design option
which will open the following dialog box:

EZ CST Link Export Design
C5T Project
Mod output file: | EERTRG Browisea...
Cross-section Setup... | Export | Close | Ahout

Select a name for the model file (.mod file). As an optional step, you can also open the
stackup editor as explained above by clicking the Cross-section Setup button.

The actual export procedure can be started by clicking the Export button. A progress
window will appear keeping you informed of the status of the export process:

3 CST Link Export Design. ..

|

extract vias

The following screen shot shows the entire Cadence® Allegro model after exporting it
and opening the corresponding files in CST MICROWAVE STUDIO®:
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While the simplicity of using this export option clearly is an advantage, its disadvantage
is the huge complexity of the exported models. Keep in mind that you are building a 3D
CAD model which is usually much more complex than the 2D data in Cadence® Allegro.

Boards having hundreds or thousands of components and traces can easily end up in
huge models which can no longer be handled and simulated efficiently. The following
export options help to reduce the complexity of the exported models while still
transferring all relevant data into the simulation model.

Export Area

The Export Area option is relatively simple to use but reduces the complexity of the
exported model significantly. In many cases, it is sufficient to simulate only a small part
of the entire board using CST MICROWAVE STUDIO®. The Export Area selection
allows selecting a rectangular or polygonal area whose contents will then be solely
exported.

After you select the corresponding option from the menu, the following dialog box will

appear:
B3 CST Link Export Area
—CST Project
rod output file: | EYTEST I RG] Browrse.
—Area Type

Select Area to Export... | Close

< Rectangular

- Polygonal

Cross-gection Setup... | Ahout
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First specify a name for the exported “.mod” file. You may also open the stackup editor
from within this dialog box by clicking the Cross-section Setup button.

Next select whether you are going to use a Rectangular area or the more general case
of a Polygonal area.

Selecting a rectangular area requires two mouse clicks for the opposite corners only
whereas the definition of a polygonal selection requires the definition of all corner points.

Start the actual interactive definition of the area by clicking the Select Area to Export
button.

Once this button is clicked, the dialog box disappears and you can start selecting points
by single-clicking on the corresponding location on the screen. Pressing the right mouse
button opens a context menu which allows you to abort the operation by selecting the
Cancel item. Choosing the Oops entry deletes the previously selected point whereas the
Done option automatically closes the rectangle or polygon and starts the export process.

In the example above, we select the following polygon (solid white line):

Due to the brick-like shape of the computation domain, the dashed area of the board will
be exported rather than the polygonal selection. However, all trace and component
geometry will still be clipped at the boundaries of the original polygon.

A progress window will be shown during the export process. Opening the exported
model in CST MICROWAVE STUDIO® will then reveal the following:
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Export Selected Nets

A typical application of EM simulation in the context of board design is analyzing the S-
parameters for a set of coupled nets. This mainly requires exporting the geometry of the
selected nets together with some neighboring geometry often including GND and Vcc
planes. Even if this can be easily achieved using the Export Area option described
above, the complexity of the exported model may still be too large for some models.

In such cases, the Export Selected Nets option provides an alternative solution. The
corresponding dialog box looks as follows:

(D CST Link Export Nets
CAET Project
|7 hod output file: | RT Browse. .
| Select Mets to Export... | _IUSE Expnr‘[ Dptigns
Cross-section Setup.. | Close | Apout |

First specify a name for the exported “.mod” file. You can optionally enter the stackup
editor from within this dialog box by clicking the Cross-section Setup button.

If the Use export options button is unchecked, only the selected nets will be exported
without any neighboring geometry. If the option is checked, another dialog box will open
later on containing parameters to include neighboring geometry.

You can start selecting the nets after clicking the Select Nets to Export button. The
dialog box will be hidden during the interactive selection procedure. You can open a
context menu by pressing the right mouse button.
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A net can be selected by clicking on it in the main view or by typing its name after
choosing Select By Name from the context menu. The selection can be aborted by
choosing Cancel from the context menu. The previously selected net can be deselected
again by choosing the Oops options from the context menu. Choosing the Done item will
end the selection and continue with the next step.

The following picture shows the selection of three nets for the example above:

If the Use export options button is checked, another dialog box opens after the net
selection has finished:

Export Mets Options
Selected Nets Layer MName Layer Type Distance | |
: ETCH/TCOP COMDUCTOR 0.00 X
ETCH/GMD PLAME ) J
ETCH/MVCC FPLAME Ed
ETCH/BOTTOM COMDUCTOR 0.00 (]
;|

Export | Cancel | [ Separate files for each net

The dialog box shows a list of all previously selected nets. Clicking on a net's name
shows a list of all layers that contain parts of the net. This also includes planes that are
crossed by the net through vias.
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For each of the conducting layers, a Distance can be specified. Neighboring geometry
will then be exported as well if it is located within the specified distance to the particular
net.

The option Separate files for each net allows you to specify whether all nets are
exported into a single model or whether separate models need to be created for each
net. Cross-talk simulations require all nets to be located in the same model, which
means that the option needs to be unchecked in this case.

Click the Export button to start the model generation.

For the example above, we have chosen a small distance around each of the nets and
put everything into a single model file:

Export Custom Selected Objects

The Export Custom Selected Objects function is one of the most flexible ways to select
objects for exporting but also requires the most laborious entity selection.

After choosing this option from the main menu, the following dialog box appears:

B3 CST Link Export Custom Selected
C5T Project
hod output file: | BT SE GRLL Browse. .
Cross-section Setup... | ‘ Select Objects ta Expart... | Close | Ahout |

Specify a name for the exported “.mod” file. You can optionally enter the stackup editor
from within this dialog box by clicking the Cross-section Setup button.
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Start the actual entity selection by clicking Select Objects to Export. The dialog box will
be hidden during the selection process.

You can open a context menu by pressing the right mouse button. From this context
menu, you can choose the type of the entity that will be selected by the next mouse
click. Available types are the following:

Net
Shape
Cline
Via
Pin

In addition, you can also select a net by specifying its name. End the selection process
by choosing either Cancel or Done. The latter choice will show a summary of all selected
entities:

You may now exclude an entity from the export process by unchecking its corresponding
Export button.

Start the actual export process by clicking the Export the Selected Objects button. A
progress window will be displayed until the export is complete.

For the example above, the exported model looks as follows:
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Note that the selection applies to the metal parts only and the dielectric layers will
always be exported. The shape of the dielectric layers is determined by the board’s
outlines.
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Agilent ADS® Co-Simulation

In addition to its tight integration into the CST DESIGN ENVIRONMENT™ CST
MICROWAVE STUDIO® features strong interfaces with Agilent ADS®. The latter
ranges from using pre-computed S-parameter data in ADS® circuit simulations to using
true EM / circuit co-simulations.

CST MICROWAVE STUDIO® manages an ADS® Design Kit which contains a
dynamically extended list of EM simulation components. The difference between the
levels of integration is how simulation results are handled for a particular component.
The integration supports changing parameters of the 3D EM models directly from within
the ADS® environment.

The “static” link (ADS® 2003A and above) requires parametric CST MICROWAVE
STUDIO® results to be computed before the component is used within ADS®. The
circuit simulator automatically interpolates the S-parameter between the pre-computed
samples.

Moreover, the “co-simulation” alternative enables ADS® to launch CST MICROWAVE
STUDIO® in order to automatically calculate required data. All information is stored
together with the CST MICROWAVE STUDIO® model to avoid unnecessary repetitions
of lengthy EM simulations. The co-simulation interface requires ADS® 2005A or above.

In the following sections, we focus on the common Design Kit installation procedure
before explaining the usage of both interfaces in more detail.

Design Kit Installation

The Design Kit is required for the static link as well as the co-simulation interface. For
the installation of the Design Kit, you can select Design Kit=*Install Design Kits from the
ADS® main menu to open the following dialog box:
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~ Install ADS Design Kit

1. Unzip Design Kit
Thiz ztep may be skipped if the Design Kit iz alleady unzipped.

i Unzip Design kit Mow. ., ¢

2. Defing Dengn kit
Enter full Path to the directarg of the desired Design kit
IF available, the remaining info will be automatically filled in.

Fath
|O0G/LIBRARY MACROS M5 AADSACST_aDS_DK_1/ EiarEa..

Marne
[CST_ADS_DK_1

Boot File [optional]

|de/ael/boat Browse...

Yersion

[version_v1

3. Install Design Kit

Select Installation Level : |U5EF| LEVEL j

] 4 Cancel Help

Clicking the Browse button next to the Path entry allows you to specify the path to the
Design Kit which is located in a subfolder of the CST DESIGN ENVIRONMENT™ l[ibrary
folder. Refer to the CST DESIGN ENVIRONMENT™ First Steps manual for more
information about setting the library folder. By default, the library is located in a subfolder
of the CST STUDIO SUITE™ installation directory.

If [library_path] is the actual library folder (e.g. “C:\Program Files\CST STUDIO SUITE
2006\Library”), the Design Kit is stored at the following location:

[library_path]\Macros\MWS\ADS\CST_ADS_ DK _1
Make sure to browse for this folder as the Design Kit's path. Once the path is set

properly, the remaining fields in the dialog box will be filled in automatically as shown in
the picture above.

The Design Kit can now be installed by clicking the OK button. Refer to the ADS®
documentation for more information on managing Design Kits.
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Static Link between CST MICROWAVE STUDIO® and Agilent ADS®

The static link can be used right after installing the Design Kit. In the following, we
explain the necessary steps to make a particular project available as a component in
ADS®.

After opening the corresponding CST MICROWAVE STUDIO® project, you need to add
a 1D result template named ADS Component Export. Now all parametric S-parameters
which are computed after adding the template will be stored in a local database. Please
note that performing model changes other than simple parametric changes will
automatically delete this database.

Once the result template is defined, you can run simulations for various parameter
settings. All entries in the S-parameter database will then become available for use
within ADS®.

Note: If you already have S-parameter data available before adding the result
template, you can click the Evaluate button in the template based post-processing
dialog box in order to add the existing S-parameters to the data set right away.
However, only the latest S-parameter results will be added.

After computing all necessary S-parameters, you can create the ADS® Design Kit
component by choosing File 2Export?’ADS Component Export from the main menu:

Export Agilent ADS Component
Camponent Dezcription:
coaxial connector bd-hex Component
Parameter Topes:
Parameter Tupe
radius Uritless -
[ 0k, ] [ Cancel ] [ Help ]

The parameter list shows all parameters that have been varied in the currently available
database. Please note that parameters depending on other parameters in form of
expressions are not listed here.

Each parameter needs to have a Type assigned to it in order to properly handle
potentially different unit settings in CST MICROWAVE STUDIO® and ADS®. Make sure
to specify the correct type according to the physical meaning of the parameter. In the
example shown above, the “radius” parameter is of type Length.
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Now double-check the types for every parameter, and enter a proper Component
Description.

Clicking OK will create the component and copy the currently available S-parameter
data to the Design Kit. Subsequently performed S-parameter simulations will not
automatically add new data to the Design Kit.

You need to restart ADS® in order to use the newly created component. The component
can then be accessed as usual from the ADS® library browser as shown below:

| Component Library/Schematic: 1 E]@

Fle Edit Wiew Options Tools Help

L= [ﬂ‘ “‘”rm‘ ﬂ\rﬂ §$|| @|++|—_| | | (Y {)‘
Libraries Components
=l Al Campaonent Diescription

Sub-networks C5T_ADS_DK_1_coasial_connect coasial connectar td-hex Component |1
o

HF ChoOe eoorany

Measurement Based SMT Passive
Microwawe Transistor Library

RF Transistor Librany

RF Pazzive SMT Libram

S Parameter Library (Mo Lapout)
Swatem Library

Block Text Fonts

|IDF Compaonents

e
&
+
s
&
+
s

< > Browse for downloadable vendor libraries...

Default Mode:  Browse AJRF  Library: Licensed, CST MWS Components 1

CST MICROWAVE STUDIO® and Agilent ADS® Co-Simulation

A unique feature of the co-simulation link is the ability to automatically launch CST
MICROWAVE STUDIO® from within ADS® if new S-parameter data are requested. This
advanced interface requires ADS® 2005A or above and needs CST MICROWAVE
STUDIO® and ADS® to be installed on the same computer.

Before the co-simulation can actually be used, you need to copy a DLL named
“‘gem_CstCmptDLL29.dII” from the Agilent ADS Plug in folder in the installation directory
of CST STUDIO SUITE™ to the ADS® bin directory. The latter directory is located in the
main installation folder of ADS® and already contains a placeholder DLL with the same
name. Make sure to override the existing DLL with the new one.

Once the DLL has been installed properly, the actual usage of the co-simulation is
simple. It can be activated for a particular model by choosing Solve 2?ADS Co-Simulation
from CST MICROWAVE STUDIO®'s main menu:
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= -1

ADS Co-Simulation

Enable A0S Co-Simulation
|22 interpolation

Description:

Cio-Sim Coaxial Connector
Solver type:

Tranzient A
Parameters:

Uze | Mame Type Maminal W alue Step Size
C P radivs Length - | 200 50

I ()8 ][ Cancel ]

First, activate Enable ADS Co-Simulation by checking the corresponding option. You
can also specify a Description text which will later be shown in the ADS® library
browser.

Whenever the calculation of new S-parameter data is required, the co-simulation
interface will automatically launch CST MICROWAVE STUDIO®. The Solver type
setting specifies which solver (transient or frequency domain) will then be used for the
calculation.

The parameter list shows currently defined parameters that can be used for the co-
simulation. If a parameter depends on another parameter (e.g. in form of an expression),
its value cannot be set directly. Therefore, dependent parameters are not shown in this
list.

A parameter can be controlled from within ADS® if its Use option is checked. This
selection allows you to hide parameters from being visible in the ADS® component
options.

The Use interpolation option specifies whether S-parameter data may be interpolated or
not. If this option is switched off, the S-parameters will be directly calculated for every
requested parameter combination. If the interpolation feature is activated, the
interpolation is done on a regular grid of anchor points. The grid is determined by the
Nominal Value and Step Size settings which can be independently specified for each
parameter.
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The following picture illustrates how the interpolation scheme works for the simplest
case of one parameter:

Step size

< :J\ Parameter value
Y * T g
Nominal value

Anchor points

CST MICROWAVE STUDIO® simulations are only carried out at the uniformly spaced
anchor points of the interpolation grid. The grid’s origin is specified by the Nominal value
whereas the Step Size determines the distance between two consecutive anchor points.

Requested data point

Parameter value

? *
M@nterpolatlon weights

Whenever a new data point is requested, the two closest neighboring anchor points are
determined and their contributions to the requested sample are calculated. Based on the
corresponding anchor point's S-parameter data and these interpolation weights, the
requested S-parameters can then be obtained by linear interpolation. This scheme can
be straightforwardly extended to handle multiple parameters as well.

In the dialog box, you can specify each parameter’s interpolation options by directly
editing the values in the parameter list. Please note that these settings will only be used
when the interpolation option is switched on.

Clicking the OK button finally creates or updates the Design Kit component. Make sure
to restart ADS® in order to update these changes.



CST MICROWAVE STUDIO ® 2006 — Getting Started 183

The components can now be accessed as usual from the ADS® library browser:

i | Component Library/Schematic: 1 E]@

File Edit Miew ©Options Tools Help
9|

G| @ = 5] [ Be] D= +]—| B
Libraries Components
=1 Al

Sub-netwarks
Fr
halog/RF

CST Mw'S Cozsimulation Eomponer>
& nalog Parts Library (Mo Layout
Measurement Based SMT Passive
Microwave Transistor Library

RF Transistor Library
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The following picture shows a co-simulation component after it has been placed on the
ADS® schematic:

s U e

CET_ADS Dk_1_coaxial_connector_td-hex
eET T e
" Interpolation="1
- Freguenty="0..8 GHz"

. radius=200. rmil

The component’s options allow changing the interpolation type (1=yes, 0=no) and CST
MICROWAVE STUDIO® model parameters directly from within the ADS® environment.
Furthermore the component displays information about the frequency range of the EM
simulation.

The Design Kit component is now dynamically linked to the CST MICROWAVE
STUDIO® model. Whenever new S-parameter data for a particular parameter
combination are computed, these data will become available to ADS® right away.

Note: Whenever a parametric model is used for ADS® co-simulation, it is advisable to
test whether the structure update succeeds for various parameter combinations before
creating the ADS® Design Kit component.
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Chapter 3 — Finding Further
Information

After carefully reading this manual, you will already have some idea of how to efficiently
use CST MICROWAVE STUDIO® for your own problems. However, when you are
creating your own first models, a lot of questions will arise. In this chapter we give you a
short overview of the available documentation.

The Quick Start Guide

The main task of the Quick Start Guide is to remind you to complete all necessary steps
in order to successfully perform a simulation. Especially for new users — or for those
rarely using the software — it may be helpful to have some assistance.

After starting the Quick Start Guide, a dialog box opens in which you can specify the
type of problem you wish to analyze:

QuicksStart Guide X

Froblem type:

® Transient Analysis

() Eigenmodes

() Frequency Domain Analysis
Mewt >

After the problem type has been selected, click Next to proceed to a list of tasks which
are either necessary or optional (as indicated) in order to perform a simulation. The
following picture shows an example for transient analysis:

QuickStart Guide X
S

Transient &nalysis:
= Set units

Set background matenal
Define structure
Set freguency
Set ports
Set boundary conditions
Set field rmonitars

Start zolver

Analyze resulks
<<Back

You will find that only the very first item on the list is active at the beginning. If you
successfully perform the operation indicated by this entry, the next item will become
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active, and so on. You may, however, change any of your previous settings throughout
the procedure.

The Quick Start Guide may be opened as soon as CST MICROWAVE STUDIO® is
started. However, the Quick Start Guide will open automatically only when it has been
used during the last session. You may start the Quick Start Guide at any time by
choosing Help =Quick Start Guide from the menu bar.

In order to access information about the Quick Start Guide itself, click the Help button.
To obtain more information about a particular operation, click on the appropriate item in
the Quick Start Guide.

Tutorials

The tutorials will generally be your best source of information when trying to solve a
particular problem. We recommend you browse through the list of all available tutorials
and choose the one closest to your application:

Rectangular Waveguide

This is for typical waveguide structures with rectangular waveguide ports. The S-
parameter simulation is performed using both the transient simulator and the general
purpose tetrahedral frequency domain simulator.

Coaxial Structure
This is an S-parameter example for a coaxial structure using the transient simulator
and the general purpose tetrahedral frequency domain simulator.

Planar Device

This is a common S-parameter example for microstrip and coplanar structures using
the transient simulator and the general purpose tetrahedral frequency domain
simulator.

Antenna

This tutorial consists of two parts: a single patch antenna and a four-patch antenna
array for which the farfield characteristics are computed for various excitation patterns.
Both simulations are carried out using the transient simulator and the tetrahedral
frequency domain simulator.

Resonator
This is a typical eigenmode example. The first few modal distributions are calculated
using the eigenmode solver.

Filter

This example shows an S-parameter simulation for a narrow band filter using the
resonant fast S-parameter frequency domain solver. This highly specialized solver is
the best choice for this type of application. However, the example also shows the
application of the general purpose tetrahedral frequency domain solver as an
alternative.

The fastest way to solve your particular problem is to study the most appropriate tutorial
carefully, understanding the basic concepts before you start modeling your own
problem. .
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If you are already familiar with CST MICROWAVE STUDIO® (it usually takes a couple of
days), it may be no longer necessary to study the tutorials in detail. In this case you can
quickly go through the pages of the tutorial and pick out new information.

Examples

The installation directory of CST STUDIO SUITE™ contains an examples subdirectory
consisting of a couple of typical application examples. A quick overview of the existing
examples can be obtained by choosing Help =Examples Overview from the menu bar.

Each of these examples also contains a “Readme” item in the navigation tree. By
double-clicking on these items, you will obtain some information about the particular
example regarding structure modeling and simulation procedure.

Although these examples are not explained in as much detail as the tutorials, they may
nevertheless contain helpful hints which can be transferred to your particular application.

Online Reference Documentation

You can access the help system’s overview page at any time by choosing Help=CST
MICROWAVE STUDIO Help from the menu bar.

In each of the dialog boxes, there is a specific Help button which directly opens the
corresponding manual page. Additionally the F1 key gives some context sensitive help
when a particular mode is active. For instance, by pressing the F71 key while a basic
shape generation mode is active, you can get information about the definition of shapes
and possible actions.

When no specific information is available, pressing the F71 key will open an overview
page from which you may navigate through the help system.

Referring to the Advanced Topics Manual

This printed manual contains more background information about the methods used in
CST MICROWAVE STUDIO® together with some more detailed information about
advanced topics including the following:

An introduction into the simulation methods

Advanced mesh generation

How to improve the calculation speed

Introduction to the powerful macro language to automate common tasks
List of available post processing templates and macros
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Technical Support

After you have taken @your first steps to solving your own applications within CST
MICROWAVE STUDIO", please use the macro Macros =*File =>Make Archive to create a
ZIP archive containing all relevant files. This ZIP file should then be sent to the technical
support team. Even if you have successfully obtained a solution, the problem
specification might still be improved in order to get even better results within shorter
calculation times.

The support area on our homepage (www.cst.com) also contains a lot of very useful and
frequently updated information. Simple access to this area is provided by choosing
Help =>Online Support. You only need to enter your user name and password once.
Afterwards, the support area will open automatically whenever you choose this menu
command.

Macro Language Documentation

More information concerning the built-in macro language can be accessed through the
Help=VBA Language Help overview page. The macro language’s documentation
consists of four parts:

e An overview and general description of the macro language

e A description of all CST MICROWAVE STUDIO® specific macro language
extensions

o A syntax reference of the Visual Basic for Applications compatible macro
language

e  Some documented macro examples

History of Changes

The history of changes between several releases of the program can be opened by
selecting Help=History of Changes. Since there are many new features in each new
version, you should browse through the list even if you are already familiar with one of
the previous releases.
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Appendix A — List of Shortcut Keys

The following list gives an overview of available shortcut keys that may be very useful,
especially for advanced users.

General Shortcut Keys Available in Main Structure View

You can activate this view by clicking on it with the left mouse button.

ESC Cancel currently active mode
CtrI+O Open new model file
Ctrl+S Save current model file
DELETE Delete the currently selected object
F1 Open context sensitive help
F2 Rename the currently selected shape in the navigation tree
F5 Update the visualized 1D result (only while a solver is running)
Ctrl+F Reset view
Space Reset view to structure
Shift+Space Reset view to selection
Alt+V Open view options dialog box
Ctri+C Copy the currently displayed result curves into clipboard
Ctrl+V Paste result curves from clipboard into the active result curve plot
Alt+O Toggle outline mode
Alt+W Toggle working plane visualization on or off
Ctrl+A Toggle axis view on or off
Ctrl+W Toggle wireframe mode on or off
Shift+A Toggle field plot animation on or off
Shift+C Activate/deactivate cutting plane view
X If the cutting plane view is active, the cut is made on the x-plane
y If the cutting plane view is active, the cut is made on the y-plane
z If the cutting plane view is active, the cut is made on the z-plane
TAB Open the numerical coordinate input box (also available in 1D plots
for axis marker positioning)
Shift+TAB Open the numerical coordinate input box with zero defaults
Numpad-(5) Front view
Numpad-(4) Left view
Numpad-(6) Right view
Numpad-(8) Top view
Numpad-(2) Bottom view
Numpad-(0) Perspective view
Cursor-Left Decrement phase (2D/3D plots), move axis marker left (1D plots)
Cursor-Right Increment phase (2D/3D plots), move axis marker right (1D plots)
Cursor-Up Move cutplane or meshplane in positive normal direction, increase
frequency for visualization of frequency dependent port modes.
Cursor-Down Move cutplane or meshplane in opposite normal direction, decrease
frequency for visualization of frequency dependent port modes.
Ctrl+H Hide selected shape, face or object
Ctrl+U Unhide all
w Align the WCS with most recently picked point(s), edge or face
Shift+U Rotate the WCS around its u axis
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Shift+V Rotate the WCS around its v axis
Shift+W Rotate the WCS around its w axis
P Pick point
M Pick edge mid point
A Pick face center
R Pick point on circle
C Pick circle center
E Pick edge
F Pick face
Shift+E Pick edge chain
Shift+F Pick face chain
D Clear picks
Ctrl+R Remove the selected feature
Ctrl+Shift+D Delete the selected face
Ctrl+Shift+C Cover the selected edges
Alt+L Add linear curve between two picked points
Alt+T Add tangent curves between two picked points and edges
Alt+P Split the selected edge at the picked point
Backspace Delete previous point in generation of basic shapes.
+ Start Boolean add operation for selected shape
- Start Boolean subtract operation for selected shape
* Start Boolean intersect operation for selected shape, start trim
curves operation for selected curve
+ Start Boolean insert operation for selected shape
% Start Boolean imprint operation for selected shape
RETURN Perform Boolean operation (if active)
| Shift+P | Open result template post processing dialog box

Mouse Wheel

| Dynamic zoom view

The following shortcuts are active when the mouse is dragged while pressing the left
mouse button:

Shift Restrict mouse movement to 90 degree angles (in shape creation)
or Planar rotate view (otherwise)

Ctrl Rotate view

Shift+Ctrl Pan view

Shortcut Keys Available in Edit Fields

Ctrl+C Copy selected text into clipboard

Ctrl+V Paste clipboard to current marker’s position

Ctrl+X Cut selected text

Ctri+Z Undo last editing operation
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Shortcut Keys Available in VBA Editor

Ctrl+N File new

Ctrl+O File open

Ctrl+S File save

Ctrl+P Print

Ctrl+F Find
F3 Find again

CtrI+R Replace

Ctrl+Z Undo previous operation

Ctrl+Y Redo previously undone operation

Ctrl+X Cut

Ctrl+C Copy

Ctrl+V Paste
F1 Context help for the word next to the caret position
F5 Run macro

ESC Pause macro
F7 Debug step to
F9 Debug break
Ctrl+F9 Add watch
Ctrl+Shift+F9 Clear all breaks
Shift+F9 Quick watch
Ctrl+F8 Debug step out
Shift+F8 Debug step over

F8 Debug step into
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